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Section 1: Getting Started

This section explains how to start using your Samsung i225 
phone by activating your service, setting up your Voicemail, or 
getting an understanding of how this manual is put together. 

Understanding this User Manual
The chapters of this manual generally follow the same order as 
the menus and sub-menus in your phone. A robust index for 
quick reference to most features begins on page 148. 

Also included is important safety information that you should 
know before using your phone. Most of this information is near 
the back of the guide, beginning on page 120. 

Notes and Tips

Throughout this manual some text is set apart from the rest. In 
this way, important information, quick methods for activating 
features, to define terms, and more are emphasized. The 
definitions for these methods are as follows: 
• Notes — Explain alternative options within the current feature, menu, 

or sub-menu. 
• Tips — Provide quick or innovative methods for performing functions 

related to the subject at hand. 
• Important — Points out important information about the current 

feature that could affect performance, or even damage your phone. 

Text Conventions

This manual provides condensed information about how to use 
your phone. To make this possible, the following terms and icon 
appear in place of repeatedly-used procedural steps: 

Preparing Your Phone
Before you can activate your new phone, you need to install and 
charge the phone battery. 

highlight Use the Navigation key/Jog Wheel ( ) to move 
a highlighting effect onto a menu item or screen 
item of interest. 

select After “highlighting” a menu item or screen item, 
press the Action key ( ) or the Done soft key to 
launch, access, or save a highlighted menu item 
or screen field of interest. 

 ➔ Used in place of “select” in long “drill down” 
procedure steps. 

Example: Select Start ➔ Settings ➔ Phone ➔ 
Call Options. 
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Installing the Battery

Note: Your phone comes packaged with a partially charged rechargeable 
standard Li-Ion battery and travel adapter.

Important!: You must fully charge the battery the first time you use your 
phone, otherwise you could damage the battery. From fully 
discharged to fully charged, the battery requires up to 4 hours of 
charge time. 

1. If in place, push down on the battery cover (1).

2. Slide the battery cover down. 

3. Lift the battery cover off of the phone (2), bottom end first. 

4. Place the battery (1) so that the plastic tabs are aligned 
with the corresponding holes in the phone. 

5. Gently push the battery down (2) until it clicks into place. 

6. Place the battery cover onto the back of the phone (1) by 
aligning the tabs with the corresponding slots in the phone. 

7. Slide the battery cover up (2) until it clicks into place. 
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Removing the Battery

1. Push down on the battery cover (1).

2. Slide the battery cover down. 

3. Lift the battery cover off of the phone (2), bottom end first. 

4. Lift the battery up (1) and away from the phone (2). 

Charging the Battery

Your phone is powered by a rechargeable standard Li-Ion battery. 
Only use Samsung-approved charging devices and batteries. 
Samsung accessories are designed to maximize battery life. Use 
of other accessories may invalidate your warranty and may 
cause damage. 

Using the Travel Adapter

The travel adapter 
included with your phone 
is a convenient, light-
weight charger that 
rapidly charges your 
phone from any 120/220 VAC outlet. 

1. Plug the large end of the Travel Adapter into a standard 
120 VAC or 220 VAC wall outlet.

Important!: For connection to an electrical supply not located in North 
America, you must use an adaptor of the proper configuration for 
the power outlet. Use of the wrong adapter could damage your 
phone and void your warranty. 
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2. Insert the smaller end of the Travel Adapter into the 
charger/accessory connector on the right side of your 
phone. 

Important!: You must unplug the adapter before removing the battery from 
the phone during charging to avoid damage. 

Warning!: The display on your handset is made of glass or acrylic and 
pressing on the screen using excessive force or a metallic object 
may damage the tempered glass surface and void the warranty. 
For more information, refer to “WARNING REGARDING DISPLAY”  on 
page 121 and to “Warranty Information” on page 140. 

Low battery indicator

The battery indicator ( ) in the upper-right corner of the 
display indicates power level. Monitor the battery strength and 
ensure your battery is adequately charged. 
• Four bars ( ) indicate a full charge. 

• An empty battery icon ( ) indicates a near empty battery. 
• A blinking empty battery icon ( ) and a tone sounding indicate 

you have two to three minutes before the battery is too low to operate 
the phone. 
If you continue to use your phone without charging its battery, the 
phone will shut down. 

Activating Your Phone
Contact your Wireless Carrier and follow their instructions for 
obtaining service, if necessary. We suggest that you read this 
guide to fully understand the services your phone supports. 

Important!: You must fully charge the battery the first time you use your 
phone, otherwise you could damage the battery. From fully 
discharged to fully charged, the battery requires up to 4 hours of 
charge time. 

Powering On the Phone

1. Press and hold . 
The startup 
animation plays 
followed by the 
appearance of the 
Home screen in the 
display. 

Incorrect
Correct

Press 
& Hold

Antenna
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Note: As with any other radio-transmitting device, do not touch the antenna 
(at the bottom of the device) while using your phone as this can affect 
call quality and can cause the phone to operate at a higher power level 
than is necessary. 

2. If the phone functions are disabled, the “Phone off” 
message and the No Service icon ( ) appear in the 
display. To enable the phone functions, do the following: 
• Press and hold the Quick/Lock key ( ) at the lower right side of 

your phone’s keypad. The Quick List menu appears in the display. 

• Select the Wireless Manager option. The Wireless Manager 
screen appears in the display. (For more information, refer to 
“Wireless Manager”  on page 110.) 

• Select the Phone option. The Phone option setting switches from 
Off to On. 

• Press the Done soft key. 

• Press . 

3. The phone begins searching for a network signal. 

4. Once the phone finds a signal, the time, date, and day 
appear in the Home screen in the display. 

5. You’re now ready to place and receive calls. 

Note: If you are outside of your carrier’s coverage or roaming area, the “No 
Service” message appears in the center of the phone’s display. If you 
cannot place or receive calls, try later when service is available, or at 
another location. 

Setting Up Your Phone (Basic)
This process details use of 
the Getting Started feature 
on your phone. You can use 
Getting Started to 
personalize your phone’s 
appearance and ringtone, 
and to setup some 
functions of your i225 for 
immediate use. 

� With the Home screen showing, press the Start soft key, 
then select Getting Started ( ). The following sub-
sections describe uses of the Getting Started options. 

Set date and time

Provided you have service from your Wireless Carrier’s network, 
this is done for you, automatically. 

If the “No Service” message 
is showing in the Home 
screen, you can set the 
time and date manually by 
doing the following: 
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1. From the Getting 
Started menu, select 
Set date and time ➔ 

change the date or 
time. The Date and 
Time screen appears 
in the display. 

2. Scroll to the bottom 
of the screen and set 
the Time setting and Time zone setting options to Manual. 

3. Select or enter values for the following options: 
• Time Zone 

• Date 

• Time 

4. Press the Done soft key to save your settings. You are 
returned to the Getting Started menu. 

Set up e-mail

You can set up your i225 to 
give you mobile access to 
your business and/or 
private e-mail account(s). 

Tip: You can setup your i225 to synchronize your e-mail. 

To set up access to an e-mail account, do the following: 

1. From the Getting 
Started menu, select 
Set up e-mail ➔ set 
up an e-mail account. 
The E-mail Setup 
screen appears in 
the display listing e-
mail account types. 

2. Select the desired e-mail account type. 

3. Enter your e-mail 
address and your e-
mail account 
password, then press 
the Next soft key. You 
are prompted to “Try 
to get e-mail settings 
automatically from 
the Internet”. 

4. Press the Next soft key. You are notified when settings are 
found for your e-mail provider. 
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5. Press the Next soft key. 

6. Enter your name and 
your e-mail account 
name as you wish 
them to be displayed 
on your screen, then 
press the Next soft 
key. 

7. You are notified that 
e-mail setup is 
complete: 
• If you want, select a 

new Automatic Send/
Receive value. 

• Press the Finish soft 
key. 

8. Your account 
information is verified and you are returned to the Getting 
Started menu. 

Set up a device password

You can setup your i225 to 
require a password every 
time it’s turned on. 

1. From the Getting 
Started menu, select 
Set up a device 
password ➔ Setup a 
password. 

The Password 
Settings screen 
appears in the 
display. 

2. If you want, enter or 
select values for the 
following options: 
• Prompt if device 

unused for (1 Minute, 
5 Minutes, 15 Minutes, 30 Minutes, 1 Hour, 1.5 Hours, 2 Hours, 12 
Hours, or 24 Hours). 

Tip: You must check the Prompt if device unused for option to activate the 
other options. 

• Password type (Simple PIN or Strong alphanumeric). 
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• Password 

• Confirm password 

3. Press the Done soft key to save your settings. 

Set up a Bluetooth headset

This option lets you pair and connect (if desired) a Bluetooth 
headset to your phone. 

1. From the Getting 
Started menu, select 
Set up a Bluetooth 
headset ➔ set up a 
Bluetooth headset. 
The Bluetooth 
Devices screen 
appears in the 
display. 

2. Set your Bluetooth 
headset to Visible, 
then select Add new 
device... A list of 
visible Bluetooth 
devices appears in 
the display. 

3. Highlight your 
Bluetooth headset, 
then press the Next 
soft key. You are 
notified that your 
i225 has connected 
with your Bluetooth 
headset. 

Set up PC 
synchronization

This option lets you set up 
your phone to synchronize 
your Outlook e-mail, 
contacts, and tasks and 
your pictures and songs 
with the same contents on 
your personal computer. 
(For more information, refer 
to “Synchronization”  on 
page 93.) 

Tip: To synchronize just your music files, refer to “Transfer music” on 
page 13. 
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Set background

This option lets you select a new background image for your 
Home screen. 

Tip: For a list of thumbnail views of the available Background images 
included with your i225, see “Personalizing Your Phone” on page 101.

1. From the Getting 
Started menu, select 
Set background ➔ 

Change the 
background image. 
The Home Screen 
menu appears in the 
display. 

2. Highlight the current 
Background image 
setting. 

3. Select a Background 
image using the Left 
and Right Navigation 
key, or do the 
following: 
• Press the Action key 

( ) to list the available Background images. 

• Select the desired Background image. 

4. Press the Done soft key to save your selection and return to 
the Getting Started menu. 

Set ring tone

This option lets you select a ringtone to play when you receive a 
call. 

1. From the Getting 
Started menu, select 
Set ring tone ➔ 

Change your ring tone 
➔ Ring Tone. The 
Ringtone screen 
appears in the 
display. 

2. Select a Ring tone 
using the Left and 
Right Navigation key, 
or do the following: 
• Press the Action key 

( ) to list the 
available Ring tones. 

• Select the desired Ring 
tone. 
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3. Press the Done soft key to save your selection and return to 
the Sounds menu. Press  to return to the Getting 
Started menu. 

Set location/GPS

This option lets you select 
whether your i225 will be 
constantly identifying its 
location to third-party 
location-based services, or 
only identifying itself to 
public safety and 
emergency services. 

1. From the Getting 
Started menu, select Set location/GPS ➔ set location/GPS. 
The Set location/GPS Location screen appears in the 
display, alerting you to the affects of selecting the ON 
setting. 

2. To read the Location information, press the Navigation key 
Down or use it as a Jog Wheel. 

3. At the bottom of the 
Location screen, 
select the desired 
setting for this 
option. 

Transfer music

This option explains how you can use Windows Media Player on 
your personal computer to synchronize the music files on your 
personal computer and on your i225. 

Add/remove Getting Started

This option lets you add a Getting Started icon to the Home 
screen or remove a Getting Started icon from the Home screen. 

1. From the Getting 
Started menu, select 
Add/remove Getting 
Started. 

The Add/remove 
Getting Started 
screen appears in 
the display. 
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Installing a microSD™ Storage Card

Note: Using the Music Player requires that you first install a Storage Card. 

Tip: Storage Cards with a storage capacity of over 32 GB will not work with 
this phone. 

1. Remove the battery cover and battery from your phone. For 
more information, refer to “Removing the Battery”  on 
page 6. 

2. Locate the storage card slot at the top of the battery 
compartment.

3. Make sure that the label side of the Storage Card is face 
up, as shown. 

4. Carefully slide the Storage Card into the storage card slot 
until you feel it click into place. 

5. Reinstall the battery and replace the battery cover on the 
phone. For more information, refer to “Installing the 
Battery”  on page 5. 

Tip: Storage Cards written to and/or formatted by other devices are likely to 
slow your phone’s response to commands and produce other unwanted 
results. To avoid such problems, format a used microSD Storage Card 
after inserting it in your handset. (For more information, refer to 
“Formatting a microSD Storage Card”  on page 115.) 

Removing a microSD Storage Card

1. Remove the battery cover and battery from your phone. For 
more information, refer to “Removing the Battery”  on 
page 6

2. Carefully press the Storage Card inward until you feel it 
release.

3. Slowly release your pressure on the card. It will slide 
outward a short distance.

4. Remove the storage card from the storage card slot.
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5. If desired, install another storage card in the slot. 

6. Reinstall the battery and replace the battery cover on the 
phone. For more information, refer to “Installing the 
Battery”  on page 5. 
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Section 2: Understanding Your Phone

This section outlines some key features of your phone. It also 
describes the screen format and the icons that will be displayed 
when the phone is in use. 

Your Phone’s Features
• Domestic and international voice and text messaging service (available 

on participating networks). 
•  Large [2.4 inch (diagonally) color screen (320 x 240 pixel resolution) 
• High speed data (EVDO Revision 0 Technology) 
• Bluetooth® Wireless Technology (see Note) 
• Global Positioning System (GPS) Technology 
• Digital Assistant Tools 
• QWERTY Keypad 
• Text (SMS), Picture (MMS), and E-mail Messaging 
• Built-in 2.0 Megapixel Digital Camera - Camcorder 
• Voice Dial 
• Media Player (MP3 — requires an optional Storage Card) 
• Storage Card Slot (microSD™ — up to 32 GB) 

Note: The i225 phone supports the wireless headset, hands-free, dial-up 
networking, personal area network, A2DP, AVRCP, phonebook access, 
serial port, basic printing, file transfer, and object push profiles for 
Bluetooth® wireless technology. 

Front View of Your Phone
Features

1. Earpiece — Lets you hear 
ringing and alert tones, 
alarm tones, and the other 
parties to calls. 

2. Charging Indicator — Glows 
red when the battery is 
being charged. Glows green 
when the battery is 
completely charged. 

3. Volume Key — From the 
Home screen, lets you 
adjust the System Volume. 
When receiving a call, lets 
you temporarily mute the 
ringer. 

4. Display — Indicates the status of your phone, including 
numbers dialed, feature and function screens, status 
icons, message indicators and contents, signal strength, 
and so on. 
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5. Navigation Key / Jog Wheel 
— In Menu mode, lets you 
scroll through the phone 
menu options. From the 
Home screen, press the 
Navigation key Left or Right 
to browse the icons in the 
Icon Bar, or press the 
Navigation key Up or Down 
or rotate it as a Jog Wheel 
to browse or scroll through 
any menu panes/options or 
icons appearing in the 
display. 

6. Left Soft Key — Used to 
navigate through menus 
and applications and to 
select the choice indicated at the bottom left corner of the 
Main LCD. 

7. Send Key — Lets you place or receive a call. From the 
Home screen, press the key once to access the recent 
calls log.

8. Home Key — Press to return to the Home screen. 

9. QWERTY Keypad — Use these 
keys to enter numbers, letters, 
and symbols. 

10. Fn Key — Toggles the text 
input mode to let you use the 
QWERTY keypad to enter 
numbers and symbols as well 
as letters. In Standby mode, 

11. Shift Key — Toggles 
capitalization for text input 
between initial capital letter 
(ABC), all capital letters (ABC), 
and all lower-case letters 
(abc). 

12. Calendar Key — Launches the 
Calendar tool. 

13. Sym Key — When entering 
text, press to launch a Symbols screen for selecting 
symbols. 

14. Microphone — Lets the other caller hear you clearly when 
you are speaking to them. 

15. Space / Vibrate Mode Key — Lets you enter spaces 
between words and characters. Press and hold this key to 
place the phone in Vibrate mode. 
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16. Voice Commands Key — Press 
and hold this key to activate 
Voice Commands. 

17. Messaging Key —Press to 
open the Messaging Inbox. 
Press and hold to launch the 
new Text message composer 
screen. 

18. Lock / Quick key — Returns 
you to the Home screen and 
manually locks all keys except 
the Unlock soft key. Press and 
hold to launch the Quick List 
menu. For more information, 
refer to “Quick List”  on 
page 35. 

19. Enter Key — Press to accept a 
text entry or to enter spaces between lines of text. 

20. Del Key — In text entry mode, deletes characters from the 
display. 

21. Camera Key — From the Home screen, press to launch the 
Content Manager screen, press and hold to launch the 
Camera feature of your phone. In Camera mode, press to 
take pictures. In Camcorder mode, press to start or pause 

video recording. 

22. Back Key — In text entry mode, deletes characters from 
the display. In menu mode, returns you to the previous 
menu or screen. 

23. End Key — Ends a call. Returns you to the Home screen. If 
you press and hold the END key, the power goes On or Off. 
When you receive an incoming call, press to send the call 
to voicemail. 

24. Right Soft Key — Used to navigate through menus and 
applications and to select the choice indicated at the 
bottom right corner of the Main Display. 

25. Action key — When navigating through a menu, accepts 
the highlighted choice in a menu. When selecting settings 
in an option screen, displays a list of available settings. 

26. Power / USB Connector — Used to connect charging 
accessories or optional USB Data cable to your phone. 

27. Headset Connector — Used to connect an optional headset 
(for hands free operation and/or music playback) or an 
optional TTY device. 
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Rear View of Your Phone

Features

1. Mirror — Helps you center the camera lens when taking 
self portraits. 

2. Camera Lens — The lens of your built-in camera. 

3. Speaker — Reproduces music, video soundtracks, and 
other sounds played by your phone. 

4. Battery Cover — Secures and protects the battery and the 
optional microSD storage card. 

5. microSD (Storage Card) Slot — Inside the battery 
compartment — Lets you install and remove optional 
microSD card for added image/photo and music storage. 

Command Keys
Soft Keys

Functions for the soft keys are indicated by labels that appear in 
the display above each soft key. There are two soft keys, Left 
( ) and Right ( ). 

Left Soft Key

Some functions of the Left soft key ( ) are as follows: 
• From the Home screen, press the Start soft key ( ) to open the 

Start menu. 
• When the Left soft key function is Done, press the Done soft key 

( ) to exit the current screen or menu and save any changes. 

Right Soft Key

Some functions of the Right soft key ( ) are as follows: 
• From the Home screen, press the Contacts soft key ( ) to launch 

the Contacts screen. 
• When the Right soft key function is Menu, press the Menu soft key 

( ) and a pop-up menu appears. 
• When the Right soft key function is Cancel, press the Cancel soft key 

( ) to back up one menu level. 

Action key
• From the Home screen, press the Action key ( ) to launch the Date 

and Time screen. 

1
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• In a menu, press  to accept the highlighted selection. 
• In camera mode, press  to take a photo. For more information, 

refer to “Camera – Camcorder”  on page 68. 
• In a list, press the Action key ( ) to view a highlighted item. 

Send Key

The Send key ( ) is used to answer calls, dial calls, and to recall 
the last number(s) dialed, received, or missed. 
• When receiving a call, press  once to answer the call. 
• Enter a number and press  to make a call. 
• From the Home screen, press  to display a list of recent calls to and 

from your phone and of Contacts. 
• Press  twice from the Home screen to call the most recent number. 
• Press  to pick up a waiting call. Press  again to switch back to the 

other call. 

Back Key

The BACK key ( ) is used to return to a previous menu or to 
return to Home screen from the Start menu. In some screens, you 
can also use the key to erase or clear numbers, text, or symbols 
from the display. 
• To back up one menu level, briefly press . 

Del Key

The Del key ( ) is used to erase or clear numbers, text, or 
symbols from the display. 
• If you enter an incorrect character, briefly press  to backspace (and 

delete) the character. 
• To erase the entire entry, press and hold . 

End Key
• Press and hold the End key ( ) to turn your phone on or off. 
• Briefly press  once to disconnect a call. 
• Press  to return to standby mode from any menu, or to cancel the 

last input. 

Navigation Key/Jog Wheel

Use the directional keys on the Navigation key ( ), or rotate it 
as a Jog Wheel, to browse menus, sub-menus, and lists. 

Camera Key

From the Home screen, press and hold the Camera key ( ) — 
located on the right side of your phone — to activate the camera 
built into your phone. 

In camera mode, pressing the Camera key ( ) takes a picture 

Note: For more information, refer to “Camera – Camcorder”  on page 68. 
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Fn Key

The Fn (Function) key ( ) changes the text input mode to 123 
mode. 

Entering Text
Your phone has a QWERTY (      ) keypad to 
support quick and easy text input. You can enter text as you 
would when using a computer keyboard.

The keys are labeled with a letter on the lower half and a number 
or symbol on the upper half. Press the key corresponding to the 
character you want to enter. 

In addition, you can use the following special function keys:

Press to delete characters.

Tip: You can also delete a character by pressing . 

Press to start a new line.

Press once to enter a single capital letter (ABC mode). 
Press twice to enter all capital letters (ABC mode). 
Press once more to enter all lower-case letters (abc 
mode). 

Press to pop-up the first of four pages of symbols in which 
you can select desired symbols. 

Press to toggle entry mode between abc (all lower-case 
letters, Fn (a single number or symbol), and Fn (all 
numbers or symbols). 

Press to insert a space in a text entry. 
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Understanding the Display Screens
Main Display

1. The top line of your phone’s display contains icons that 
indicate network status, battery power, signal strength, 
and more. (For more information, refer to “Display Screen 
Icons”  on page 22.) 

2. The center portion of the display shows information such 
as menus, call progress information, messages, and 
photos. 

3. The Shortcut bar is used to select which Home screen 
menu appears in the Samsung WizPro Home screen. (For 
more information, refer to “Home Screen”  on page 103.)

4. The bottom line of the display shows current soft key 
functions. The sample screen shows that pressing the Left 
(Start) soft key will display the Start menu and pressing the 

Right (Contacts) soft key will show the Contacts screen, 
listing all contacts. (For more information, refer to 
“Understanding Your Contacts”  on page 36.) 

Display Screen Icons

The following icons can appear in the Status bar:

3

2

1

4

Shows the strength of the signal. You can also view the 
following service status:
• Wireless is turned off. 

• No wireless coverage. 

Appears when the ring type has been set to Vibrate in the 
current profile or the ring tone in Sounds has been set 
to Vibrate. Also, appears when the Silent profile is 
activated. 
Appears when Bluetooth is activated. For details, see 
page 110. 

Appears when a Bluetooth headset or handsfree kit 
connects with your device. 
Appears when EVDO data transfer speed is available.
 
Appears when 1X data speed is available. 
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Dialogue Boxes

Dialogue boxes prompt for action, inform you of status, or warn 
of situations such as low battery. Dialogue boxes and their 
definitions are outlined below.
• Choice 

– Example: “Save Message?”

• Reconfirm 
– Example: “Erase All Messages?”

• Performing 
– Example: “Sending...” “Connecting...”

• Completed 
– Example: “Message Saved” 

• Information 
– Example: “New Message” 

• Error 
– Example: “System Error!” 

• Warning 
– Example: “Low Battery,” “Memory Full!” 

Backlights

Backlights illuminate the display and the keypad. When you press 
any key, the backlights come on. They go off when no keys are 
pressed within a period of time set in the Backlight menu. 

Note: During a phone call, the display backlight dims and turns off after 10 
seconds to conserve battery power, regardless of the Backlight setting. 
For more information, refer to “Power Management”  on page 109. 

Your Phone’s Modes
Standby Mode

Standby mode is the state of the phone once it has found service 
and is idle. The phone goes into standby mode: 
• After you power the phone on. 
• When you press  after a call or from within a menu. 

From the Home screen, you will see the time, day, and date as 
well as all phone status icons. 

Place Calls From the Home Screen

1. From the Home screen, enter a phone number, and press 
 to place a call. 

GPS location is on. 

GPS location is off unless you make an emergency (911) 
call. 
Appears when a text (SMS) message has been received.

Appears when an Email message or multimedia (MMS) 
message has been received. 
Appears when a new voicemail has been received. 



Understanding Your Phone       24

2. Press  to return to standby mode. 

Receive Messages From the Home Screen

You can receive text or MMS messages from the Home screen. 
An alert tone sounds and the message text or a notification 
message appears in the display when a new message arrives. 

The following message options appear when you press the Menu 
soft key: 
• Reply — Compose and send a message replying to this message. 
• Delete — Delete this message from the Inbox folder. 
• Go to Inbox — Lets you review this message and others and lets you 

access additional message options. 

Highlight the desired message option and then press . 

Adjust the System volume

From the Home screen, you 
can adjust the System 
volume for your phone by 
pressing the Volume key 
(on the left side of the 
phone) Up or Down. The 
System volume controls the 
volume of all sounds played 
by your phone, such as 
ringers, alerts, alarms, and multimedia files. 

1. From the Home screen, press the Volume key Up or Down 
to set the System volume as desired. 

When you are satisfied with the setting, press Done. Your phone 
returns to standby mode. 

Adjusting Individual Volume Settings

You can adjust individual volume settings by selecting a sound 
Profile and/or by changing individual sound Profile volume 
settings. 

To select a sound Profile: 

1. From the Home screen, press and hold the LOCK key. The 
Quick List appears in the display showing the following 
Profiles: 
• Normal 

• Silent 

2. For more profiles, select More... The following profiles 
appear in the Quick List screen: 
• Vibrate 

Note: The Vibrate icon ( ) appears in the display when the phone is in 
Vibrate mode. 

• Outdoor 

• Automatic 

3. Select the desired Profile. 
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Changing Profile sound settings: 

1. From the Home screen, press Start, then select Settings ➔ 

Profiles. The following sound Profiles appear in the display: 
• Normal 

• Silent 

• Vibrate 

• Outdoor 

• Automatic 

2. Highlight the desired sound Profile, then press the Menu 
soft key and select Edit. The following sound settings for 
the selected Profile appear in the display: 
• Name

• Ring type 

• Ring volume 

• Reminder type 

• Reminder volume 

• Notification type 

• Notification volume 

• System sound volume 

3. Highlight the desired setting and press the Navigation key 
Left or Right to change the highlighted volume setting. 

4. To save your setting(s), press Done. 

Call Answer Mode

You can choose to answer a call by pressing any key except , 
, or by pressing only  or the Answer soft key. For 

more information, refer to “Call Options”  on page 102. 

Talk Mode

You can place and receive calls only when your phone is on. 
While in a call, your phone is in talk mode. Press the Menu soft 
key to display a list of menu options. For more information, refer 
to “The In-Use Options Menu”  on page 31. 

Enter/Exit Vibrate Mode

Silences the tones your keypad makes when you press a key and 
replaces all ringers with vibration. 

To enter Vibrate Mode:

� From the Home screen, press and hold . The phone 
vibrates and the Silent Mode icon ( ) appears in the 
display and your sound Profile automatically changes to 
Vibrate. For more information, refer to “Adjusting Individual 
Volume Settings”  on page 24

To exit Vibrate Mode:

� While in Vibrate mode and standby mode, press and hold 
. The Silent Mode icon ( ) disappears from the 

display and your phone automatically returns to your 
preset/preselected sound Profile. For more information, 
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refer to “Adjusting Individual Volume Settings”  on 
page 24. 

Speakerphone Mode

Speakerphone mode lets you use your phone hands-free and/or 
share calls with others. 
• Entering Speakerphone Mode — During a call, press the Menu soft 

key, then select Speakerphone On. 
• Exiting Speakerphone Mode — During a call, press the Menu soft 

key, then select Speakerphone Off, or end the call. 

Hands-free Mode

Hands-free mode lets you operate your phone remotely, without 
touching it other than to turn it on or off. 

To place your phone in Hands-free mode, do one of the following: 
• Connect an optional wired headset. 

– or – 
• Pair and connect an optional Bluetooth technology headset or hands-

free car kit. For more information, refer to “Set up a Bluetooth 
headset”  on page 11. 

Camera Mode

Camera mode lets you take pictures with your phone’s camera-
camcorder. In Camera mode, you can also adjust the resolution 
and appearance of your pictures. 

For more information, refer to “Camera – Camcorder”  on 
page 68. 
• Entering Camera Mode — From the Home screen, press and hold the 

Camera key ( ) — on the right side of the phone. 
• Exiting Camera Mode — Press . 

Note: You can also enter Camera mode by pressing the Start soft key and 
selecting Camera. 

Camcorder Mode

Camcorder mode lets you record videos with your phone’s 
camera-camcorder. In Camcorder mode, you can also adjust the 
resolution and appearance of your videos. 

For more information, refer to “Camera – Camcorder”  on 
page 68. 
• Entering Camcorder Mode — From the Home screen, press and hold 

the Camera key ( ) — on the right side of the phone — then press 
. 

• Exiting Camcorder Mode — Press . 

Note: You can also enter Camcorder mode by pressing the Start soft key and 
selecting Camera, then pressing the Menu soft key and selecting Mode 
( ) ➔ Camcorder ( ). 
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Input Mode

Input mode determines how you enter text, numbers, and 
symbols. Optional text input modes are abc, ABC, ABC, Fn, and 
Fn. While at any text entry screen, press , , or  to toggle 
between the optional modes. For more information, refer to 
“Entering Text”  on page 21. 

Tip: You can toggle between abc, ABC and ABC entry modes by pressing . 

You can toggle between abc, Fn and Fn entry modes by pressing . 

Lock Modes

When the phone is in a Lock Mode, restrictions are placed on 
phone use. You can receive calls and messages, but cannot place 
outgoing calls (except for emergency numbers) until you unlock 
the phone. Lock Mode also restricts access to menus and the 
Volume key. 

Manually Locking Your Phone

Press and hold the Quick/Lock key ( ). 

Unlocking Manual Lock

Press the Unlock soft key, then press . 

Unlocking Automatic Lock

Unlock your phone by entering the lock code when prompted. For 
more information, refer to “Device Lock”  on page 114. 
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Section 3: Call Functions

This section explains how to make and answer calls. This section 
also describes the features and functionality associated with 
making or answering calls. 

Turning the Phone Functions On and Off
When set to Off, the Wireless Manager’s Phone option disables all 
radio functions of your phone. This prevents you from receiving 
or making calls (except emergency calls), but allows you to use 
other features (such as the camera and the Organizer) safely in 
sensitive environments, such as on board an aircraft. 

1. At the Home screen, 
press and hold the 
LOCK-Quick key 
( ). The Quick List 
appears in the 
display. 

2. Select Wireless 
Manager. The 
Wireless Manager 
screen appears in the display showing the following 
options: 
• All — Toggles both the Bluetooth and radio functions of your 

phone to On /Off at the same time. 

• Bluetooth — Enables/disables the Bluetooth functions of your 
phone. 

• Phone — On / Off — Enables/disables the radio functions of your 
phone. 

Tip: At the Home screen, you can also launch Wireless Manager by pressing 
Start and selecting Settings ➔ Connections ➔ Wireless Manager. 

3. If the Phone option is set to Off, select the Phone option to 
set it to On. 

4. To exit the Wireless Manager, press Done. 

Making Calls
This section explains how to make and answer calls. This section 
also includes the features and functionality associated with 
making or answering calls. 

Manual Dialing

1. With the phone on, enter the number you wish to call using 
the keypad. 

2. Press  to place the call. 

Dialing Emergency Numbers

To place an emergency call: 
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1. With the phone on, enter 911 using the keypad. 

2. Press  to place the call. 

You can specify other numbers as emergency numbers using the 
Emergency # settings. For more information, refer to 
“Emergency Numbers”  on page 115.

Important!: Emergency number 911 is preset into your phone. You can dial 
this number almost any time, even when the phone is locked or 
restricted. 

If you call 911 an audible tone is heard and an Emergency 
prompt appears in the display for the duration of the call. 

Important!: Because of various transmission methods, network parameters, 
and user settings necessary to complete a call from your 
wireless phone, a connection cannot always be guaranteed. 
Therefore, emergency calling may not be available on all 
wireless networks at all times. 

Important!: DO NOT depend on this phone as a primary method of calling 
911 or for any other essential or emergency communications. 

Dialing International Numbers

Call Another Country — 
Manual Method: 

1. From the Home 
screen, enter 011 
(the three-digit exit 
code for the United 
States). 

2. Enter the country 
code for the country that you are calling (in this example, 
82 for South Korea). 

3. Enter the number that you wish to call, then press . 

Note: Puerto Rico and Canada are on the North American dialing plan. 
Making calls to Puerto Rico and Canada is similar to making calls 
within the United States, no unique country codes are necessary. 

Call Another Country — 
Shortcut Method: 

1. From the Home 
screen, press and 
hold  until a plus 
sign (+) appears in 
the display. 
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Note: When you press , your phone automatically replaces this + with 
011, the three-digit exit code for the United States. 

2. Enter the number that you wish to call, then press . 

Calling Contacts

You can store phone numbers and contact names in your phone’s 
Contacts list. To call one of your Contacts, do the following: 

1. From the Home screen, press Contacts. The Contacts 
screen appears in the display. 

2. Enter the first few letters of a Contacts list entry name. For 
more information, refer to “Entering Text”  on page 21. The 
Contacts list displays the first few entries with names 
matching the letters you entered. 

3. Highlight the Contact you wish to call and press . For 
more information, refer to “Understanding Your Contacts”  
on page 36.

Speed Dialing

Speed Dialing lets you quickly and easily dial any contact in your 
Contacts list by using that contact’s location number in the list. 
You can assign and change location (speed dial) numbers for 
your contacts. For more information, refer to “Speed Dial”  on 
page 66.

One-Touch Dialing

Speed Dial numbers 2 through 9 are special One-Touch dialing 
numbers. You can call the phone numbers stored in your phone’s 
Contacts list and assigned Speed Dial numbers 2 through 9 by 
pressing and holding a single key. 

Example: For Speed Dial number 3, press and hold the  key until the name 
and number appear in the display and the number is dialed. 

Two-Touch Dialing

Memory locations 10 through 99 are special Two-Touch dialing 
locations. 

Example: For location number 13, briefly press , then press and hold  
until the name and number appear in the display and the number is 
dialed. 

Pause Dialing From a Contacts Entry
• If you speed dial a contact that contains (two-second) P pause(s) 

simply wait for the pauses to pass and the dialing to complete. 
• If you speed dial a contact that contains (hard) W pause(s), wait for the 

appropriate prompt(s) from the number you are calling (credit card 
number, bank account number, and so on) and enter the appropriate 
response(s). 



31

Calls Log Dialing

You can place a call to any number or Contact listed in the Calls 
Log. 

1. From the Home screen, press . The combined recent 
Calls and Contacts search screen appears in the display. 

2. Highlight a call by browsing the list by pressing the 
Navigation key Up or Down. 
– or –

By entering a string of numbers or letters and searching 
the list. 

3. Press  to call the highlighted number or Contact. 

Answering Calls
Your phone notifies you of a call in the following ways: 
• A ringtone sounds and/or your phone vibrates. 
• A phone number (unless blocked by the caller) and a name appear in 

the display (If the caller’s number and name are stored in your 
Contacts list). 

• If the caller can’t be identified, Call from unavailable#, Call from 
restricted number, or no number appears in the display. 

• Your phone continues to notify you of the call until one of the following 
events occurs: 
– You answer the call. 
– You ignore the call. 

– You mute the ringer. 
– The calling party ends the call. 
– The call is sent to voicemail. 

Answering an Incoming Call

� To answer a call, press  or press Answer. The ringtone 
and/or vibration stop and the caller’s voice can be heard in 
the earpiece. 

Tip: You can set your phone to automatically answer calls or to answer calls 
when you press any key but the  key. For more information, refer to 
“Call Options”  on page 102.

Adjusting the Call Volume

During a call, press the Volume key ( ) Up or Down until the 
you hear the other party to the call at the desired loudness. The 
Volume key is on the left side of phone. 

The In-Use Options Menu

You can access numerous menus and features while in a call. 

Note: If the call is disconnected while you are accessing an In-Use Option, 
the In-Use Option disappears from the display and the phone 
eventually returns to standby mode. 

1. While in a call, press Menu. 
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The following menu items appear in the display: 
• Mute / Unmute — Blocks/restores sound going to the other 

parties on this call. 

• Speakerphone On / Off — Enables/disables Speakerphone mode. 

• Turn Hands-free On / Off — Enables/disables Hands-Free mode. 
(Requires a headset or optional Handsfree Kit.) 

• Contacts — The Contacts Find screen appears in the display. 

• Save to Contacts — Saves the number calling/called to the 
Contacts list. 

• View Calendar — Launches the Calendar. For more information, 
refer to “Calendar”  on page 54.

• Call Log — The calls list appears in the display. 

2. Select the desired sub-menu or feature. 

Ignoring a Call

When you ignore an incoming call, the call is immediately 
forwarded to your voice mail.

� During an incoming call, press Ignore. The caller is 
forwarded to your voice mail. 

Muting the Ringer

To temporarily mute the Incoming Call ringer when receiving a 
call, press the Volume key, on the left side of your phone, Up or 
Down. 

Note: Muting the ringer does not forward an incoming call to your voice mail. 

Using the Speakerphone
During a call, you can place your phone in Speakerphone mode 
to free your hands or to share a call with others. 
• Entering Speakerphone Mode — During a call, press Menu, then 

select Speakerphone On. 
• Exiting Speakerphone Mode — During a call, press Menu, then 

select Speakerphone Off, or end the call. 

Displaying Your Phone Number
To display the phone number your Wireless Provider has 
assigned to your phone: 

� From the Home screen, press Start, then select Settings 
➔ More... ➔ More... ➔ Phone Information. The Phone 
Information screen appears in the display showing the 
phone number assigned to your phone. 

Reviewing Your Call History
To review your recent calls, press . 

To review all of your calls, press , then press Menu and select 
View ➔ All Calls. 
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Roaming-Networks
What is Roaming?

Roaming lets you use your i225 phone when you travel outside of 
your Wireless Provider’s coverage area. Extra charges may apply 
when making or receiving calls. 

Note: Some features may be unavailable while roaming. Roaming also 
consumes additional power from the battery requiring more frequent 
recharging. Contact your Wireless Provider for more information about 
Roaming. 

How Roaming Works

Roam Option lets you set roaming preferences if you move in and 
out of your home network. 

The following roaming options are available: 
• Home Only — Your phone is available for normal operation only in the 

designated coverage area.
• Automatic—Your Wireless Provider’s Preferred Roaming List (PRL) of 

networks is used to acquire service. If no preferred networks are 
found, any digital system is acquired. 

Note: For more information, refer to “Roaming”  on page 114
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Section 4: Menu Navigation

This section explains the menu navigation for your phone. It also 
includes an outline of all the available menus associated with 
your phone. 

Home Screen Menus
The i225 Home screen has unique, selectable Home screen 
layouts. Some of these Home screen layouts include transparent 
menus, accessed with the Icon Bar (Samsung WizPro) and/or the 
Navigation key/Jog Wheel. For more information, refer to “Home 
Screen”  on page 103. 

Samsung WizPro Home Screen

The Samsung WizPro Home screen layout provides a set of 
transparent menus that give you shortcut access to frequently-
used features and functions of your i225, some of which you can 
setup. 

� To change the displayed menu, press the Navigation key 
( ) Left or Right to select any of the available icons. 

� To browse a menu and display/highlight options, press the 
Navigation key Up or Down or rotate it as a Jog Wheel. To 
select a menu option, highlight it and press . 

� To return to the Home menu, highlight the Samsung WizPro 
Home icon ( ) or press . 

Start Menu
The Start menu is a multi-
page group of icons that 
give you access to the 
functions, features, and 
settings for your phone. 

� To page through the 
Start menu, press 
More. 

� To scroll through the Start menu or to highlight a particular 
icon, use  as a Navigation key or as a Jog Wheel. 

Shortcut Bar

Menu Area

Icon Bar
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Shortcuts

The i225 offers the following three sets of shortcuts to more 
easily and quickly access frequently-used sub-menus of the Start 
menu: 
• Samsung WizPro Home screen menus (See above.) 
• The Quick List menu. 
• Function keys. For more information, refer to “Fn Key”  on page 21

Quick List

The Quick List menu gives you easy access to a set of frequently-
used options. To launch the Quick List, do the following: 

� From any screen, press and hold the Quick/Lock key 
( ). The following options appear in the display: 
• Power off — Turns your phone off. 

• Lock — Locks all of your phone’s keys, except Unlock. All other 
keys light the backlight. 

• Task Manager — Lets you review and manage the software tools 
and applications running in phone memory. For more information, 
refer to “Task Manager”  on page 66 

• Wireless Manager — Launches the Wireless Manager screen 
which lets you enable/disable the Bluetooth and Phone (radio) 
functions. For more information, refer to “Wireless Manager”  
on page 110 

• Normal — Sound Profile. For more information, refer to 
“Selecting a Profile”  on page 109. 

• Silent — Sound Profile. For more information, refer to “Selecting 
a Profile”  on page 109. 

• More — Lists the Vibrate, Outdoor, and Automatic sound Profiles. 
For more information, refer to “Selecting a Profile”  on 
page 109. 

Numbered Menus
The options in a number of 
the sub-menus and pop-up 
menus are numbered for 
quick access, such as the 
Settings sub-menu. 

� To select a menu 
option, press the 
respective number 
key. 

Example: To select Power Management, press . 

To page through the Settings sub-menu, press . 
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Section 5: Understanding Your Contacts

This section details how you can manage your daily contacts by 
storing their names and numbers in your Contacts list. You can 
have your Contacts entries sorted by name. 

Contact Information
You can be store hundreds of Contacts entries (depending upon 
available memory) in the Contacts list. Each entry can have up to 
five associated phone numbers and one Email address. Each 
phone number can be up to 32 digits in length, including 2-
second Pauses or Waits, and associated names can be up to 32 
characters in length. You can also assign Speed Dial numbers of 
your choice for Contact entries. For more information, refer to 
“Speed Dial”  on page 66.

Adding a Contact
You can use any of three 
methods to add an entirely 
new entry to the Contacts 
list. 

Menu Method

1. From the Home 
screen, press 
Contacts. The 

Contacts screen appears in the display. 

2. Press New. The 
Select a Type screen 
appears in the 
display. 

3. Select the desired 
Contact type. The 
Contact screen 
appears in the 
display with fields 
unpopulated. 

4. Enter or select values 
for each field in turn. 
• Highlight each field by 

using the Jog Wheel or 
pressing the 
Navigation key Up or 
Down. 

• Enter values using the 
keypad. 

• Select values by pressing the Navigation key Left or Right. 
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• View a list of available values for a highlighted selection field by 
pressing . 

5. To save your settings, press Done. 

Call Save Method

1. During a call, press Menu and select Save to Contacts. The 
Select a Contact screen appears in the display. 

2. Select the <New Contact> option. The Save to Contact 
screen appears in the display with the new number 
populating a Number field. 

3. Enter or select values for other fields in turn. 
• Highlight each field by using the Jog Wheel or pressing the 

Navigation key Up or Down. 

• Enter values using the keypad. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted selection field by 
pressing . 

4. To save your new Contact, press Save. 

Adding Dialing Pauses

When you call automated systems (like banking services), you 
are often required to enter a password or account number. 
Instead of manually entering the numbers each time, you can 
store the password or account numbers in your Contacts along 
with special characters called pauses. 

• 2-Sec Pause — P pause — A two-second pause stops the calling 
sequence for two seconds and then automatically sends the remaining 
digits. 

• Wait — W pause — A hard pause stops the calling sequence until you 
press . 

To add pause(s) to Contacts: 

1. Create a new contact. For more information, refer to 
“Menu Method”  on page 36 or see “Call Save Method” on 
page 37. 

2. Press Menu. A pop-up menu containing the following 
options appears in the display: 
• Insert Pause — a two-second pause — adds a “p” to the 

number. 

• Insert Wait — a hard pause (awaits input from you) — adds a 
“w” to the number. 

3. Select the desired pause option. 

4. To save your new Contact, press Save. 

Note: If you select Insert Pause, P appears in the display. If you select Insert 
Wait, W appears in the display. 

Receiving Contacts from Other Phones

1. Pair with another phone using Bluetooth. For more 
information, refer to “Bluetooth”  on page 110. 
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2. When prompted, accept connection with the other 
Bluetooth device. 

3. Verify the new Contact is in the Contacts. 

Finding a Contact
1. From the Home screen, press Contacts. The Contacts 

screen appears in the display. 

2. Enter the first few letters of the Contact name. For more 
information, refer to “Entering Text”  on page 21. A list of 
matching Contacts appears in the display. 

3. Highlight the desired Contact by pressing the Navigation 
key Up or Down. 

Changing Contact Information
1. From the Home screen, press Contacts. The Contacts 

screen appears in the display. 

2. Find and highlight the Contact you want to change. For 
more information, refer to “Finding a Contact”  on page 38. 

3. Press Menu, then select Edit. 

4. Enter or select new values for each field in turn. 
• Highlight each field by using the Jog Wheel or pressing the 

Navigation key Up or Down. 

• Enter/change values using the keypad. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted selection field by 
pressing . 

5. To save your settings, press Done. 

Deleting a Contact
1. From the Home screen, press Contacts. The Contacts 

screen appears in the display. 

2. Find and highlight the Contact you want to change. For 
more information, refer to “Finding a Contact”  on page 38. 

3. Press Menu, then select Delete. You are prompted to 
confirm your deletion. 

4. To confirm your deletion, press Yes. 
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Section 6: Messaging

This section explains how to send or receive different types of 
messages. This section also describes the features and 
functionality associated with the various types of messaging. 

Types of Messages
Your i225 can send Text (SMS) messages, Multimedia [picture or 
video (MMS)] messages, E-mail messages, and Instant 
Messages (IM). 

Text and Multimedia Messages

You send Text and Multimedia messages by simply entering the 
phone number of the recipient in the To: field when creating a 
new message. Text messages can be up to 160 characters in 
length. 

E-mail Messages

With the i225 you can send E-mail in two ways: 
• Directly, through an Internet Protocol (IP) account, or 
• Indirectly, by using Microsoft ActiveSync™ to exchange E-mail 

through your PC 

Instant Messages

The i225 includes Windows Live® for Mobile and Windows Live® 
Messenger instant messaging. 

Sending Messages
Creating and Sending Text Messages

1. From the Home screen, press Start, then select Messaging 
( ) ➔ Text Messages. The Text Messages screen 
displays showing the contents of a Text Messages folder 
(in this case, the Inbox folder). 

2. Press Menu, then 
select New. The Text 
Messages 
composition screen 
displays. 

3. Enter multiple phone 
number or E-mail 
addresses of 
recipient(s) in the To 
field. 
• Use the keypad to place a semicolon between numbers, if there is 

more than one recipient. 

4. Select the message text input field and use the keypad to 
enter the text content of your message. For more 
information, refer to “Entering Text”  on page 21. 
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Note: There is a 160-character limit for text messages. If you send a text 
message with more than 160 characters, the message is truncated 
after the first 160 characters and the remaining characters are then 
sent in consecutive messages until the entire message text has been 
sent. Charges may apply in accordance with the sender's and the 
recipient's calling plans.

5. For additional message options, press Menu. The following 
options are available: 
• Add Recipient — Add Contacts entries.

• Check Names — Check contacts for the name of the recipient. 

• Insert — Insert a Picture, Sound, Video, or Voice Notes file into 
your message. This automatically changes a Text message to a 
Multimedia (MMS) message. 

• My Text — Add pre-composed text to this message. 

• Save to Drafts — Saves the message to the draft folder.

• Copy/Paste — Lets you select some or all text in this message, cut 
or copy the selected text, and paste the cut or copied text at a new 
place in the message.

• Cancel Message — Cancels the new message.

• Message Options — Launches the Message Options screen, 
which lets you select whether to receive notification when this 
message is delivered, change the delivery Priority, and change the 
Callback number to be included with this message.

6. Press Send to transmit your message to the selected 
recipients. 

Checking Names Within a Text Message

� While creating a Text message, press Menu and select 
Check Names. For more information, refer to “Creating and 
Sending Text Messages”  on page 39. 

Recipient names currently used within the To filed are 
verified against the current Contacts list and e-mail 
addresses are reviewed to verify they conform with the 
standard E-mail formats. 

Creating and Sending Multimedia Messages

1. From the Home screen, press Start, then select Messaging 
( ) ➔ MMS. The MMS screen appears in the display 
showing the contents of a Messages folder. 

2. Press Menu, then 
select New. The 
Multimedia Message 
composition screen 
displays. 

3. Enter the phone 
number or E-mail 
addresses of up to 
ten recipient(s) in the 
To field. 
• Use the keypad to place a semicolon between numbers, if there is 

more than one recipient. 
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4. Select the Subject 
field and use the 
keypad to enter a 
subject for your 
message. 

5. Select the message 
text input field and 
use the keypad to 
enter the text 
content of your message. For more information, refer to 
“Entering Text”  on page 21.

6. To add existing 
photos, music files, 
or video clips to your 
message or to 
launch the Camera 
or Sound Recorder to 
take or record new 
files and add them to 
your message, select 
the appropriate icon(s) on the bottom line of the 
Multimedia Message composition screen. 

7. To access additional Multimedia message options, press 
Menu. The following options are available: 

• Preview — Allows you to preview the new MMS message prior to 
delivery.

• Add Recipients — Add Contacts entries or numbers from the 
recent Calls log. 

• Edit Item — Lets you Copy, Cut, Paste, Remove, or Replace a 
picture, video, or sound file. 

• Add — Lets you attach both pre-existing or new files to the new 
MMS message: Picture, Sound, Voice Notes, Video, New Picture, 
New Sound, New Video, Text and MMS Template.

• Attach — Attach your vCard, vCalendar, or a File. 

• Edit Slide — Add Slide, Delete Slide, Order Slide, Text Style, 
Background Color, Duration, Move Slide Up, Move Slide Down in a 
multi-page message. 

• Save to — Lets you save the current Multimedia message as a 
Draft or an MMS Template.

• Cancel Message — Lets you save the current message as a draft 
and exit the message composer.

• MMS Options — For more information, refer to “Configuring 
Multimedia Message Parameters”  on page 46 

8. Press Send to transmit your message to the selected 
recipients. 

Note: Charges may apply in accordance with the sender's and the recipient's 
calling plans. 



Messaging       42

Using My Text Messages
My Text Messages consist of 9 pre-composed text message 
phrases you can quickly insert into the body of a new message or 
as a response to a received message without having to type a 
message. These default messages are: 
• What are you up to?
• Just checking in...
• Where are you?
• Check this out!
• I’ll be right there.
• I’m running late.
• I’ll get back to you.
• Urgent! Please reply ASAP.
• Let’s catch up soon.

Inserting My Text in a Message

1. Create a new message. For more information, refer to 
“Sending Messages”  on page 39 

2. Press Menu and select My Text.

3. Select a desired message from the list. The selected 
message is then inserted into the body of the message. 

4. Complete your message. For more information, refer to 
“Sending Messages”  on page 39 

5. Press Send to transmit your message to the selected 
recipients. 

Editing My Text

1. Create a new message. For more information, refer to 
“Sending Messages”  on page 39 

2. Press Menu and select My Text. 

3. Select a pre-existing Text Message entry. 

4. Press Menu and select Edit My Text. The highlighted Text 
Message is opened for editing.

5. Use the keypad to edit the text. For more information, refer 
to “Entering Text”  on page 21.

6. Press Done to save your changes. 

7. Press Insert return to the message and include your 
changed text. 

Retrieving a Message
When you receive a new text, picture, or video message, the 
message ringer sounds (unless turned off) and the message 
displays in a preview pane. 

Note: The Text Message Notification  icon displays on the top of the 
screen. 

1. To remove the preview pane from the Home screen, 
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press any key. 

2. To re-open and display the message in the Home screen, 
press the Up or Down Navigation key to highlight your new 
message and press . 

Read Text Messages Options

Several message features are available when reading a text 
message.

� While reading a received text message, press Menu. The 
following options are available:
• Delete — Deletes the message.

• Forward — Send a copy of this message to another recipient. 

• Insert — Add Picture, Sound, Video, or Voice Notes files to any 
reply to this message. 

• My Text — Add pre-composed text to any reply to this message. 

• Save to Drafts — Saves a copy of any reply to this message in the 
Drafts folder. 

• Copy/Paste — Lets you select some or all text in this message, cut 
or copy the selected text, and paste the cut or copied text at a new 
place in the message.

• Close — Returns you to the Inbox folder contents screen. 

• Message Options — Lets you Request delivery notification, set 
delivery Priority, and send a Callback number. 

Read Multimedia Message Options

Several message features are available when reading a 
Multimedia message.

� While reading a received Multimedia message, press 
Menu. The following options are available:
• Mute — Silence playback of attached audio file or audio from 

attached video file. 

• Stop — Stop attached audio file or video playback. 

• Delete — Delete this message.

• Reply/Forward — Send a Text or Multimedia message reply to the 
sender or to all recipients of the message or forward the message 
to another number or email address. 

• Mark as Unread — Lets you mark the message as unread. 
Unread messages are boldfaced on the message list. 

• Resend — Inactive. 

• Message Info — Displays send Date. Size, Priority, Expiration date, 
and Read Report information. 

• From Address — Call the sender or save sender’s number to your 
Contact list. 

• Save as Template — Save this message as a pre-composed, 
Multimedia message template for later reuse. 

• Attached Files... — View and/or save attached picture file and/or 
sound file, or video file. 
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Accessing Message Folders
Although this procedure shows Text Messages folders, the basic 
process and folder types are the same for all message types. 

1. From the Home 
screen, press Start, 
then select 
Messaging ( ) ➔ 

Text Messages. The 
Text Messages 
screen displays 
showing the 
contents of a 
Messages folder (in this case, the Inbox folder). 

2. Press Menu and 
select Folders. A 
menu tree that lists 
Text Messages 
folders appears. The 
available Text 
Messages folders 
are: 
• Deleted Items — 

Stores messages that you delete from the other folders. This lets 
you recover messages that were erased accidentally. 

• Drafts — Lets you store messages for later completion and/or 
reuse. 

• Inbox — Stores your incoming (received) messages. 

• Outbox — Stores your outgoing messages until they are sent. 

• Sent Items — Stores your outgoing messages that have been 
sent.

(For information about Outlook E-mail folders, refer to the 
Microsoft Outlook user manual.) 

3. To display the contents of a folder, select it. 

Received Text Message Options

Several message features are available for received text 
messages.

1. From the Messages Inbox folder screen, highlight a text 
message and press Menu. The following options are 
available:
• New — Lets you create a new Text or Multimedia message.

• Delete — Removes this message from the Inbox folder and places 
it in the Deleted Items folder. To delete more than one message, 
use the Select Messages option. 

• Mark as Unread — Changes the status of this message from 
Read to Unread.

• Move — Lets you move this message to other folders. 
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• Folders — Lets you display the contents of the Text Messages 
folders: Deleted Items, Drafts, Inbox, Outbox, and Sent Items. 

• Tools: 

– Switch Accounts — Returns you to the Messaging menu to 
select another Messaging account: Text Messages, MMS, or an Outlook 
E-mail account. 

– Empty Deleted Items — Allows you to permanently erase all 
messages from the Deleted Items folder. 

– Options — Allows you to change the Messaging options. 

• Select Messages — Select All messages, All Below this message, 
or Several messages to which other functions will be applied. 

• Reply/Forward — Lets you Reply to the sender of this message, 
Reply to the sender and All receivers of this message. 

Received Multimedia Messages Options

Several message features are available for received Multimedia 
messages.

1. From the Messages Inbox folder screen, highlight a 
Multimedia message and press Menu. The following 
options are available:
• New — Lets you create a new Text or Multimedia message.

• Reply/Forward — Sends a reply to the sender and/or all other 
recipients, or forwards this message to other people.

• Mark as Unread — Changes the status of this message from 
Read to Unread.

• Move — Lets you move this message to any of the other MMS 
folders.

• Folders — Lets you display the contents of the MMS folders: 
Deleted Items, Drafts, Inbox, Outbox, and Sent Items. 

• Message Info — Shows the Subject, Sent Date, Size, Priority, and 
Expiration time limit for this message. 

• Tools: 

– Switch Accounts — Returns you to the Messaging menu to 
select another Messaging account: Text Messages, MMS, or an Outlook 
E-mail account. 

– Empty Deleted Items — Allows you to permanently erase all 
messages from the Deleted Items folder. 

– Options — Allows you to change the Messaging options. 

• Select Messages — Select All messages, All Below this message, 
or Several messages to which other functions will be applied. 

• Send/Receive — Inactive. 

• MMS Options — For more information, refer to “Configuring 
Multimedia Message Parameters”  on page 46. 

Configuring Message Parameters
1. From the Home screen, press Start, then select Messaging 

( ) ➔ Text Messages / MMS. The Text Messages screen 
or the MMS screen appears in the display showing the 
contents of a Messaging folder. 
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2. Press Menu, then select Tools ➔ Options. The following 
options appear in the display: 
• Display — Lets you select whether to show message dates and 

times in the message list, how the message list will sort messages, 
and what screen will appear in the display after you delete or move 
a message. 

• Sending — Lets you specify whether to include a copy or an 
original message with any reply to that message and whether to 
save copies of sent items. 

• Signatures — Lets you compose and assign a text signature to a 
specific Messaging account. 

• Account Settings — Lets you select whether to request delivery 
notifications for your outgoing messages or whether to always send 
your callback number with your outgoing messages. 

• Setup E-mail — Lets you setup a new Outlook E-mail account. 

• Security Settings — Lets you specify whether Messaging with 
pop-up a warning before navigating to a URL or file link not on your 
phone. 

• Other — Lets you specify whether Messaging will display the 
“account picker” screen when launched or whether Messaging will 
warn you to confirm deleting of messages. 

3. Select the desired option to display and change its 
settings. 

4. To save your changes, press Done. 

Configuring Multimedia Message Parameters

1. From the Home screen, press Start, then select Messaging 
( ) ➔ MMS. The MMS screen appears in the display, 
showing the contents of an MMS folder. 

2. Press Menu, then select MMS Options. The following 
options appear in the display: 
• Sending Options — 

Lets you set delivery 
options and delivery 
reporting options for 
Multimedia messages. 

•
Receiving Options — 
Lets you specify how 
your phone reacts to 
incoming Multimedia 
messages. 



47

• Composer Options 
— Lets you select 
Message Class and 
Creation Mode 
settings for composing 
Multimedia messages. 

• About — Displays 
version information for 
Samsung’s 
Multimedia Message 
software. 

3. To save your new settings, press Done. 

Accessing E-mail Setup
You can configure i225 Messaging to send and receive E-mail 
using Microsoft Outlook, ActiveSync, and a PC or using an IP 
account. 

Setting Up an Internet Service Provider (ISP) Account

You can use your i225 to access the Internet for E-mail using a 
connection through your Wireless Carrier or using a Wi-Fi 
connection. For more information, refer to “Connections”  on 
page 110.

1. From the Home 
screen, press Start, 
then select 
Messaging ( ) ➔ 

Setup E-mail.The E-
mail Setup screen 
appears in the 
display listing e-mail 
account types. 

2. Select the desired e-mail account type. 

3. Enter your E-mail address and password into the 
appropriate fields and press Next. 

4. You are prompted to 
let your handset 
automatically obtain 
E-mail settings. 
• If this account is to 

access a public ISP 
E-mail server, press 
Next. 

• If this account is to 
access a private E-mail server (such as your employer’s), disable 
this function by selecting the checkbox next to the prompt. The 
check mark disappears. Then, press Next. 
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Note: For private E-mail servers, you will be prompted for specific 
information about the server. 

- Server URL or IP address 
- Server access authentication (nearly always required and usually 
   the same as your account ID and password) 
- Whether the server requires SSL (Secure Sockets Layer) 
- Type of connection used to access the server 

Contact the server operators or your ISP for this information. 

5. You are notified when setup is complete. (For ISP servers, 
you are prompted to select an automatic contact interval.) 

Using an ISP for E-mail

You can configure the i225 to use an Internet Service Provider 
(ISP) or your network at work to send E-mail directly from the 
i225 without connecting to your PC through ActiveSync. 

1. From the Home screen, press Start, then select Messaging 
( ) ➔ your E-mail account. 

2. Review your received E-mail as needed. 

3. To create and send E-mail, press Menu, and select New. 
The E-mail composition screen displays. 

4. Enter the E-mail address in the To field. 

5. Select the Subject field and enter a subject. 

6. Select the message text field and enter the content of your 
E-mail message.

7. When you’re finished, press Send. 

Setting Up an Outlook E-mail Account

� Install ActiveSync on your PC and set up a Standard 
Partnership, so you can send/receive E-mail. For more 
information, refer to “Setting Up and Configuring 
ActiveSync”  on page 94.

Using Microsoft Outlook for E-mail

Using Microsoft Outlook, E-mail is composed off-line and is sent 
to the intended recipient(s) the next time you synchronize using 
ActiveSync. 

Note: For more information on how to wirelessly synchronize your e-mail, 
refer to the Wireless Sync documentation included within the 
ActiveSync Companion CD. 

1. From the Home screen, press Start, then select Messaging 
( ) ➔ Outlook E-mail. 

2. Review your received E-mail as needed.

3. To create an send E-mail, press Menu, and select New. 
The E-mail composition screen displays. 

4. Enter the E-mail address in the To field. 

5. Select the Subject field and enter a subject. 

6. Select the message text field and enter the content of your 
E-mail message.
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7. When you’re finished, press Send. 

Outlook E-mail Folders

There are five message 
folders in the Outlook E-
mail directory (see adjacent 
image), and their functions 
are similar to the folders in 
the Text Messages 
directory, except for the 
Outbox folder. 
• Using ActiveSync, E-mail is 

stored in the Outbox until you synchronize with your PC. 
• Using an ISP, E-mail is stored in the Outbox folder until message 

sending is complete. 

The following is a list of Outlook E-mail messaging folders and 
their functions.
• Deleted Items — sent to the Deleted Items folder. Once messages are 

removed from the Deleted Items folder, they are permanently erased.
• Drafts — contains all messages that were not completed and saved to 

send at a later date.
• Inbox — all incoming messages arrive and are stored in the Inbox 

until deleted. If memory is full, new messages are rejected. Delete 
older messages to free up space for incoming messages. 

• Outbox — the Outbox stores unsent messages until they send.

• Sent Items — keeps a record of all sent messages from your device. 

Configuring E-mail Parameters

1. From the Home screen, press Start, then select Messaging 
( ) ➔ <E-mail Account>. The selected E-mail account 
folder (usually Inbox) screen appears in the display. 

2. Press Menu, then select Settings. The following options 
appear in the display: 
• Edit Account Setup — Lets you change your E-mail account 

access settings. 

• Send/Receive Schedule — Lets you change the Automatic Send/
Receive interval, the age of the messages to be Downloaded to 
your phone, and Advanced Settings. 

• Download Size Settings — Lets you select the Message content 
format for your received E-mail messages and the Message 
download limit to specify how much of a message to initially 
download to your handset. 

3. To save your changes, press Done. 

Launching Windows Live® Instant Messaging
To launch Windows Live: 

� From the Home screen, press Start, then select Internet ➔ 

Messenger / Windows Live. 



Internet       50

Section 7: Internet

The i225 includes a number of applications to help you explore 
and enjoy the Internet. 

Internet Explorer
You can use Internet Explorer to view web pages in two different 
ways: 
• By downloading pages and then performing an ActiveSync operation.
• By connecting to the Internet Directly via your wireless data 

connection.

While browsing you can also download new files and programs. 

Launch Internet Explorer

� From the Home screen, press Start, then select Internet 
Explorer ( ).

Note: Internet Explorer Mobile does not support all browser functions 
supported by Internet Explorer on a personal computer. Therefore, 
browser functions might not work properly with some Internet sites. 

Save Favorites

When you find a web page that contains useful or interesting 
information, it can be saved as a favorite.

1. In standby mode, press Start, then select Internet Explorer 
( ).

2. Press Menu, then select Go to Web Address. 

3. Enter the web address into the Address field and press Go. 

4. Press Menu and select Add to Favorites.

5. Select the Name field and use one of the text entry 
methods to enter a bookmark name.

6. Select the Folder field and choose a bookmark storage 
location (Favorites).

7. Press Add to store the bookmark and return to the web 
page. 

Internet Sharing
Internet Sharing lets you share i225 Internet connections with a 
single personal computer or with a network. (For more 
information, go to http://www.microsoft.com/windowsmobile/en-us/
help/v6-0/connect-computer-internet-using-device-modem-
touch.aspx.) 

Note: Please contact your Carrier before using your phone as a modem 
through Internet Sharing or Tethering.  A tethering service plan is 
required due to high data usage. 

http://www.microsoft.com/windowsmobile/en-us/help/v6-0/connect-computer-internet-using-device-modem-touch.aspx
http://www.microsoft.com/windowsmobile/en-us/help/v6-0/connect-computer-internet-using-device-modem-touch.aspx
http://www.microsoft.com/windowsmobile/en-us/help/v6-0/connect-computer-internet-using-device-modem-touch.aspx
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To launch Internet Sharing: 

� From the Home screen, press Start, then select Internet 
( ) ➔ Internet Sharing ( ).

Messenger
For more information, refer to “Launching Windows Live® 
Instant Messaging”  on page 49. 

RSS Reader
With RSS (Really Simple Syndication) Reader, you can have 
information sent to you from selected web sites, rather than 
having to visit these sites individually and repeatedly. 

To setup RSS Reader, do the following: 

1. From the Home screen, press Start, then select Internet 
( ) ➔ RSS Reader. The RSS Reader – Feeds screen 
appears in the display. 

2. Follow the instructions on the screen to setup your folders 
and subscribe to your feeds. 

Windows Live
For more information, refer to “Launching Windows Live® 
Instant Messaging”  on page 49. 
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Section 8: Personal Assistant Tools

This section explains how to use your phone’s digital assistant 
tools to schedule events, set reminders, perform calculations, 
and more. 

Organizer
To access Organizer tools: 

� From the Home 
screen, press Start, 
then select Organizer 
( ). The 
Organizer screen 
appears in the 
display. 

Alarms

Your phone has an alarm clock that can be set to go off once, or 
daily at a specified time. Once set, the alarm clock is easy to 
change or turn off completely.

Note: The alarm doesn’t function when the phone is turned off. If the time for 
an alarm that was set for Once has elapsed and the phone is off, the 
alarm occurs at the same time on the following day. 

1. From the Organizer 
screen, select 
Alarms. The 
following options 
appear in the display: 
• Wake up alarm 

• Alarm 1 

• Alarm 2 

• Alarm 3 

• Alarm 4 

• Alarm 5 

• Alarm 6 

2. Select an Alarm. An 
Alarm screen 
appears in the 
display. 

3. Enter or select values 
for each setting in 
turn. 
• Highlight each setting. 
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• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

4. To save your settings, press Done. 

When an Alarm Sounds

An animated alarm clock appears in the display with the options 
Snooze or Dismiss, and an alert sounds when the specified time 
for the alarm arrives. 

� To silence the alarm, press Dismiss. 
• If the alarm was set as a Daily alarm, the alarm icon remains in the 

center portion of the display. 

• If the alarm was set as a Mon.-Fri., the alarm icon remains in the 
center portion of the display. 

• If the alarm was set as a Weekends only alarm, the alarm icon 
remains in the center portion of the display. 

Turn Off the Alarm

Turning off an Alarm stops 
it from sounding when the 
set time is reached while 
retaining the Alarm settings 
for your reuse. 

1. From the Organizer 
screen, select 

Alarms ( ). A list of alarms appears in the display. 

2. Highlight the Alarm you wish to turn off. 

3. Press Edit. The selected Alarm screen appears in the 
display. 

4. Highlight Activation and select Off. The highlighted Alarm is 
turned off, but the alarm settings are retained for later 
reuse. 

Anniversary

Anniversary lets you set reminders of events important to you. 

� From the Organizer screen, select Anniversary ( ). The 
Anniversary screen appears in the display, listing any 
anniversaries. 
• If there are no anniversaries, press New to create one. 

Creating a New Anniversary

1. In the Anniversary 
screen, press New. 
The New Anniversary 
screen appears in 
the display. 

2. Enter or select values 
for each setting in 
turn. 
• Highlight each setting. 
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• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

3. To save your settings, press Done. 

Changing an Anniversary

1. In the Anniversary screen, highlight the anniversary you 
want to change. 

2. Press , or press Menu and select Edit. The Edit 
Anniversary screen appears in the display. 

3. Enter or select values for each setting in turn. 
• Highlight each setting. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

4. To save your settings, press Done. 

Deleting Anniversaries

1. In the Anniversary screen, highlight an anniversary you 
want to delete. 

2. To delete one anniversary, press Menu and select Delete. 
You are prompted to confirm your deletion. 

3. To delete more than one anniversary: 
• Press Menu and select Select. The following options are available: 

– Several 

– All 
• If you select Several: 

– Highlight each anniversary you want to delete, then press . 

– Press Menu, then select Delete. 

You are prompted to confirm your deletion. 

4. To delete your selection(s), press Yes. 

Calendar

Calendar lets you view the current, past, or future month in a 
monthly calendar layout. While viewing the calendar, the current 
date is highlighted and days with scheduled appointments are 
surrounded by a box. 

View an Appointment

1. From the Home 
screen, press Start 
and select Calendar 
( ). The day’s 
agenda appears in 
the display with the 
first appointment 
highlighted. The 
current date appears at the top of the screen. 

2. Use the following keys to navigate your calendar: 



55

• To move from one day to another, press the Navigation key Left or 
Right. 

• To move from one week to another, press Week, then the 
Navigation key Left or Right. 

• To view previous months, press Menu, then select Go to Date and 
enter the desired month. 

• To change the calendar view to monthly, press Month, when 
available, or press Menu, then select Month View. 

• To access other options, press Menu while viewing the calendar. 
Select the desired option to perform the related process. 

3. In Agenda or Week view, select the desired appointment. 

4. In Month view, select the desired day, then select the 
desired appointment. Information for the selected event 
appears in the display. 

Add a New Appointment

1. From the Home 
screen, press Start 
and select Calendar 
( ). The day’s 
agenda appears in 
the display with the 
first appointment 
highlighted. The 
current date appears at the top of the screen. 

2. Press Menu, then select New Appointment. The New 
screen appears in the display. 

3. Enter or select values for each setting in turn. 
• Highlight each setting. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

4. To save your settings, press Done. 

Deleting an Appointment

1. From the Home screen, press Start and select Calendar 
( ). The day’s agenda appears in the display with the 
first appointment highlighted. The current date appears at 
the top of the screen. 

2. Navigate to the appointment you want to delete. 

3. Press Menu, then select Delete Appointment. You are 
prompted to confirm your deletion. 

4. To delete your selected appointment, press Yes. 
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Personalizing Your 
Calendar

1. From the Calendar 
screen, press Menu, 
then select Tools ➔ 

Options. The Options 
screen appears in 
the display. 

2. Enter or select values for each setting in turn. 
• Highlight each setting. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

3. To save your settings, press Done. 

Tasks

� From the Organizer 
screen, select Tasks 
( ). The Tasks 
screen appears in 
the display listing 
any Tasks. 

Adding a New Task

1. In the Tasks screen, 
highlight the Enter 
new task here field 
and enter the name 
of the new task. 

2. Press . The new 
Task appears in the 
list. 

3. Press . The Tasks 
screen changes to 
show the name of 
the new Task. 

4. Press Edit. The Edit 
screen appears in 
the display. 

5. Enter or select values 
for each setting in turn. 
• Highlight each setting. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

6. To save your settings, press Done. 
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Viewing a Task

1. In the Tasks screen, 
highlight the task you 
want to view. 

2. Press . The Task 
information appears 
in the list. 

3. To change the Task, 
press Edit. 

4. For other options, press Menu. 

Deleting a Task

1. In the Tasks screen, highlight the task you want to delete. 

2. Press Menu, then select Delete Task. You are prompted to 
confirm your deletion. 

3. To complete the deletion, press Yes. 

Voice Notes

� From the Organizer 
screen, select Voice 
Notes ( ). The 
All Notes screen 
appears in the 
display listing any 
voice notes. 

Recording a New Voice Note

1. From the Organizer 
screen, select Voice 
Notes ( ). The 
All Notes screen 
appears in the 
display listing any 
voice notes. 

2. To begin recording, 
press Record. A 
Recording screen appears in the display. 

3. To stop recording, 
press Stop. The new 
recording appears in 
the All Notes list. 

4. To rename the new 
Voice Note or access 
other options, press 
Menu. 
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Playing a Voice Note

1. In the All Notes 
screen, select the 
Voice Note you want 
to listen to. The 
selected Recording 
screen appears in 
the display and 
Playing begins. 

2. To end playback, press Stop. 

Deleting a Voice Note

1. In the All Notes screen, highlight the voice note you want to 
delete. 

2. Press Menu, then select Delete. You are prompted to 
confirm your deletion. 

3. To complete the deletion, press Yes. 

World Clock

� From the Organizer 
screen, select World 
Clock ( ). The 
World Clock screen 
appears in the 
display showing the 

current local time and any Clock assignments. 

Assigning a Clock

1. In the World Clock 
screen, highlight 
Clock 1 or Clock 2. 

2. Press Assign. The 
Assign screen 
appears in the 
display. 

3. Highlight the desired time zone by pressing the Navigation 
key Left or Right. 

4. Highlight the desired city by pressing the Navigation key 
Up or Down. 

5. To assign your settings, press Done. 

Applying Daylight Saving Time

1. In the World Clock screen, highlight Clock 1 or Clock 2. 

2. Press Menu, then select Apply DST. 

Home Screen Layout

� To view your World Clock assignments on the Home 
screen, change the Home screen layout to Samsung Multi 
Clock. For more information, refer to “Home Screen”  on 
page 103. 
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Office Mobile
This section introduces Microsoft Office Mobile applications 
included with your phone. You can view different document 
formats with the document viewing tool, access word processing 
and spreadsheets documents, and even instant message others 
using the preloaded applications on your i225.

The i225 is an integrated communication device with the power 
of a mobile phone and the intelligence of a PC. The i225 is loaded 
with familiar Microsoft® Office Mobile applications, like Word 
Mobile and Excel, and several specialty applications. 

To access Office Mobile: 

� From the Home 
screen, press Start, 
then select Office 
Mobile ( ). The 
Office Mobile menu 
appears in the 
display. 

Excel Mobile

Excel Mobile works with Microsoft Excel on your computer to 
give you easy access to copies of your workbooks. You can copy 
workbooks from your computer to your handset. Synchronize 
workbooks between your computer and your handset to ensure 

that you have the most up-to-date content in both locations. 
Excel Mobile also provides fundamental spreadsheet tools, such 
as formulas, functions, sorting, and filtering.

Reviewing a Workbook

1. From the Office Mobile menu, select Excel Mobile ( ). If 
there are existing workbooks on this device, the file access 
screen displays. 

2. Select, review, and update your spreadsheet(s), as needed. 
(For more information, refer to the Excel User Guide.) 

3. When you are finished, press Menu and select Close file to 
save your workbook and exit. 

Note: You can open only one workbook at a time. If you try to open a second, 
you are asked to save the first workbook. 

Beaming a Workbook

1. From the Office Mobile menu, select Excel Mobile ( ). 
The file access screen displays. 

2. Move the cursor over the workbook you want to beam, 
then press Menu. A pop-up menu displays. 

3. Select Beam File.... 

4. Select the device to which you want to beam the 
workbook. 

5. When finished, press  to exit the screen. 
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OneNote Mobile

OneNote Mobile is a digital notebook that allows you to gather, 
store, and manage information in a single location.

Create a Note

1. From the Office Mobile menu, select OneNote Mobile 
( ). The file access screen displays. 

2. Press New. 

3. Construct your note(s). For more information, refer to 
“Entering Text” on page 21 and to the OneNote User Guide.

4. Press Menu to select formatting options.

5. When you are finished, press Done  to save your 
note and exit. 

PowerPoint Mobile

PowerPoint Mobile works with Microsoft PowerPoint on your 
computer to give you easy access to copies of your 
presentations. You can copy presentations from your computer to 
your handset. Synchronize presentations between your computer 
and your handset to ensure that you have the most up-to-date 
content in both locations. 

Show a Presentation

1. From the Office Mobile menu, select PowerPoint Mobile 
( ). The file access screen displays. 

2. If needed, select the folder where the presentation you 
wish to show resides. 

3. Select the desired presentation to begin showing it. 
• To advance to the next slide, press the Navigation key Right. 

• To end the slide show, press , then press  again. 

Word Mobile

Word Mobile works with Microsoft Word on your computer to give 
you easy access to copies of your documents. You can copy 
documents from your computer to your handset. Synchronize the 
documents between your computer and your handset to ensure 
you have the most up-to-date content in both locations.

Use Word Mobile to create documents, such as letters, meeting 
minutes, and trip reports. 

Viewing/Editing a Document

1. From the Office Mobile menu, select Word Mobile ( ). 
• If there are no documents on this device, a new document 

automatically displays. 

• If there are existing documents on this device, the file access 
screen displays. 

2. Enter text using the desired character input method. For 
more information, refer to “Entering Text”  on page 21..
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3. When finished, press Done  to save and exit. 
– or – 
Press Menu, then select File ➔ Save As... ➔ Save to save 
your document with a specific name, folder, type, and 
location. 

You can open one document at a time. If you try to open a second 
document, you are asked to save the first document. 

You can save a document in any one of the following formats:
• Word Document (*.docx)
• Word Template (*.dotx)
• Rich Text Format (*.rtf)
• Plain Text (*.txt)

Accessing Word Mobile options

1. From the Office Mobile menu, select Word Mobile ( ).

2. If there are existing documents on this device, you can 
select your document from the display list. 

3. Press Menu and the following options are available:
• Close File — allows you to close your file. 

• Edit — allows you to edit your document.

• File — allows you to choose the Save As option and name your file 
and to location to save to, or to Send your document in a message.

• Scroll Up/Down — allows you to choose how you scroll through 
your document, By Page or By Line.

• Find... — allows you to search your document by entering a word 
or phrase.

• About — provides information about Microsoft Office Word 
Mobile

4. When finished, press View to view your document. 

Sideloading Microsoft Office Files

You can sideload Microsoft Office files directly onto your i225 
phone for viewing or editing. 

Note: Sideloading files to your i225 requires that you connect it to a PC using 
an optional Data Cable, available from your Wireless Provider. 

1. From the Home screen, press Start, then select Settings 
( ) ➔ Connections ➔ USB. The USB screen appears in 
the display with the current Default USB Function setting 
highlighted. 

2. Press the Navigation key Left or Right to change the 
setting to Mass Storage. 

3. Press Done. 

4. Connect the i225 to your PC using an optional USB Data 
Cable. The i225 will appear to your PC as a Removable 
Disk Drive. 

5. Copy the desired Microsoft Office files to your i225. 
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Deleting a Microsoft Office File

1. From the Home screen, press Start, then select Contents 
Manager ( ) ➔ My Device. An array of folders and files 
appears in the display. 

2. Highlight the cursor over the workbook you want to delete, 
then press Menu, then select Delete. You are prompted to 
confirm the deletion. 

3. Select Yes to confirm the deletion. 

Accessories
� From the Home 

screen, press Start, 
then select 
Accessories 
( ). The 
Accessories menu 
appears in the 
display. 

Calculator

You can perform calculations, including addition, subtraction, 
multiplication, and division using your phone.

1. In the Accessories menu, select Calculator. The 
Calculator screen appears in the display. 

2. Enter the first number in your calculation using the keypad. 

3. Use the Navigation key to set the type of calculation that 
you wish to perform. Your choices are as follows: 
• Up Navigation key — [x] Multiplication 

• Left Navigation key — [-] Subtraction 

• Action key ( ) — [=] Equals/Total 

• Right Navigation key — [+] Addition 

• Down Navigation key — [÷] Division 

For nested operations [such as (1.81 + 9.34) / 5.22] and to 
calculate powers (such as 32), press Menu. The following 
options appear in the display: 
• % — Calculate a percentage of the current entry. 

•  — Calculate the square root of the current entry. 

• Xn — Raise the current number to the power of your next entry. 

4. Use the keypad to enter the next number in your 
calculation. 

5. Repeat steps 3 and 4 as needed. 

6. To perform the calculation and view the result, press . 

To clear your last operation or number entry, press . 

To clear all of your entries, press Clear. 

Smart Converter

The conversion menu provides the following conversion features:
• Currency 
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• Length 
• Weight 
• Volume 
• Area 
• Temperature 

To convert a currency, length, weight, volume, area, or 
temperature, do the following: 

1. In the Accessories menu, select Smart Converter. 

2. Select the conversion 
feature you wish to 
use. The selected 
conversion feature 
screen appears in the 
display with the From 
Unit field highlighted.

3. Use the Left and 
Right navigation keys 
to select the Unit to be converted From. 

4. Highlight the From Unit field. 

5. Use the keypad to enter the Unit you want converted in the 
From Unit field. 

6. Highlight the To Unit 
field. 

7. Use the Left and 
Right navigation keys 
to select the units to 
be converted From 
and To. The 
converted quantity 
appears in the To 
quantity field. 

Currency — Reviewing/Editing Exchange Rates

The Currency Converter includes long-term average exchange 
rates as default values. To review and/or change a default 
exchange rate to the current exchange rate, do the following: 

1. In the Accessories menu, select Smart Converter ➔ 

Currency. 

2. Press Menu, then 
select View rates. 
The View rates list 
appears in the 
display with the Base 
currency field 
highlighted. 
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3. Press . A list of available currencies appears in the 
display. 

4. Highlight the desired base currency, then press Done. 

5. Highlight the 
currency exchange 
rate you want to 
review or change. 

6. Use the keypad to 
change the current 
exchange rate. For 
more information, 
refer to “Currency — 
Reviewing/Editing Exchange Rates”  on page 63.
• To save the changed exchange rate, press Done. 

• To discard your changes and return to the Currency Converter 
screen, press Menu, then select Cancel. 

Currency — Adding Exchange Rates

You can use the Currency Converter to convert from and to 
obscure currencies by adding exchange rates for these 
currencies. 

To add a currency and its exchange rate to the Currency 
Converter, do the following: 

1. In the Accessories menu, select Smart Converter ➔ 

Currency. 

2. Press Menu, then select View rates. The View rates list 
appears in the display with the Base currency field 
highlighted. 

3. Use the Left and Right navigation keys to select the Base 
currency to be converted from. 

4. Press Menu, then 
select Add rate. The 
Add rate screen 
appears in the 
display. 

5. Highlight the Name 
field. 

6. Enter an identifier of 
up to 3 characters 
for the new currency 
using the keypad. 
For more 
information, refer to 
“Entering Text”  on 
page 21.

7. Highlight the Rate 
field. 
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8. Enter a decimal exchange rate for the new currency using 
the keypad. For more information, refer to “Entering Text”  
on page 21.

9. To save the new 
exchange rate, press 
Done. The Exchange 
Rate list appears in 
the display with your 
new exchange rate 
at the bottom of the 
list. 

Currency — Erasing 
Exchange Rates

You can erase the preloaded currencies from the Exchange Rate 
list, as well as a currency that you have added to the list, by 
doing the following: 

1. In the Accessories screen, select Smart Converter ➔ 

Currency. 

2. Press Menu, then select View rates. The View rates list 
appears in the display with the Base currency field 
highlighted. 

3. Highlight the 
currency exchange 
rate to be erased. 

4. Press Menu, then 
select Delete. You are 
prompted to confirm 
the erasure. 
• To erase the 

highlighted exchange 
rate, press Yes. 

• To keep the highlighted exchange rate, press No. 

SmartSearch

Lets you find information 
stored in your i225 phone, 
such as: Contacts, 
appointments, tasks, phone 
calls (in the Calls Log), 
messages (text and e-mail), 
and so on. 

1. In the Accessories screen, select SmartSearch. The 
SmartSearch screen appears in the display. 

2. In the Find: field, enter the character string to be matched. 
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3. If desired, select All Items. A list of available item types 
appears in the display. Select the desired item type to be 
searched. 

4. If desired, highlight Match case and/or Match whole word 
and press . 

5. For further search 
options, press Menu. 

6. To initiate the search, 
press Go. The Find 
results screen 
appears in the 
display listing any 
items found. 

Speed Dial

1. In the Accessories screen, select Speed Dial. The Speed 
Dial screen appears in the display listing the available 
Speed Dial numbers. 

2. To dial a listed Speed Dial number, highlight the list entry 
and press Go. 

3. To edit a listed Speed Dial number, highlight the list entry 
and press . 

4. For more information, highlight the <Help> item and press 
. 

StopWatch

1. In the Accessories screen, select StopWatch. The Stop 
Watch screen appears in the display. 

2. To start the Stop Watch count, press Start. 

3. To save individual lap times, press Lap. 

4. To stop the elapsed time count, press Stop. 

5. To reset the Stop Watch display, press Reset. 

Task Manager

Task Manager lets you review the software tasks currently 
residing in processing memory and lets you free memory by 
removing tasks. 

1. In the Accessories screen, select Task Manager. The Task 
Manager screen appears in the display, listing the 
software tasks currently in phone processing memory. 

2. To remove a task from processing memory (but not from 
phone “permanent” memory), press End Task. 

3. For other options, press Menu. 

Tip Calculator

Tip Calculator automatically calculates the following amounts: 
• Gratuity (tip) 
• Individual payment (for groups) 
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Calculations are based on the total amount of the check, a 
selected percentage, and the number of people paying. 

1. In the Accessories 
screen, select Tip 
Calculator. The Tip 
Calculator screen 
appears in the 
display with the Bill 
Amount field 
highlighted. 

2. Use the keypad to 
enter the total amount of the bill. 

3. If needed, highlight the Tip field and press  to change 
the tip percentage. 

4. If needed, highlight 
the Split field and use 
the keypad to change 
the number of 
persons paying. 

5. Press Calculate. The 
amount of the Tip, 
the bill Total, and the 
amount each person 
should pay appear in the lower half of the screen. 

CityID®

CityID enhances your i225 phone’s Caller ID feature by 
automatically displaying the city and state below the calling 
phone number for received wireless calls. 

Note: Additional charges apply for CityID subscription. For more information, 
contact your Carrier. 

To start the CityID program, do the following: 

� In the Start menu, select CityID. The CityID screen 
appears in the display. 
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Section 9: Camera – Camcorder

Use your i225 phone to take full-color digital pictures or record 
full-color digital videos, display them on your phone’s vivid color 
display, and instantly share them with family and friends. It’s fun, 
and as easy to use as a traditional point-and-click camera. This 
section explains how you can do the following: 
• Take pictures and record videos with your phone’s built-in digital 

camera-camcorder. 
• Send your pictures or videos to others in Multimedia messages. 
• Set the several options associated with the camera-camcorder that 

help you take crisp, clear pictures/videos. 

Taking Pictures
Taking pictures with the 
built-in camera-camcorder 
is as simple as launching 
the camera, choosing a 
subject, pointing the lens 
(located on the top-rear of 
your phone), and pressing 
a key. 

Taking Snap Shots (Single Pictures)

To take a single picture using the current camera settings, do the 
following: 

1. In standby mode, press and hold the Camera key ( ) 
on the right side of the phone. The camera viewfinder 
screen appears in the display. For more information, refer 
to “Camera Screen Layout”  on page 71. 

Note: You can also launch the camera by pressing Start, then selecting 
Camera ( ). 

2. Using the display as a viewfinder, point the camera lens (at 
the top-rear of the phone) at your subject. 

3. When the image that you wish to capture appears in the 
display, press the Camera key ( ) or . Your new 
picture appears in the Review Screen. 
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The following options 
are available: 
• To save the picture to 

memory, press Save. 

• To access the 
following options, 
press Menu: 

– To save the picture 
and send a copy of it 
to someone else, select Send via MMS. For more information, refer to 
“Creating and Sending Multimedia Messages”  on page 40.

– To set the picture as wallpaper for the Home screen, select Set as 
Homescreen. 

– To discard the picture without saving it, select Cancel. 

Tip: You can change a number of the camera’s options and settings to suit 
particular uses for your pictures. See “Camera Options” on page 73 for 
more information.

Taking Multi Shot Pictures

When taking pictures of moving subjects or subjects you cannot 
pose, such as children and pets, the camera’s Multi Shot mode 
simplifies the process of taking multiple pictures in quick 
succession. After taking Multi Shot pictures, you can go to your 
Album (the My Pictures folder), review thumbnail or full screen 

views of the pictures you have just taken, and can select the best 
picture(s) and discard the rest. 

1. In standby mode, 
press and hold the 
Camera key ( ) 
on the right side of 
the phone. The 
camera viewfinder 
screen appears in 
the display. For more 
information, refer to 
“Camera Screen Layout”  on page 71. 

Note: You can also launch the camera by pressing Start, then selecting 
Camera ( ). 

2. Press Menu. The options menu bar appears at the top of 
the camera screen. 

3. Highlight the Shooting Mode icon ( , , , 
, or ). The following Shot Type options appear in 

the display: 
• Single Shot —  — Lets you take 1 photo at a time. 

• Multi Shot —  — Lets you take a series of photos in quick 
succession, automatically saving each photo. 
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• Mosaic Shot —  — Lets you take 4 shots that combine to 
form a mosaic photo. 

• Funny Mask —  — Lets you select colorful masks to 
include around the subjects your photos (press the Navigation key 
Left and Right to preview available masks). 

• Smile Detection —  — Takes the photo only when the 
subject person smiles. 

4. Select Multi Shot or Mosaic Shot. 
• When you select Multi Shot, the Multi Shot icon ( ) appears in 

the display, and the Size setting automatically decreases to . 
Each photo is automatically saved. 

• When you select Mosaic Shot, the Mosaic Shot icon ( ) 
appears in the display. When you take the first Mosaic Shot photo 
the progress array ( ) appears in the display. 

5. Using the display as a viewfinder, point the camera lens at 
your subject. 

6. When the image that you wish to capture appears in the 
display, press  or the Camera key ( ). The camera 
takes one picture (Manual) or multiple pictures in quick 
succession (Auto).

Recording Videos

Recording videos with the 
built-in camera-camcorder 
is as simple as launching 
the camera, switching to 
camcorder mode, choosing 
a subject, pointing the lens 
(located on the top-rear of 
your phone), and pressing 
a key to start and stop video recording. 

To record a video using the current camcorder settings, do the 
following: 

1. In standby mode, press and hold the Camera key ( ) 
on the right side of the phone. The camera viewfinder 
screen appears in the display. For more information, refer 
to “Camera Screen Layout”  on page 71

Note: You can also launch the camera by pressing Start, then selecting 
Camera ( ). 

2. Launch the camcorder by pressing . 

Tip: Change to camcorder mode by pressing Menu, then highlighting the 
Mode icon ( ) and selecting Camcorder ( ). 
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3. Using the display as a viewfinder, point the camera lens (at 
the top-rear of the phone) at your subject. 

4. When the image that you wish to capture appears in the 
display, press the Camera key ( ) or  to start video 
recording. 
• To pause the recording, press . 

• To resume the recording, press . 

5. To end the recording, press . 

6. Your new picture appears in the Review Screen. 

The following options 
are available: 
• To save the video to 

memory, press Save. 

• To preview the video, 
press . 

• To discard the video 
without saving it, 
select Cancel. 

Tip: You can change a number of the camcorder’s options and settings to 
suit particular uses for your videos. See “Camcorder Options” on 
page 79. 

Camera Screen Layout
When you activate your 
phone’s camera, the top 
two lines of the display are 
reserved for camera icons 
(when active). The center 
of the display shows a 
viewfinder image of the 
subject at which the 
camera is pointed. 

Camera Screen Soft Keys

The soft key labels on the bottom line of the display change to 
the following: 
• Album — Pressing the Left soft key opens the My Pictures folder on 

the Default Storage location so you can view or manage your stored 
pictures. See “Album — My Pictures” on page 76 for more 
information.

• Shortcuts — Pressing the Navigation key takes a picture of the 
subject currently appearing in the camera view finder screen. 

• Menu — Pressing the Right soft key opens a menu bar of camera 
options and settings. 
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Camera Screen Icons

Mode — Indicates the camera is active. 

Tip: To change the Mode setting to Camcorder, press . 

Shooting Mode — Indicates the type of photo the 
camera will take each time you press  or the Camera 
key ( ). Available Shooting Modes are: Single Shot 
(shown), Multi Shot ( ), Mosaic Shot ( ), Funny 
Mask ( ), and Smile Detection ( ). For more 
information, refer to “Shooting Mode”  on page 73. 

Size — Indicates camera’s current resolution setting. 
Available Sizes are: 1600x1200 (shown), 1280x1024 
( ), 640x480 ( ), and 320x240 ( ). See 
“Camera Options” on page 73 for more information.

White Balance — Indicates camera’s white balance 
setting. You can change the camera white balance 
setting. For more information, refer to “White Balance”  
on page 74. 

Effect — Lets you change the color content of the 
subject image to shades of a selected color. [Available 
color effects are: No Effect (shown), Black & White 
( ), Sepia ( ), and Negative ( ).] 

Night Shot — Lets you take photos in low light. 
(Available values are Off ( ) or On ( ). 

Settings — Launches tabbed menus of options that 
retain your settings until you change or reset them. For 
more information, refer to “Settings”  on page 75. 

Default Memory — Indicates where photos will be stored 
[My Device (shown) or SD Card ( )]. 

Photo Limit — Indicates the number of photos you can 
take with the available memory. (Depending on the Size 
and Default Memory values.) 

Zoom — Enlarges the image from x00 to x05 before 
you take a picture. For more information, refer to 
“Zoom”  on page 83. 

Viewfinder Mode — Indicates current viewfinder screen 
format setting [Available options are no icons ( ), all 
icons (shown), or crosshatch ( )]. 

Brightness — Brightens ( ) or darkens ( ) the 
image from -2.0 to +2.0 before you take a picture. For 
more information, refer to “Brightness”  on page 83. 

Self Timer — Delays the camera shutter Off (shown, 0 
seconds) or for 2 ( ), 5 ( ), or 10 ( ) seconds 
after you press . 
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Camera Options
The Camera Options let you temporarily adjust default camera 
settings to suit available lighting, the subject of the photo, or the 
purpose of the photo, for the current camera session. When you 
exit the camera, your Camera Options values revert to their 
default values. 

To access Camera Options, do the following: 

1. In camera mode, press Menu. The Camera Options menu 
appears in the display. 

2. Select a sub-menu, then select a preferred value. 

The following sub-sections describe camera options and 
available values. 

Shooting Mode

Shot Type lets you take multiple photos or shots in succession at 
the touch of a key and/or add colorful frames to your photos. 

1. Highlight the Shooting Mode icon ( , , , 
, or ). The following Shot Type options appear in 

the display: 
• Single Shot —  — Lets you take 1 photo at a time. 

• Multi Shot —  — Lets you take a series of photos in quick 
succession, automatically saving each photo. 

• Mosaic Shot —  — Lets you take 4 shots that combine to 
form a mosaic photo. 

• Funny Mask —  — Lets you select colorful masks to 
include around the subjects your photos (press the Navigation key 
Left and Right to preview available masks). 

• Smile Detection —  — Takes the photo only when the 
subject person smiles. 

2. Select the desired Shot Type. 
• When you select Multi Shot, the Multi Shot icon ( ) appears in 

the display, and the Size setting automatically decreases to . 
Each photo is automatically saved. 

• When you select Mosaic Shot, the Mosaic Shot icon ( ) 
appears in the display. When you take the first Mosaic Shot photo 
the progress array ( ) appears in the display. 

Size

Size lets you change the clarity (in pixels) and size (in bytes) of 
your pictures. 

1. In camera mode, press Menu, then highlight the 
Resolution setting. The following values appear in the 
camera screen: 
• 1600x1200 (pixels) 

• 1280x1024 (pixels) 

• 640x480 (pixels) 

• 320x240 (pixels) 

2. Select the desired Size value. 
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Night Shot

Night Shot lets you take pictures in low light conditions. 

1. In camera mode, press Menu, then highlight  or . 
The following options appear in the display: 
• Off 

• On 

2. Select the Night Shot setting of your choice. 

White Balance

White Balance allows you to adjust picture quality according to 
available light. 

3. In camera mode, press Menu, then highlight  /  / 
 /  / . 

The following values appear in the camera screen: 
•  Auto — The camera automatically adjusts picture quality 

to available light. 

•  Daylight — Use this setting when taking pictures in full 
sun. 

•  Cloudy — Use this setting when taking pictures in cloudy 
conditions. 

•  Incandescent — Use this setting when taking pictures 
under incandescent lights. 

•  Fluorescent — Use this setting when taking pictures under 
fluorescent lights. 

Each option, as you highlight it, shows the effects it has on 
a picture. 

4. Select the desired White Balance value. The camera 
viewfinder screen appears in the display with your 
selected White Balance value applied. 

The next time you press , the camera applies your 
selected White Balance value to your picture. 

Color Effect

Change the look of your pictures with Color Effect. Choose from 
eight available settings such as Black&White, Negative, and 
Sepia. The selected color effect previews in the display before 
you take the picture. 

1. In camera mode, press Menu, then highlight  /  / 
 / . The following values appear in the display: 

•  No Effect — Subjects and pictures appear with a normal 
hue.

• Black&White — Subjects and pictures appear in black and 
white. 

• Sepia — Subjects and pictures appear in a brownish-gray 
hue. 

• Negative — Subjects and pictures appear in inverted colors.

2. Select the Effects value of your choice. The camera 
viewfinder screen appears in the display with your 
selected Effects value applied. 
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When you take your next picture, the camera applies your 
selected Effects value to your picture. 

Settings

When you change Camera Settings values, your changes are 
saved for future camera sessions, unlike changes to Camera 
options. 

� In camera mode, press Menu, then select Settings ( ). 
The Settings menu appears in the display with the Camera 
tab and Quality setting highlighted. 

Quality

You can affect how much your photo is compressed, thereby 
reducing it’s overall size (not to be confused with resolution). 

1. In the Settings menu, highlight the Camera tab, then 
highlight Quality and press the Navigation key to the Right. 
The following values appear in the camera screen: Super 
Fine, Fine, Normal, or Economy. 

2. Select the desired Quality value. 

Shutter Sound

Choose from four different sounds whenever you take a picture. 
Aside from being a cool sound effect, Shutter Sounds acts as an 
audible reminder that your camera has taken a picture. 

1. In the Settings menu, highlight the Camera tab, then 
highlight Shutter Sound and press the Navigation key to 

the Right. The following values appear in the camera 
screen: 
• Shutter 1 

• Shutter 2 

• Shutter 3 

• Off 

2. Select the Shutter Sound value of your choice. You’re 
returned to the camera viewfinder screen. The next time 
you press , you’ll hear your selected shutter sound. 

Sound Zoom

Choose enable or disable a sound to play when you adjust the 
camera Zoom ( ) using the Jog Wheel or Volume key. 

1. In the Settings menu, highlight the Camera tab, then 
highlight Sound Zoom and press the Navigation key to the 
Right. The following values appear in the camera screen: 
• On 

• Off 

2. Select the Sound Zoom value of your choice. You’re 
returned to the camera viewfinder screen. 

Sound Brightness

Choose enable or disable a sound to play when you adjust the 
camera Brightness ( ) using the Navigation key. 
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1. In the Settings menu, highlight the Camera tab, then 
highlight Sound Brightness and press the Navigation key 
to the Right. The following values appear in the camera 
screen: 
• On 

• Off 

2. Select the Sound Brightness value of your choice. You’re 
returned to the camera viewfinder screen. 

Viewfinder Mode

Choose the format for the Camera viewfinder screen. 

1. In the Settings menu, highlight the Setup tab, then highlight 
Viewfinder Mode and press the Navigation key to the 
Right. The following values appear in the camera screen: 
• No Icon — No icons appear in the viewfinder screen. 

• Icon — All icons appear in the viewfinder screen. 

• Guideline — All icons appear along with a crosshatch pattern. 

Default Storage

1. In the Settings menu, highlight the Setup tab, then highlight 
Default Storage and press the Navigation key to the Right. 
The following storage options appear in the display: 
• My Device — Stores your photos in phone memory. 

• SD Card — Stores your photos on an optional microSD Storage 
Card. 

2. Select the memory location setting of your choice. An icon 
(  or ) appears in the camera screen to indicate 
where photos will be stored. 

Review Screen

1. In the Settings menu, highlight the Setup tab, then highlight 
the Review screen and press the Navigation key to the 
Right. The On/Off options appear.

2. Make your selection to turn the review screen on or off and 
press  to save your selection.

3. Press  to return to the camera viewfinder screen.

Shortcuts

This setting lists the keys you can press to directly access some 
Camera functions. 

� In the Settings menu, highlight the Shortcuts tab. A 
scrollable list of keypad shortcuts appears in the display. 

Album — My Pictures
Saved pictures are stored in the My Pictures folder(s) [on your 
phone and on any optional microSD Storage Card(s)]. You can 
browse the pictures one at a time (expanded mode), or view 
several pictures at once in thumbnail format. 

1. In camera mode, press Album. Any pictures that you’ve 
saved appear in the display. 
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Tip: You can also access the My Pictures folder from the Home screen, by 
pressing Start, then More, then selecting Contents Manager ( ) My 
Pictures / Storage Card ➔ My Pictures; or you can use the Jog Wheel to 
browse the Start menu and select Contents Manager ( ) My Pictures / 
Storage Card ➔ My Pictures. 

2. Use the Navigation key to browse pictures in the Album. 

3. Press Menu while browsing pictures in the Album. The 
following options appear in the display: 
• Send via — Send a copy of the currently highlighted picture in an 

MMS message, in an Email message, or over a Bluetooth 
connection. 

• Set as — Assign the currently highlighted picture to be wallpaper 
on the Home Screen or as a Caller ID image for someone in your 
Contacts list. 

• Delete — Remove this picture from your Album. 

• Edit — Lets you change this picture with an Editor, Copy/Move this 
picture to another folder, Rename this picture, create a new 
pictures folder, compress (Zip) this picture, Select this picture for 
copy/move/delete, Select All pictures for copy/move/delete. 

• Take picture — Launches the Camera in your phone so that you 
can take a new picture. 

• Play Slide Show — Show all of your pictures in this folder, in 
series and full-screen. 

• Search — Search for files by name, file Type, and/or Location. 

• Sort by — Re-list the files in this folder in order of their Names, 
Dates, Sizes, or Types. 

• Properties — View the file Name, file Type, Size, Resolution, 
Folder name, Date and time created, and Protected status of the 
currently highlighted picture. 

• Options — Select the Album View format, the Zoom Mode, or 
Slide Show settings. Also, view the keypad Shortcuts list, and 
version information about the Contents Manager. 

4. Select the desired option to perform the function for the 
option or enter its sub-menu. 

Switch From Expanded to Thumbnail Mode

1. Highlight a picture that you wish to view full size, then 
press . 

2. To return to the thumbnail view of your photos, press 
. 

Camcorder Screen Layout
When you activate your 
phone’s camcorder, the top 
line of the display is 
reserved for camcorder 
icons (when active). The 
center of the display shows 
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a viewfinder image of the subject at which the camera lens is 
pointed. 

Camcorder Screen Soft Keys

The soft key labels on the bottom line of the display change to 
the following: 
• Album — Pressing the Left soft key opens the My Videos folder on 

the Default Storage location so you can view or manage your stored 
pictures. See “Album — My Videos” on page 82 for more 
information.

• Shortcuts — Pressing the Navigation key Up lets you change the 
Viewfinder Mode. Pressssing the Navigation key Down lets you 
select a self Timer setting. Pressing the Navigation key Left/Right lets 
you adjust video brightness. 

• Menu — Pressing the Right soft key opens a menu bar of camera 
options and settings. 

Camcorder Screen Icons

Mode — Indicates the camcorder is active. 

Tip: To change the Mode setting to Camcorder, press . 

Recording Mode — Video recording duration is limited to 
available memory [Normal (shown)] or is limited to 
1021 KB [Limit for MMS ( )]. 

 Size — Indicates camcorder’s current resolution value. 
Available values are 320x240 or 176x144. You can 
change the camcorder resolution by changing the value 
of either the Recording Mode or the Size option. For more 
information, refer to “Camcorder Options”  on page 79

Default Memory — Indicates where photos will be stored 
[My Device (shown) or SD Card ( )]. 

Recording Time Counter — Indicates the available 
recording time. (Depending on the camera Size 
value.) 

Recording Memory Limit — Indicates the 
maximum size (in KBytes) for videos to be 
included in MMS messages. [Shows when 
Recording Mode is set to Limit for MMS ( ).] 

Viewfinder Mode — Indicates current viewfinder screen 
format setting [Available options are no icons ( ), all 
icons (shown), or crosshatch ( )]. 

Brightness — Brightens ( ) or darkens ( ) the 
image from -2.0 to +2.0 before you take a picture. For 
more information, refer to “Brightness”  on page 83

Self Timer — Delays the camera shutter Off (shown, 0 
seconds) or for 2 ( ), 5 ( ), or 10 ( ) seconds 
after you press . 
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Camcorder Options
The camcorder options let 
you temporarily adjust 
default camcorder settings 
to suit available lighting, 
the subject of the video, or 
the purpose of the video, 
for the current camcorder 
session. When you exit the 
camcorder, your 
camcorder options values revert to their default values. 

To access the Camcorder Options menu, do the following: 

1. In camera mode, press . The Camcorder viewfinder 
screen appears in the display. 

2. Press Menu. The Camcorder Options menu appears in the 
display. 

3. Select a sub-menu, then select a preferred value. 

The following sub-sections describe camera options and 
available values. 

Recording Mode

Recording Mode lets you take multiple photos or shots in 
succession at the touch of a key and/or add colorful frames to 
your photos. 

1. In camcorder mode, press Menu, then highlight  / 
. The following values appear in the camera screen: 

•  Limit for MMS — Limits your video recordings to a 
resolution of 176x144 and a maximum physical size of 1021 KB. 

•  Normal — Lets you record videos only limited by your Size 
value and available memory. 

2. Select the desired Recording Mode. 

Size

Size lets you change the clarity (in pixels) of your videos. 

1. In camera mode, press Menu, then highlight the 
Resolution setting. The following values appear in the 
camera screen: 
• 320x240 (pixels) 

• 176x144 (pixels) 

2. Select the desired Size value. 

White Balance

White Balance allows you to adjust video quality according to 
available light. 

1. In camcorder mode, press Menu, then highlight  / 
 /  /  / . 

The following values appear in the camcorder screen: 
•  Auto — The camcorder automatically adjusts video quality 

to available light. 
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•  Daylight — Use this setting when recording videos in full 
sun. 

•  Cloudy — Use this setting when recording videos in 
cloudy conditions. 

•  Incandescent — Use this setting when recording videos 
under incandescent lights. 

•  Fluorescent — Use this setting when recording videos 
under fluorescent lights. 

2. Select the desired White Balance value. The camcorder 
viewfinder screen appears in the display with your 
selected White Balance value applied. 

The next time you press , the camcorder applies your 
selected White Balance value to your video. 

Effect

Change the look of your videos with Effect. Choose from eight 
available settings such as Black&White, Negative, and Sepia. The 
selected color effect previews in the display before you record 
the video. 

1. In camera mode, press Menu, then highlight  /  / 
 / . The following values appear in the display: 

•  No Effect — Subjects and pictures appear with a normal 
hue.

•  Black&White — Subjects and videos appear in black and 
white. 

•  Sepia — Subjects and pictures videos in a brownish-gray 
hue. 

•  Negative — Subjects and videos appear in inverted colors.

2. Select the Effects value of your choice. The camcorder 
viewfinder screen appears in the display with your 
selected Effects value applied. 

When you record your next video, the camcorder applies 
your selected Effects value to your video. 

Settings

When you change Camcorder Settings values, your changes are 
saved for future camcorder sessions, unlike changes to 
Camcorder Options. 

Quality

You can affect how much your video is compressed, thereby 
reducing it’s overall size (not to be confused with resolution). 

1. In the Settings menu, highlight the Camcorder tab, then 
highlight Quality and press the Navigation key to the Right. 
The following values appear in the camcorder screen: 
Fine, Normal, or Economy. 

2. Select the desired Quality value. 

Audio

1. In the Settings menu, highlight the Camcorder tab, then 
highlight Audio and press the Navigation key to the Right. 
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The following values are available: On, or Off. 

2. Select the desired Audio value. 

Sound Start

Choose enable or disable a sound to play when you begin 
recording a video. 

1. In the Settings menu, highlight the Camcorder tab, then 
highlight Sound Start and press the Navigation key to the 
Right. The following values are available: 
• On 

• Off 

2. Select the Sound Start value of your choice. You’re 
returned to the camcorder viewfinder screen. 

Sound Stop

Choose enable or disable a sound to play when you stop 
recording a video. 

1. In the Settings menu, highlight the Camcorder tab, then 
highlight Sound Stop and press the Navigation key to the 
Right. The following values are available: 
• On 

• Off 

2. Select the Sound Stop value of your choice. You’re 
returned to the camcorder viewfinder screen. 

Viewfinder Mode

Choose the format for the Camcorder viewfinder screen. 

1. In the Settings menu, highlight the Setup tab, then highlight 
Viewfinder Mode and press the Navigation key to the 
Right. The following values appear in the Camcorder 
screen: 
• No Icon — No icons appear in the viewfinder screen. 

• Icon — All icons appear in the viewfinder screen. 

• Guideline — All icons appear along with a crosshatch pattern. 

Default Storage

1. In the Settings menu, highlight the Setup tab, then highlight 
Default Storage and press the Navigation key to the Right. 
The following storage options appear in the display: 
• My Device — Stores your videos in phone memory. 

• SD Card — Stores your videos on an optional microSD Storage 
Card. 

2. Select the memory location setting of your choice. An icon 
(  or ) appears in the camcorder screen to 
indicate where videos will be stored. 

Review Screen

1. In the Settings menu, highlight the Setup tab, then highlight 
Review Screen. The following values appear in the 
display: 
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• On — When you record a video, the video appears in the Review 
Screen. 

– To save the video, press Save. 

– To discard the photo, press Cancel. 
• Off — New videos are saved to the My Videos folder automatically. 

2. Select the automatic save value of your choice. You’re 
returned to the camcorder viewfinder screen. 

Shortcuts

This setting lists the keys you can press to directly access some 
Camcorder functions. 

� In the Settings menu, highlight the Shortcuts tab. A 
scrollable list of keypad shortcuts appears in the display. 

Album — My Videos
Saved videos are stored in the My Videos folder. You can browse 
the pictures one at a time (expanded mode), or view several 
pictures at once in thumbnail format. 

1. In Camcorder mode, press Album. Thumbnail images of 
any videos that you’ve saved appear in the display. 

Tip: You can also access the My Videos folder from the Home screen, by 
pressing Start, then More, then selecting Contents Manager ( ) My 
Videos / Storage Card ➔ My Videos or using the Jog Wheel to browse the 
Start menu and select Contents Manager ( ) My Videos / Storage Card 
➔ My Videos. 

2. Use the Navigation key or the Jog Wheel to browse videos 
in the Album. 

3. Press Menu while browsing videos in the Album. The 
following options appear in the display: 
• Send via — Send a copy of this video in an MMS message, in an 

Email message, or over a Bluetooth connection. 

• Delete — Remove this video from your Album. 

• Edit — Lets you Copy/Move this video to another folder, Rename 
this video, create a new videos folder, compress (Zip) this video, 
Select this video for copy/move/delete, Select All videos for copy/
move/delete. 

• Record video — Launches the Camcorder in your phone so that 
you can record a new video. 

• Add to Now Playing List — Adds this video to the Windows Media 
player Now Playing List. 

• Search — Search for files by name, file Type, and/or Location. 

• Sort by — Re-list the files in this folder in order of their Names, 
Dates, Sizes, or Types. 

• Properties — View the file Name, file Type, Size, Resolution, 
Duration, Date and time created, and Protected status of the 
currently highlighted video. 

• Options — Select the Album View format, the Zoom Mode, or 
Slide Show settings. Also, view the keypad Shortcuts list, and 
version information about the Contents Manager. 
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4. Select the desired option to perform the function for the 
option or enter its sub-menu. 

Switch From Expanded to Thumbnail Mode

1. Highlight the thumbnail of the video that you wish to view, 
then press ( ) to play the video. 

2. To return to the thumbnail view of your photos, press 
. 

Camera-Camcorder Adjustments
Zoom

Zoom lets you temporarily enlarge the pictures you take. 
Increasing the Zoom (1 – 5) enlarges your pictures (0 is normal). 

� In camera mode, use the Jog Wheel or press the Volume 
key Up or Down to adjust the Zoom (the screen image 
enlarges to show the affects of your changes). 

The next time you press , the camera takes an 
enlarged picture according to your selected Zoom setting. 

Viewfinder Mode

Choose the format for the Camera/Camcorder viewfinder screen. 

1. In camera mode, press the Navigation key Up. The 
following values appear in the Camera/Camcorder screen: 
• No Icon — No icons appear in the viewfinder screen. 

• Icon — All icons appear in the viewfinder screen. 

• Guideline — All icons appear along with a crosshatch pattern. 

2. Select the desired Viewfinder Mode. 

Brightness

Brightness lets you temporarily lighten the pictures you take. 
Increasing the Brightness (-2.0 – +2.0) lightens your pictures (0 
is normal). 

� In camera mode, press the Navigation key Left or Right to 
adjust the Brightness (the screen image lightens or 
darkens to show the affects of your changes). 

The next time you press , the camera takes a lighter or 
darker picture according to your selected Brightness 
setting. 

Timer

The Timer lets you delay taking a picture long enough to let you 
join others in a picture. 

1. In camera mode, press the Navigator key Down. The 
following values appear in the camera screen: 
• — Off. 

•  — 2-second delay. 

•  — 5-second delay. 

•  — 10-second delay. 

2. Select a Timer value. 
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The next time you press , the countdown Self Timer 
indicates the time remaining before the camera takes the 
picture. The phone reads the countdown timer value to you 
beginning with two or three and continuing to zero, when 
the picture is taken. 

Tip: To stop the countdown timer without resetting it, press . 

Point, Click, and Send Pictures
Take a picture and send it to anyone with a compatible device in 
a few easy steps. 

1. In camera mode, take a desired picture by pressing  or 
. 

2. Press Menu, then select Send via MMS. The MMS screen 
appears in the display with the new photo already inserted. 

3. Enter the recipient’s phone number or Email address using 
the keypad, or press Menu, then select Add Recipients to 
select a recipient. 

After you select the desired recipients, press Select. The 
address(es) are added to your message in the MMS screen. 
Use the Jog Wheel or Navigation key to move to the other 
message fields. For more information, refer to 
“Messaging”  on page 39. 

4. When you are finished composing your message, press 
Send to send the Picture message to the intended 
recipients. 
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Section 10: Multimedia

You can use your i225 phone to take and display pictures, to 
record and playback videos and sound files (voice memos), and 
to play compatible video games. This section details how to 
access your multimedia files and applications. 

Windows Media Player
Use Microsoft Windows Media Player® to play digital audio and 
video files you create and store on your device or download from 
the Internet. You can play files in either Windows Media (.wma 
and .wmv) MP3, MP4, or 3GPP2 (.3g2) format. 

Loading Media Files

You can load media files to the handset using any of the following 
methods: 
• Over the air — Download media files from Internet sites using Internet 

Explorer. (For more information, refer to “Internet Explorer”  on 
page 50.) 

• Via ActiveSync — Download media files from your PC using the 
ActiveSync application’s Explore Device Tool. The files are stored in the 
Local Content folder on the handset after the ActiveSync operation. 
(For more information, refer to “Synchronization”  on page 93.) 

• Sideloading — Copy media files directly from your personal computer 
to a microSD Storage Card, then install the card in your i225 phone. 

(For more information, refer to “Installing a microSD™ Storage 
Card”  on page 14.) 

Updating the Media Library

After you load media files 
into your i225 phone, you 
must update the Media 
Library to access the files, 
especially “sideloaded” 
files. 

1. From the Home 
screen, press Start, then select Windows Media ( ). 
• If the Library screen appears, go to Step 2. 

• If the Windows Media screen appears, press Menu, then select 
Library and go to Step 2. 

2. Press Menu, then 
select Update Library. 
The Update Library 
screen appears in 
the display and the 
search for media 
files begins. 
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3. When the library has 
been updated, press 
Done to return to the 
Library screen. Your 
media files are now 
available for playing. 

Launch Media Player

1. From the Home 
screen, press Start, 
then select Windows 
Media ( ). 
• If the Library screen 

appears, go to Step 2. 

• If the Windows Media 
screen appears, press 
Menu, then select Library and go to Step 2. 

2. Select the desired 
folder and media file. 
The Windows Media 
player screen 
appears in the 
display and the 
selected media file 
begins playing. 

Media Player Controls

The following settings are 
available in the media 
player:
• To playback to a media file, 

press the Play ( ) key 
( ). The Play icon turns 
into the Pause icon ( ) 
once the media file begins playing. 

• During playback: 
– Press the Navigation key Left ( ) to skip back to the beginning of the 

current file. 
Press and hold the Navigation key Left to skip backward. 

– Press the Navigation key Right ( ) to skip ahead to the end of the 
current file. 
Press and hold the Navigation key Right to skip forward. 
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– Press the Navigation key Up or Down to adjust playback volume. 

•  While paused: 
– Press the Navigation key Left ( ) to play the previous media file in 

the current folder or Playlist. 
– Press the Navigation key Right ( ) to play the next media file in the 

current folder or Playlist. 

Camera and Video
Your i225 phone includes a camera-camcorder that you can use 
to take pictures or to record videos. You can also view saved 
pictures and videos, send them to others as part of MMS 
messages, and set pictures as Home screen wallpaper. 

Launching the Camera

� From the Home screen, press and hold the Camera key 
( ) on the lower right side of your phone. The Camera 
viewfinder screen appears in the display. 

For more information, refer to “Taking Pictures”  on page 68. 

Launching the Camcorder

1. From the Home screen, press and hold the Camera key 
( ) on the lower right side of your phone. The Camera 
viewfinder screen appears in the display. 

2. Press . The Camcorder viewfinder screen appears in 
the display. 

For more information, refer to “Recording Videos”  on page 70. 

Accessing Pictures and Videos

� From the Home screen, press Start, press More, then 
select Contents Manager ( ) ➔ My Pictures / My Videos 
/ Storage Card ➔ My Pictures / My Videos. 
• To view a picture / video, highlight the desired picture / video, then 

press . 

Selecting a video launches the Windows Media player to play the video. 
For more information, refer to “Windows Media Player”  on 
page 85. 

For more information, refer to “Album — My Pictures”  on 
page 76 or to “Album — My Videos” on page 82. 

Games
There are two games included with your i225. These games are 
listed in the Games folder on the Start menu. You can download 
other games and add these to your Games folder by using either 
of the following options: 

Note: Games can be downloaded from the Internet and stored on your 
phone. Instructions from the game download site should inform you of 
the location (folder) in which to store the application on your phone. 

• Games & Themes — From the Home screen, highlight Shortcuts 
then select Buy Games & Themes. 

• Internet Explorer — From the Home screen, highlight Shortcuts then 
select Internet Explorer. 
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Bubble Breaker

1. From the Home screen, press Start then select Games 
( ) ➔ Bubble Breaker ( ).

2. To begin play, press New. 

3. Select Yes to confirm the commencement of a new game.

4. Press Menu and then select Options to display the options 
screen for the current game.
• Choose from: Play Sounds, Guest Mode, game Style, and 

Breakers.

5. Update your selected options then press  or press 
Done to return to the game.

6. Select  to exit the current game and return to the 
previous screen. 

Solitaire

1. From the Home screen, press Start then select Games 
( ) ➔ Solitaire ( ).

2. Press Menu and select New Game to commence a new 
game. 

3. Begin play. 

4. Select  to exit the current game and return to the 
previous screen. 
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Section 11: Microsoft Windows Mobile

Microsoft Windows Mobile offers a number of features and 
functions for using and managing the software on your i225 
handset. 

Application Management
Your i225 is powered by Windows MobileTM 6.5 Software for i225 
Phone Edition, which allows installation and removal of any i225-
compatible application on your device. i225 applications can be 
downloaded from the web, or purchased at retail outlets.

Install New Applications (Apps)

You can install any program created for Windows Mobile 6.5, as 
long as the phone has enough memory. The most popular place 
to find Apps for your phone is on the Windows phone 
Marketplace web site (http://marketplace.windowsphone.com/
Default.aspx).

You can also obtain games and themes from your Wireless 
Provider. Just press Start and select Buy Games & Themes 
( ). 

The first application you should install is Microsoft ActiveSync 4.5 
or later. You will need this application to install others. You can 
download the latest version of Microsoft ActiveSync from the 

Microsoft site at: http://www.microsoft.com/windowsmobile/en-us/
help/synchronize/device-synch.mspx.

When a new application is downloaded from the web or installed 
using a CD, the files are transferred to the mobile device via 
ActiveSync. ActiveSync checks if enough memory is available 
before installing a program. To free up memory, simply remove 
old programs or delete unused files. For more information, refer 
to “Delete an Application”  on page 90. 

Install Linked Applications

Your i225 phone includes a number of links to application 
installation packages, including the following: 
• Windows Marketplace — Lets you find and download Microsoft-

certified applications (apps) for your Windows Mobile phone. 
• Microsoft My Phone — Lets you back up your phone automatically, 

easily share photos on social networking sites, access information on 
your phone online, and locate your phone if it is lost. 

• MSN Money — Lets you access MSN Money online services web site. 
• MSN Weather — Lets you view current weather conditions and three-

day forecasts for major cities in your area and elsewhere in the world. 
• bing Search Widget — Lets you search maps, answers, and local 

information. 

http://marketplace.windowsphone.com/Default.aspx
http://marketplace.windowsphone.com/Default.aspx
http://www.microsoft.com/windowsmobile/en-us/help/synchronize/device-synch.mspx
http://www.microsoft.com/windowsmobile/en-us/help/synchronize/device-synch.mspx
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• Tone Room Deluxe — Lets you browse, purchase, and download 
ringtones. 

To install one of these applications: 

� From the Home screen, press Start and select the desired 
application, then follow the prompts to complete the 
installation. 

Delete an Application

Some applications are large and take up space on your handset. 
To help manage space and memory requirements for other 
software that may need to be installed, you can delete any 
application not required for your device to operate correctly. To 
delete an application:

1. From the Home screen, press Start, then select Settings 
( ) ➔ More... ➔ Remove Programs.

2. Select the program from the list and press Menu, then 
select Remove. For more information, refer to “Remove 
Programs”  on page 116.

3. Select Yes to confirm.

4. Press Done to save your changes and return to the 
previous screen. 

Task Manager
Windows MobileTM 6.5 includes a mobile version of Task 
Manager that lets you review the applications running on your 
handset and, if needed, stop them running. 

1. From the Home 
screen, press Start, 
then select 
Accessories ( ) 
➔ Task Manager 
( ). The Task 
Manager screen 
displays.

2. To end a task, 
highlight the task and press End Task.

3. Press Menu to access the following options:
• Switch To: switches to and displays the selected application.

• End All Tasks: ends all the tasks that are running.

• View: Allows you to view Applications or Processes.

• Sort By: Allows you to sort how applications are viewed, by 
Memory, CPU, or Name.

• Refresh: Refreshes the screen display.

• Exit: Exits the Task Manager screen. 
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Rebooting your Phone after Lockup
The End key ( ) lets you quickly turn off the phone in the event 
of a program or application error. In this case your phone would 
appear to “freeze” and become unresponsive. 

1. Press and hold  until the power off animation appears 
in the display. 

2. Press and hold  until the power on animation appears 
in the display. 

Note: This restart action is similar to that of a “cold reboot” action on a 
computer. Your phone’s temporary memory is cleared, but information 
in permanent storage remains unchanged. 

Resetting your Phone to Factory Defaults

Note: To completely remove any personal information stored on your device, 
see “Precautions for Transfer and Disposal” on page 146. 

You can reset your phone’s settings and clear all data/
applications from phone’s internal memory by using the Hard 
Reset option. This option resets your phone to its factory default 
settings, ends all applications currently running, and wipes all 
data (pictures/video/contacts) from your phone. 

Note: Although this action wipes all information and settings from your i225, 
you can circumvent the deletion of important data by storing it on a 
removable microSD storage card. 

1. From the Home 
screen, press Start, 
then select Settings 
( ) ➔ More ➔ 

Security ➔ Phone 
Reset. The Phone 
Reset screen 
displays. 

2. To reset your phone’s 
settings, enter the Password and press Done. A 
confirmation screen displays. 

3. Press OK to remove all settings and data stored in your 
device.

4. Cycle power to the phone, that is, turn the power off and 
then on again. 

5. Follow the on screen tutorials and complete the setup 
process. 



Microsoft Windows Mobile       92

Performing a Manual Hard Reset

Caution!: When performing a manual Hard Reset, the storage and settings 
initialize. 

1. With the device powered off, press and hold  to begin 
the power on sequence. 

2. Press and hold the 
Left soft key ( ) 
and . The User 
Storage Format 
screen appears in 
the display. 

3. Select Format and 
Reboot. 

[SCH-i225 User Storage Format]
    --Warning--
All data will be erased.

Please press key within 5 secs

1. Format and Reboot
2. Exit
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Section 12: Synchronization

This section describes how to synchronize the data on your 
phone with data on one of the following: 
• Your Microsoft Windows desktop computer, using Microsoft® 

ActiveSync® or Windows Mobile® Device Center® (depending on your 
personal computer operating system). 

• A server running Microsoft Exchange Server® with Exchange 
ActiveSync®. 

Synchronization compares the data on your phone with your 
desktop computer or server and updates both your phone and 
computer or server with the latest data. 

Note: Access the Microsoft web site (http://www.microsoft.com/
windowsmobile/en-us/help/synchronize/default.mspx) to download Active 
Sync 4.5 or later, or Windows Mobile Device Center 6.1 or later.

Active Sync (Windows XP or earlier)
With ActiveSync, you can:
• Keep Contacts, Calendar, Tasks, and/or Inbox data up-to-date by 

synchronizing your phone with Microsoft Outlook® data on your 
desktop computer and/or a server running Microsoft Exchange 
Server® with Exchange ActiveSync®. 

• Copy (rather than synchronize) files between your phone and desktop 
computer. 

• Control the moment when synchronization occurs by selecting a 
synchronization mode. 

• Select data types to be synchronized and control the amount of 
synchronized data. 

ActiveSync – System Requirements

To use ActiveSync 4.5 your computer must meet the following 
hardware and software requirements: 
• Vista, Microsoft Windows XP, Windows 2000, Windows Millennium 

Edition, or Windows NT Workstation 4.0 with SP6 or later.
• Microsoft Internet Explorer 6.0 or later. 
• Hard-disk drive with 12 to 65 MB of available hard-disk space (actual 

requirements will vary based on selection of features and user's 
current system configuration). 

• USB port (1.0 or higher). 
• A CD-ROM drive. 
• VGA or compatible video graphics adapter at 256 colors or more. 

Installing Microsoft ActiveSync® on your computer

Before beginning synchronization, you must install Microsoft 

ActiveSync on your computer. 

1. Insert the Getting Started CD into the computer’s CD drive.

http://www.microsoft.com/windowsmobile/en-us/help/synchronize/default.mspx
http://www.microsoft.com/windowsmobile/en-us/help/synchronize/default.mspx
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2. Click the Setup and Installation link from the on-screen 
disc menu.

3. Click the Install button to begin installation. 

Tip: You can also download the latest version of ActiveSync from the 
Microsoft web site, http://www.microsoft.com/windowsmobile/en-us/help/
synchronize/default.mspx.

Important!: If the ActiveSync option is grayed out, the application is already 
installed. Un-install any previously installed version before 
completing this installation. 

4. Launch the setup program and follow the instructions on 
the screen. When installation completes, the 
Synchronization Setup Wizard connects your phone to the 
computer, to set up a partnership.

Note: When installation completes, the ActiveSync icon displays on the task 
bar.

Note: Synchronization automatically begins the first time your device is 
connected to your computer.
All the selected synchronization items are copied from your computer 
to your device, and Windows Explorer creates a shortcut to the Mobile 
drive.

Connecting Your Phone to a Computer

To connect the phone to your computer, you can choose one of 
the following ways:
• Using a USB data cable
• Using a Bluetooth connection

Using a USB data cable

Connect one end of the USB data cable to the jack on the bottom 
of the phone and the other end to the USB port on your computer.

Note:  Your phone must be set for Microsoft® ActiveSync® to use a USB 
connection. Select Start ➔ ActiveSync ➔ Menu ➔ Connections..., 
then select Synchronize all PCs using this connection and set USB. 

The connection is established and the Microsoft® ActiveSync® 
window displays. The synchronization automatically begins.

Setting Up and Configuring ActiveSync 

1. After you’ve installed ActiveSync, connect one end of the 
USB data cable to the jack on the upper right side of your 

http://www.microsoft.com/windowsmobile/en-us/help/synchronize/default.mspx
http://www.microsoft.com/windowsmobile/en-us/help/synchronize/default.mspx
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phone and the other end to a USB port on your computer. 

Your computer assigns a different profile to each device 
that is connected to it through the ActiveSync application.

2. Select Next to setup the sync partnership between the PC 
and your device.

3. Enter a unique name for your device and click Next.

4. Select or deselect the desired applications that you wish to 
synchronize, then click Next.

Incorrect
Correct
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5. Click the square to allow wireless data connections on 
your device while connected to your computer. If selected 
a checkmark will display in the box. 

6. Click Finish.

7. The i225 and the PC should perform the first ActiveSync. 
This may take some time, depending on the amount of 
information that needs to be synchronized.

Connecting using Bluetooth Wireless Technology

To use ActiveSync® via Bluetooth wireless technology, you need 
to configure the settings for both your PC and your handset.

PC Configuration

1. Add a COM port in the Bluetooth application you use on 
your PC. 

2. In ActiveSync, select File ➔ Connection Settings. The 
Connection Settings window pops-up. 

3. Check Allow connections to one of the following:, then 
choose the COM port added in Step 1. 
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PDA Configuration

1. Establish a Bluetooth connection between your device and 
your PC.

2. If your PC has Bluetooth ActiveSync functionality, select 
ActiveSync in Partnership Settings. 

3. On your phone, from the Home screen, select Start ➔ 

ActiveSync. 

4. Press Menu, then select “Connect via Bluetooth.” 

Customizing Connection Settings

To establish a connection between your computer and the phone, 
you must enable the connections you want to use in the 
ActiveSync® program. By default, all connections are enabled.

1. From the ActiveSync® window on your computer, select 
File ➔ Connection Settings...

2. Change the connection settings.

Note: If your phone is not connected to the computer, click this button to 
establish a connection.

3. Click on OK.

Synchronizing Information
Synchronizing Your Phone With Your PC

To begin synchronization, connect your phone to your computer 
using a USB data cable or via Bluetooth. The Microsoft ActiveSync 
window on your computer automatically displays and 
synchronization starts.

Once the synchronization is completed, the phone stays 
connected to the computer. If any change is made, Microsoft 
ActiveSync automatically will begin synchronization. 

To begin synchronization manually on your phone. 

� From the Home screen, select Start ➔ ActiveSync, then 
press Sync. 

You can open the phone’s file directory from your PC by clicking 
Explore in the Microsoft ActiveSync window. You can then copy 

If your phone is not 
connected to the 
computer, click this 
button to establish 
a connection.
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files quickly and easily from the phone to the computer, or from 
the computer to the phone. 

Note: To synchronize Bluetooth devices with a compatible computer, the 
computer must have the Bluetooth stack for Windows XP Service 
Pack 2. 

Synchronizing Your Phone With a Server

Your phone can synchronize information automatically over a 
wireless connection with your company’s Microsoft Exchange 
server every time they connect to synchronize e-mail. 

Note: Information is synchronized only if your company is running Microsoft 
Exchange Server® with Exchange ActiveSync®. 

Customizing Synchronization Settings
You can set various setting options for synchronization with a 
computer and a server, and set the synchronization schedule.

First, you must terminate any connection between your phone 
and computer. Disconnect the USB data cable or disconnect the 
phone from the PC Bluetooth interface using Wireless Manager. 
For more information, refer to “Wireless Manager”  on page 110.

Changing PC Settings on Your Phone

Configuring an Exchange Server connection

1. From the Home screen, select Start ➔ ActiveSync. 

2. Press Menu, then select Add Server Source The Enter Email 
Address screen displays. 

3. Enter the Server address. 

4. To use a SSL protocol for server access, select This server 
requires an encrypted (SSL) connection.

5. Press Next. The User Information screen displays. 

6. Enter your Microsoft Exchange User name, Password, and 
Domain. 

7. To save the password for subsequent accesses, select 
Save password. 

8. Press Next. 

9. Select data types to synchronize. 

10. When you are done, press Finish.

Changing the Synchronization Schedule

You can schedule synchronization with the Microsoft Exchange 
Server on two separate times. Use the peak time schedule to 
synchronize during working hours or other times when you 
experience higher mail volumes. Use the off-peak time schedule 
to synchronize during times when you experience lower mail 
volumes.

1. From the Home screen, select Start ➔ ActiveSync. 

2. Press Menu, then select Schedule... The Schedule screen 
displays. 
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3. Set each option:
• To synchronize periodically during peak times, select a frequency of 

synchronization in the Peak times field. 

• Select frequency of synchronization in the Off-peak times field to 
synchronize periodically during off-peak times. 

4. Select one of the available options.
• To use the peak time and off-peak time setting while roaming, 

select Use above settings when roaming.

• To synchronize each time you send an e-mail, select Send/
receive when I click Send. 

5. To set the days and hours for peak time, select Adjust peak 
times to fit your schedule. The Peak Times screen displays. 

6. Set each option: 
• Select individual Peak days. 

• Select a Start Time. 

• Select an End Time. 

7. Select  when you are finished. You are returned to the 
Schedule screen. 

8. Select  to return to the ActiveSync screen. 

Windows Mobile Device Center (Windows Vista 
and Windows 7)

The Microsoft Windows Mobile Device Center enables you to set 
up new partnerships, synchronize content, and manage music, 

pictures, and video with Windows Mobile powered devices 
(Windows Mobile 2003 or later). The Windows Mobile Device 
Center is only supported on Windows Vista and Windows 7.

Windows Mobile Device Center helps you to quickly set up new 
partnerships, synchronize business-critical information such as 
e-mail, contacts and calendar appointments, easily manage your 
synchronization settings, and transfer business documents 
between your device and PC. 

The Windows Mobile Device Center simplifies managing media 
between your Windows Mobile powered device and your PC. With 
the picture acquisition wizard, you can easily tag and transfer all 
of the pictures from your Windows Mobile powered device to 
your PC’s Windows Photo Gallery.

System Requirements

Windows Mobile Device Center 6.1 is currently only available for 
the following versions of Microsoft Windows™. 
• Windows 7™ Ultimate
• Windows 7™ Professional
• Windows 7™ Home Premium
• Windows 7™ Starter
• Windows Vista™ Ultimate
• Windows Vista™ Enterprise
• Windows Vista™ Business
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• Windows Vista™ Home Premium
• Windows Vista™ Home Basic

Installing Windows Mobile Device Center 

If your PC is running Windows Vista or Windows 7, your 
synchronization settings will be managed through the Windows 
Mobile Device Center. For instruction on downloading Windows 
Mobile Device Center visit http://www.microsoft.com/
windowsmobile/devicecenter.mspx.

http://www.microsoft.com/windowsmobile/devicecenter.mspx
http://www.microsoft.com/windowsmobile/devicecenter.mspx
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Section 13: Personalizing Your Phone

This section explains how to personalize your phone to suit your 
needs and preferences. 

Basic Personalization
A set of basic personalization functions is available with the 
Getting Started tool. This tool lets you quickly setup the following 
features and functions to your preferences: 
• Date and time 
• E-mail 
• Device password 
• Bluetooth headset 
• PC synchronization 
• Home screen background 
• Ring tone for voice calls 
• Location/GPS 
• Transfer music 
• Add/remove Getting Started 

For more information, refer to “Setting Up Your Phone (Basic)”  on 
page 8. 

Setup Your Phone’s Sounds

You can set several of your phone’s sounds (such as the call 
ringer) as a group by selecting a sound Profile. For more 
information, refer to “Selecting a Profile”  on page 109. 

Accessing the Settings Menu
To access the majority of your phone’s personalization settings, 
do the following: 

� With the Home 
screen showing, do 
one of the following: 
• Press Start, then 

select Settings ( ). 

• Select the Settings 
shortcut ( ), then 
press All settings. 

The first page of the 
Settings menu appears in the display. 

Navigating the Settings Menu
• To advance to the next Settings menu page, press . 
• To return to the previous Settings menu page, press Done or . 
• To select a menu option, press . 
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The following sub-sections describe uses of your phone’s 
Settings. 

Changing the Phone Settings
Auto Answer

Auto Answer enables your phone to automatically answer calls 
after a period of time that you specify. 

Note: To use your i225 in Auto Answer mode, you must connect a handsfree 
headset (wired or Bluetooth) or a Bluetooth Handsfree Kit to your 
phone. 

1. At the Settings menu, select Phone ➔ Auto Answer. The 
following settings are available: 
• 2 Seconds — Phone automatically answers calls after 2 seconds. 

• 4 Seconds — Phone automatically answers calls after 4 seconds. 

• 6 Seconds — Phone automatically answers calls after 6 seconds. 

• 8 Seconds — Phone automatically answers calls after 8 seconds. 

• 10 Seconds — Phone automatically answers calls after 10 
seconds. 

• Never — Disables automatic answering of calls. 

Tip: To display a list of these options, press . 

2. Select the desired setting. 

Call Options

These options control how your phone handles incoming and 
outgoing voice calls. 

1. At the Settings menu, select Phone ➔ Call Options. The 
following options appear in the display: 
• Any key answer (check box) — When checked, lets you answer 

incoming voice calls by pressing any key except . (To check/
uncheck this option, press .) 

• Phone number (display only) — Shows the phone number 
assigned to your phone. 

• Voice mail number — Lets you change the number used to dial 
your voice mail account. 

• International code — Lets you set the code the international call 
shortcut (press and hold ) used to dial international numbers. 

Tip: In addition to the Exit code (default is 011) you can add a specific 
Country code. Example — (01182) would automatically dial a number in 
South Korea. 

2. Highlight the desired option and enter a new setting. 

3. To save your changes, press Done. 

Hearing Aid Mode

This option lets you enable or disable your phone’s hearing aid 
compatibility. For more information, refer to “FCC Hearing-Aid 
Compatibility (HAC) Regulations for Wireless Devices”  on 
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page 132.

1. At the Settings menu, select Phone ➔ Hearing Aid 
Mode. 

2. To enable T-Coil hearing aid compatibility, select On. 

To disable hearing aid compatibility, select Off. 

Voice Privacy

This option lets you select the level of security applied to your 
calls. 

Note: With Voice Privacy set to On, enhanced level security is applied to your 
calls, which can result in encoding and decoding delays. 

1. At the Settings menu, select Phone ➔ Voice Privacy. The 
following settings are available: 
• On — Enhanced security 

• Off — Standard security 

2. Select the desired setting. 

Changing the Display Settings
Home Screen

1. At the Settings menu, select Display ➔ Home Screen. 
The following options appear in the display: 

• Home screen layout — Lets you choose from the following 
layouts:   

Windows Simple Windows Default

Large Font Windows Basic
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• Show Recent Programs — Lets you select the option to display 
the most Recent Programs in the Start menu or to display All 
Programs.

• Color scheme — Lets you select from the following color 
schemes: 

Samsung Simple Samsung Popup

Samsung Calendar Samsung Multi Clock

Pocket MSN Samsung WizPro

• Default • Purple • Guava Bubbles 

• Blue • Red • Samsung Blue 

Sliding PanelMSN  Default

Sliding Panel Media
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• Background Image — Lets you choose from the following 
images:   

  • Brown • Text : Black • Samsung Black 

• Grey • Text : White • Samsung Purple 

• Light Green • Yellow • Samsung Violet 

• Magenta • Windows 
Mobile Green 

Default green

greenLS guava

guavaLS WIZPRO

USCC Spring

Grass Leaf
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• Time out — Lets you how long the current screen will display 
without activity before returning to the Home screen. The available 
options are: 

– Never 
– After 10 seconds 

– After 5 minutes 

– After 10 minutes 

– After 15 minutes 

– After 30 minutes 

2. Highlight the desired option, then select a new value for 
the highlighted option. 

Start Menu Style

1. At the Settings menu, select Display ➔ Start Menu 
Style. The following settings are available: 
• Grid 

Water Champagne

Redwine Silhouette1

Silhouette2 Skyscraper1

skyscraper2
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• List 

2. Select the desired style. 

Changing the Sound Settings
Ringtone

1. At the Settings menu, select Sounds ➔ Ring Tone. The 
following settings are available: 

2. To preview the ringtones, press Menu, then select Play. 

3. To change the ringtone setting, press the Navigation key 
Left or Right. 

4. To save your change, press Done. 

Notification

The Notification settings allow you to select the actions for which 
you hear sounds and how you are notified when different events 
occur.

1. At the Settings menu, select Sounds ➔ Notification. The 
Notification screen appears in the display showing the 
current Notification settings. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

• For more options, press Menu. 

3. To save your settings, press Done. 

System Sound

1. At the Settings menu, select Sounds ➔ System Sound. 
The System Sound screen appears in the display showing 
the current System Sound settings. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

• Vibrate • 6_slowly • Digital Bell 

• None • 7_sonicboom • Gutta Tone 

• 1_club mix • 8_the bridge of cloud • Minimal Tone 

• 10_castle on a 
cloud 

• 9_chill out •  Popple Tone 

• 2_disco party • Animato Tone • Samsung Tune 

• 3_late night • Charming Intro tone • Single Tone 

• 4_mix master • Classic Bell • Ticktock Tone 

• 5_moonlight • Crossing Tone • Uscpint_1-2 
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• For more options, press Menu. 

3. To save your settings, press Done. 

Keypad Tone

1. At the Settings menu, select Sounds ➔ Keypad Tone. 
The Keypad Tone screen appears in the display showing 
the current Keypad Tone setting. 

2. Select a new value by pressing the Navigation key Left or 
Right. 
– or –

View a list of available values by pressing . 

3. To save your setting, press Done. 

Call Alert

1. At the Settings menu, select Sounds ➔ Call Alert. The 
Call Alert screen appears in the display showing the 
current Call Alert settings. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Notification key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

• For more options, press Menu. 

3. To save your settings, press Done. 

DNSe

Note: The DNSe setting requires that you connect a headset to your phone. 

1. At the Settings menu, select Sounds ➔ DNSe. If no 
headset is connected to your phone, you are prompted to 
connect one. 

2. If not connected, connect a headset to your phone, then 
press OK. The DNSe screen appears in the display showing 
the current DNSe settings. 

3. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting (and their 
effects) by pressing . 

4. To save your settings, press Done. 

Emergency Tone

1. At the Settings menu, select Sounds ➔ More... ➔ 

Emergency Tone. The Emergency Tone screen appears 
in the display showing the current Emergency Tone setting. 

2. Select a new value by pressing the Navigation key Left or 
Right. 
– or –
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View a list of available values by pressing . 

3. To save your setting, press Done. 

Profiles
This option lets you review, select, and edit a sound profile for 
your phone. 

Selecting a Profile

1. At the Settings 
menu, select 
Profiles. The 
Profiles screen 
appears in the 
display showing the 
available Profiles. A 
checkmark indicates 
the currently 
selected Profile. 

2. Highlight one of the following Profiles: 
• Normal — All sounds play at medium volume. 

• Silent — No sounds play. 

• Vibrate — No sounds play, but the phone vibrates, instead. 

• Outdoor — All sounds play at Loud volume. 

• Automatic — Lets the Organizer’s Calendar tool automatically 
switch between the Normal and the Vibrate profiles when an 
Appointment with Status set to Busy occurs/ends. 

3. To select the highlighted Profile, press Done or press . 

Changing a Profile

1. At the Settings menu, select Sounds ➔ Profiles. The 
Profiles screen appears in the display showing the 
available Profiles. A checkmark indicates the currently 
selected Profile. 

2. Highlight the Profile you want to change. 

3. Press Menu, then select Edit. The selected Profile’s 
settings appear in the display. 

4. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting (and their 
effects) by pressing . 

5. To save your settings, press Done. 

Power Management
1. At the Settings menu, select Power Management. The 

Power Management screen appears in the display 
showing an expanded Main battery charge level display 
and the current Power Management settings. 
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2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting (and their 
effects) by pressing . 

3. To save your settings, press Done. 

Connections
Wireless Manager

Wireless Manager lets you enable/disable the Bluetooth and 
Phone functions. 

1. At the Settings menu, select Connections ➔ Wireless 
Manager. The Wireless Manager screen appears in the 
display showing the current Bluetooth and Phone settings. 

2. Highlight the connection you want to enable/disable, then 
press . 

3. To save your setting(s), press Done. 

Bluetooth

Bluetooth is a short-range wireless communications technology 
capable of exchanging information over a distance of about 30 
feet without requiring a physical connection.

General Settings

This option lets you view and manage the Registered List of other 
Bluetooth devices paired with your i225. 

1. At the Settings menu, select Connections ➔ Bluetooth 
➔ General Settings. The Bluetooth Devices screen 
appears in the display listing the Bluetooth devices paired 
with your i225. 

2. To pair a headset 
with your i225: 
• Set your Bluetooth 

headset to Visible, 
then select Add new 
device... A list of 
visible Bluetooth 
devices appears in the 
display. 

• Highlight your 
Bluetooth headset, 
then press Next. You 
are notified that your 
i225 has connected 
with your Bluetooth 
headset. 

3. To remove a device 
from the list: 
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• Press Menu, then select Delete. You are prompted to confirm your 
deletion. 

• To confirm the deletion, press Yes. 

My Information Setting

This option lets you change your i225 Bluetooth device name. 

1. At the Settings menu, select Connections ➔ Bluetooth 
➔ My Information Setting. The My Information Setting 
screen appears in the display showing the i225 current 
Bluetooth Device name. 

2. To change the name, highlight Device name:. 

3. Use the keypad to edit the name or enter a new name. 

4. To save your new setting, press Save. 

Incoming Beam Setting

1. At the Settings menu, select Connections ➔ Bluetooth 
➔ Incoming Beam Setting. The Incoming Beam Setting 
screen appears in the display with the Receive incoming 
beams checkbox highlighted. 

2. Enable/disable this setting by pressing . 

3. To save your new setting, press Save. 

FTP Server Setting

1. At the Settings menu, select Connections ➔ Bluetooth 
➔ FTP Server Setting. The FTP Server Setting screen 
appears in the display showing the current Bluetooth and 

OBEX FTP security settings and Shared Folder setting. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing . 

3. To save your new settings, press Save. 

Basic Printer Setting

Lets you connect your i225 with a Bluetooth printer already 
paired with your i225 phone. (For more information, refer to 
“General Settings”  on page 110.) 

If your printer includes Bluetooth Printing technology, Basic 
Printing service appears in Partnership Settings. Check Basic 
Printing and press Done. 

You can set or unset a default Bluetooth printer in Printer Basic 
Settings. 

Smart Pairing Setting

Lets you select whether the i225 attempts to pair with other 
Bluetooth devices using predefine or specified PIN codes. 

1. At the Settings menu, select Connections ➔ Bluetooth 
➔ Smart Pairing Setting. The Smart Pairing Setting 
screen appears in the display showing the current Smart 
Pairing settings. 

2. Enter or select values for each setting in turn. 
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• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing . 

3. To save your new settings, press Save. 

Discoverable Mode Setting

Lets you make your i225 “visible” to other Bluetooth devices 
(such as, personal computers or other handsets) for purposes of 
pairing with those devices. 

1. At the Settings menu, select Connections ➔ Bluetooth 
➔ More ➔ Discoverable Mode Setting. The 
Discoverable Mode Setting screen appears in the 
display. 

2. Select a new setting by pressing the Navigation key Left or 
Right. 

3. To save your new setting, press Save. 

Supported Profiles

Actually, the Bluetooth specification is a protocol that describes 
how the short-range wireless technology works, whereas 
individual profiles describe the services supported by individual 
devices. Profiles reduce the chance that different devices will not 
work together. 

� At the Settings menu, select Connections ➔ Bluetooth 
➔ More ➔ Supported Profiles to view a list of the 
Bluetooth Profiles supported by the i225. 

USB

This option lets you select how the USB interface on your i225 
will react to being connected to a Personal Computer. 

1. At the Settings menu, select Connections ➔ USB. The 
USB screen appears in the display showing the current 
USB settings. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

3. To save your settings, press Done. 

Dial-up

1. At the Settings menu, select Connections ➔ Dial-up. 
The Dial-up screen appears in the display showing the 
following options: 
• New... — Lets you create a new Dial-up profile. 

• Network Connect — This connection is pre-configured and 
cannot be modified. 

• Phone As Modem — Lets you change the settings in this Dial-up 
profile. 

2. Select the desired option. The respective Dial-up 
connection profile screen appears in the display. 



113

3. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

4. To save your settings, press Done. 

Proxy

1. At the Settings menu, select Connections ➔ Proxy. The 
Proxy screen appears in the display and lists any existing 
Proxy profiles. 

2. To create a Proxy profile, select New... The Add Proxy 
screen appears in the display. 

3. To change an existing profile, highlight it and press Menu, 
then select Edit. The related Proxy screen appears in the 
display. 

4. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

5. To save your settings, press Done. 

VPN

This option lets you setup Virtual Private Network (VPN) profiles. 

1. At the Settings menu, select Connections ➔ VPN. The 
VPN screen appears in the display and lists any existing 
VPN profiles. 

2. To create a VPN profile, select New... The Add VPN screen 
appears in the display. 

3. To change an existing profile, highlight it and press Menu, 
then select Edit. The related Proxy screen appears in the 
display. 

4. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

5. To save your settings, press Done. 

USB to PC

Lets you enable or disable advanced network functionality for 
i225 USB-to-PC connections. 

1. At the Settings menu, select Connections ➔ More... ➔ 

USB to PC. The USB to PC screen appears in the display 
and shows the current advanced network functionality 
setting. 
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2. To change the setting, highlight the Enable advanced 
network functionality checkbox. 

3. Press . 

4. To save your setting, press Done. 

Domain Enroll

Lets you enroll your phone in one of your employer’s domains. 

1. At the Settings menu, select Connections ➔ More... ➔ 

Domain Enroll. The Domain Enroll screen appears in the 
display, explains what information you need to enroll your 
phone in a company domain, and shows the current 
Domain Enrollment status. 

2. To enroll your phone, press Enroll. You are prompted to 
backup your data stored on your phone before continuing 
the Domain Enrollment. 

3. Press Next. The Enroll screen appears in the display. 

4. Follow the prompts to complete the Domain Enrollment. 

Date and Time
� At the Settings menu, select More... ➔ Date and Time. 

For more information, refer to “Set date and time”  on 
page 8. 

Roaming
Lets you enable or disable Roaming for your i225 and lets you 
select the type of Roaming to use. 

1. At the Settings menu, select More... ➔ Roaming. The 
Roaming screen appears in the display, showing the 
current Roaming setting. 
• Select a new value by pressing the Navigation key Left or Right. 

• View a list of available values by pressing . 

2. To save your setting press Done. 

Security
� At the Settings menu, select More... ➔ Security. The 

Security screen appears in the display, showing the 
following options: 

Device Lock

Lets you set your phone to lock itself automatically, and lets you 
specify a password for unlocking the phone. 

1. In the Security screen, select Device Lock. The Password 
Settings screen appears in the display with the Prompt if 
device unused for checkbox highlighted. 

2. To activate the other settings, press . 

3. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 
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• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

4. To save your settings, press Done. 

Certificates

Certificates screens let you view and delete Personal, 
Intermediate and Root certificates that grant external access to 
your phone and/or grant your phone access to external systems. 

Encryption

Lets you enable or disable encryption for files stored on microSD 
storage cards. 

1. In the Security screen, select Encryption. The Encryption 
screen appears in the display with the Encrypt files when 
placed on storage cards checkbox highlighted. 

2. To change the current setting, press . 

3. To save your setting, press Done. 

Emergency Numbers

This option lets you specify up to three Emergency Numbers in 
addition to the default numbers 911, *911, and #911. 

Phone Reset

This password-protected option lets you reset all of your phone’s 
settings that you have changed to their default values. 

Memory Information
This option displays the amount of phone Memory and Storage 
and Storage Card space are Used and Free. 

This option also lets you format a used microSD storage card. 

Formatting a microSD Storage Card

Tip: Storage Cards written to and/or formatted by other devices are likely to 
slow your phone’s response to commands and produce other unwanted 
results. To avoid such problems, format a used microSD Storage Card 
after inserting it in your handset. 

� From the Memory Information screen, press Menu and 
select Format Storage Card. You are prompted to confirm 
formatting the Storage Card. 

Caution!: Repeatedly formatting a microSD Storage Card can reduce its 
service life. Erase unwanted files from a Storage Card instead of 
formatting it. 

Text Input Settings
1. At the Settings menu, select More... ➔ Text Input 

Settings. The Text Input Settings screen appears in the 
display, showing the current Text Input settings. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 
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• View a list of available values for a highlighted setting by pressing 
. 

3. To save your settings, press Done. 

Remove Programs
This option lets you review and remove applications that you 
have added to your i225. 

1. At the Settings menu, select More... ➔ 

Remove Programs. The Remove Programs screen 
appears in the display, listing the applications you 
currently have installed on your phone. 

2. To remove a program, highlight it, then press Menu and 
select Remove. You are prompted to confirm your removal 
of the selected program. 

3. To confirm removal, press Yes. 

Message Ticker
1. At the Settings menu, select More... ➔ More... ➔ 

Message Ticker. The Message Ticker screen appears in 
the display, showing the current Message Ticker settings. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Activate/deactivate a highlighted checkbox by pressing . 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

3. To save your settings, press Done. 

Accessibility
This option lets you personalize your phone’s displayed text, 
keypress reactions, and in-call alert volume to suit your needs. 

1. At the Settings menu, select More... ➔ More... ➔ 

Accessibility. The Accessibility screen appears in the 
display, showing the current Message Ticker settings. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

3. To save your settings, press Done. 

Key Settings
These options let you select which functions and features the 
Message key, Function (Fn) keys, and the Voice Command key 
launch when pressed or pressed and held. 

1. At the Settings menu, select More... ➔ More... ➔ Key 
Settings. The Key Settings screen appears in the display, 
listing the following options: 
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• Message Key Settings 

• Fn Key Settings 

• User Defined Key Settings 

• Calendar Key Settings 

2. Select the option whose setting(s) you want to review and/
or change. The respective screen appears in the display, 
showing the current settings. 

3. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

4. To save your settings, press Done. 

Regional Settings
This option lets you personalize the Language, Locale, and Date 
and Number formats to suit your needs. 

1. At the Settings menu, select More... ➔ More... ➔ 

Regional Settings. The Regional Settings screen 
appears in the display, showing the current Regional 
settings. 

2. Enter or select values for each setting in turn. 
• Highlight each setting by pressing the Navigation key Up or Down. 

• Select values by pressing the Navigation key Left or Right. 

• View a list of available values for a highlighted setting by pressing 
. 

3. To save your settings, press Done. 

Other Settings
Location

This option lets you select whether your phone broadcasts a 
location signal at all times or only when you make an Emergency 
Call. 

1. At the Settings menu, select More... ➔ More... ➔ Other 
Settings ➔ Location. You are informed of the effects of 
setting this option to ON. 

2. Press OK. The 
Location screen 
appears in the 
display, showing the 
current setting. 

3. To read the Location 
information, press 
the Navigation key 
Down or use it as a 
Jog Wheel. 
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4. At the bottom of the 
Location screen, 
select the desired 
setting for this 
option. 

5. To save your setting, 
press Done. 

TTY

This option lets you enable your phone to work with a TTY device. 

1. At the Settings menu, select More... ➔ More... ➔ Other 
Settings ➔ TTY. You are informed of the effects of 
enabling this option. 

2. Press OK. The TTY screen appears in the display, showing 
the current setting. 

3. Change the current 
setting by pressing 
the Navigation key 
Left or Right. 
• View a list of available 

values by pressing 
. 

4. To save your setting, 
press Done. 

Phone Information
This option lists information valuable to you, especially if you 
need to contact Customer Care. 

Owner Information
This option lets you enter personal information to be used as an 
electronic “calling/business card”. 

About
This option displays version information about the copy of 
Windows Mobile installed on your phone and about the hardware 
used to run Windows Mobile. 

Error Reporting
This option lets you enable or disable Windows Mobile’s Error 
Reporting function. This function is explained on the Error 
Reporting screen. 

Customer Feedback
This option lets you enable or disable Windows Mobile’s 
Feedback Reporting function. This function is explained on the 
Customer Feedback screen. 

Managed Programs
This option lets you view Installation History details for any 
Managed Programs you install on your i225. 
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Setup E-mail
This option lets you setup your i225 to access an e-mail account. 
For more information, refer to “Set up e-mail”  on page 9. 

Device Name
This option lets you change the Device Name and enter a 
Description to be used to identify your phone to other devices, 
such as computers. 
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Section 14: Health and Safety Information

This section outlines the safety precautions associated with using 
your phone. These safety precautions should be followed to 
safely use your phone.

Health and Safety Information
Exposure to Radio Frequency (RF) Signals

Certification Information (SAR)

Your wireless phone is a radio transmitter and receiver. It is 
designed and manufactured not to exceed the exposure limits for 
radio frequency (RF) energy set by the Federal Communications 
Commission (FCC) of the U.S. government. 

These FCC exposure limits are derived from the 
recommendations of two expert organizations, the National 
Counsel on Radiation Protection and Measurement (NCRP) and 
the Institute of Electrical and Electronics Engineers (IEEE). 

In both cases, the recommendations were developed by scientific 
and engineering experts drawn from industry, government, and 
academia after extensive reviews of the scientific literature 
related to the biological effects of RF energy.

The exposure limit set by the FCC for wireless mobile phones 
employs a unit of measurement known as the Specific 
Absorption Rate (SAR). The SAR is a measure of the rate of 

absorption of RF energy by the human body expressed in units of 
watts per kilogram (W/kg). The FCC requires wireless phones to 
comply with a safety limit of 1.6 watts per kilogram (1.6 W/kg). 

The FCC exposure limit incorporates a substantial margin of 
safety to give additional protection to the public and to account 
for any variations in measurements. 

SAR tests are conducted using standard operating positions 
accepted by the FCC with the phone transmitting at its highest 
certified power level in all tested frequency bands. Although the 
SAR is determined at the highest certified power level, the actual 
SAR level of the phone while operating can be well below the 
maximum value. This is because the phone is designed to 
operate at multiple power levels so as to use only the power 
required to reach the network. In general, the closer you are to a 
wireless base station antenna, the lower the power output.

Before a new model phone is available for sale to the public, it 
must be tested and certified to the FCC that it does not exceed 
the exposure limit established by the FCC. Tests for each model 
phone are performed in positions and locations (e.g. at the ear 
and worn on the body) as required by the FCC. 

For body worn operation, this phone has been tested and meets 
FCC RF exposure guidelines when used with an accessory that 
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contains no metal and that positions the handset a minimum of 
1.5 cm from the body. 

Use of other accessories may not ensure compliance with FCC RF 
exposure guidelines.

The FCC has granted an Equipment Authorization for this mobile 
phone with all reported SAR levels evaluated as in compliance 
with the FCC RF exposure guidelines. The maximum SAR values 
for this model phone as reported to the FCC are:
• Head: 1.12 W/Kg.
• Body-worn: 0.97 W/Kg.

SAR information on this and other model phones can be viewed 
online at http://www.fcc.gov/oet/ea. To find information that 
pertains to a particular model phone, this site uses the phone 
FCC ID number which is usually printed somewhere on the case 
of the phone. 

Sometimes it may be necessary to remove the battery pack to 
find the number. Once you have the FCC ID number for a 
particular phone, follow the instructions on the website and it 
should provide values for typical or maximum SAR for a particular 
phone. Additional product specific SAR information can also be 
obtained at www.fcc.gov/cgb/sar. 

Please Note the Following Information When 
Using Your Handset

1. WARNING REGARDING DISPLAY

The display on your handset is made of glass or acrylic and 
could break if your handset is dropped or if it receives 
significant impact. Do not use if screen is broken or 
cracked as this could cause injury to you.

2. WARRANTY DISCLAIMER: PROPER USE OF A TOUCH SCREEN 
HANDSET

If your handset has a touch-screen display, please note 
that a touch-screen responds best to a light touch from the 
pad of your finger or a non-metallic stylus. Using excessive 
force or a metallic object when pressing on the touch-
screen may damage the tempered glass surface and void 
the warranty. For more information, refer to “Standard 
Limited Warranty”  on page 140. 

Samsung Mobile Products and Recycling
Samsung cares for the environment and encourages its 
customers to recycle Samsung mobile phones and genuine 
Samsung accessories.

Go to: http://mobile.samsungusa.com/recycling/index.jsp or 
1-800-822-8837 for more information.

http://www.fcc.gov/oet/ea
http://www.fcc.gov/cgb/sar/
http://mobile.samsungusa.com/recycling/index.jsp
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UL Certified Travel Adapter
The Travel Adapter for this phone has met applicable UL safety 
requirements. Please adhere to the following safety instructions 
per UL guidelines.

FAILURE TO FOLLOW THE INSTRUCTIONS OUTLINED MAY LEAD 
TO SERIOUS PERSONAL INJURY AND POSSIBLE PROPERTY 
DAMAGE.

IMPORTANT SAFETY INSTRUCTIONS - SAVE THESE 
INSTRUCTIONS.

DANGER - TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, 
CAREFULLY FOLLOW THESE INSTRUCTIONS.

FOR CONNECTION TO A SUPPLY NOT IN NORTH AMERICA, USE 
AN ATTACHMENT PLUG ADAPTOR OF THE PROPER 
CONFIGURATION FOR THE POWER OUTLET. THIS POWER UNIT IS 
INTENDED TO BE CORRECTLY ORIENTATED IN A VERTICAL OR 
HORIZONTAL OR FLOOR MOUNT POSITION.    

Consumer Information on Wireless Phones
The U.S. Food and Drug Administration (FDA) has published a 
series of Questions and Answers for consumers relating to radio 
frequency (RF) exposure from wireless phones. The FDA 
publication includes the following information:

What kinds of phones are the subject of this update?

The term wireless phone refers here to hand-held wireless 
phones with built-in antennas, often called “cell,” “mobile,” or 
“PCS” phones. These types of wireless phones can expose the 
user to measurable radio frequency energy (RF) because of the 
short distance between the phone and the user's head. These RF 
exposures are limited by Federal Communications Commission 
safety guidelines that were developed with the advice of FDA and 
other federal health and safety agencies.

When the phone is located at greater distances from the user, the 
exposure to RF is drastically lower because a person's RF 
exposure decreases rapidly with increasing distance from the 
source. The so-called “cordless phones,” which have a base unit 
connected to the telephone wiring in a house, typically operate at 
far lower power levels, and thus produce RF exposures well 
within the FCC's compliance limits.

Do wireless phones pose a health hazard?

The available scientific evidence does not show that any health 
problems are associated with using wireless phones. There is no 
proof, however, that wireless phones are absolutely safe. 
Wireless phones emit low levels of radio frequency energy (RF) in 
the microwave range while being used. They also emit very low 
levels of RF when in the stand-by mode. 
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Whereas high levels of RF can produce health effects (by heating 
tissue), exposure to low level RF that does not produce heating 
effects causes no known adverse health effects. Many studies of 
low level RF exposures have not found any biological effects. 
Some studies have suggested that some biological effects may 
occur, but such findings have not been confirmed by additional 
research. In some cases, other researchers have had difficulty in 
reproducing those studies, or in determining the reasons for 
inconsistent results.

What is FDA's role concerning the safety of wireless 
phones?

Under the law, FDA does not review the safety of radiation-
emitting consumer products such as wireless phones before they 
can be sold, as it does with new drugs or medical devices. 
However, the agency has authority to take action if wireless 
phones are shown to emit radio frequency energy (RF) at a level 
that is hazardous to the user. In such a case, FDA could require 
the manufacturers of wireless phones to notify users of the 
health hazard and to repair, replace or recall the phones so that 
the hazard no longer exists.

Although the existing scientific data do not justify FDA regulatory 
actions, FDA has urged the wireless phone industry to take a 
number of steps, including the following:

• Support needed research into possible biological effects of RF of the 
type emitted by wireless phones;

• Design wireless phones in a way that minimizes any RF exposure to 
the user that is not necessary for device function; and

• Cooperate in providing users of wireless phones with the best possible 
information on possible effects of wireless phone use on human 
health.

FDA belongs to an interagency working group of the federal 
agencies that have responsibility for different aspects of RF 
safety to ensure coordinated efforts at the federal level. The 
following agencies belong to this working group:
• National Institute for Occupational Safety and Health 
• Environmental Protection Agency
• Federal Communications Commission
• Occupational Safety and Health Administration
• National Telecommunications and Information Administration

The National Institutes of Health participates in some interagency 
working group activities, as well.

FDA shares regulatory responsibilities for wireless phones with 
the Federal Communications Commission (FCC). All phones that 
are sold in the United States must comply with FCC safety 
guidelines that limit RF exposure. FCC relies on FDA and other 
health agencies for safety questions about wireless phones.
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FCC also regulates the base stations that the wireless phone 
networks rely upon. While these base stations operate at higher 
power than do the wireless phones themselves, the RF 
exposures that people get from these base stations are typically 
thousands of times lower than those they can get from wireless 
phones. 

Base stations are thus not the primary subject of the safety 
questions discussed in this document.

What are the results of the research done already?

The research done thus far has produced conflicting results, and 
many studies have suffered from flaws in their research 
methods. Animal experiments investigating the effects of radio 
frequency energy (RF) exposures characteristic of wireless 
phones have yielded conflicting results that often cannot be 
repeated in other laboratories. A few animal studies, however, 
have suggested that low levels of RF could accelerate the 
development of cancer in laboratory animals. However, many of 
the studies that showed increased tumor development used 
animals that had been genetically engineered or treated with 
cancer-causing chemicals so as to be pre-disposed to develop 
cancer in absence of RF exposure. Other studies exposed the 
animals to RF for up to 22 hours per day. These conditions are 
not similar to the conditions under which people use wireless 

phones, so we don't know with certainty what the results of such 
studies mean for human health.

Three large epidemiology studies have been published since 
December 2000. Between them, the studies investigated any 
possible association between the use of wireless phones and 
primary brain cancer, glioma, meningioma, or acoustic neuroma, 
tumors of the brain or salivary gland, leukemia, or other cancers. 
None of the studies demonstrated the existence of any harmful 
health effects from wireless phones RF exposures. 

However, none of the studies can answer questions about long-
term exposures, since the average period of phone use in these 
studies was around three years.

What research is needed to decide whether RF exposure 
from wireless phones poses a health risk?

A combination of laboratory studies and epidemiological studies 
of people actually using wireless phones would provide some of 
the data that are needed. Lifetime animal exposure studies could 
be completed in a few years. However, very large numbers of 
animals would be needed to provide reliable proof of a cancer 
promoting effect if one exists. 

Epidemiological studies can provide data that is directly 
applicable to human populations, but ten or more years' follow-
up may be needed to provide answers about some health effects, 
such as cancer. 
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This is because the interval between the time of exposure to a 
cancer-causing agent and the time tumors develop - if they do - 
may be many, many years. The interpretation of epidemiological 
studies is hampered by difficulties in measuring actual RF 
exposure during day-to-day use of wireless phones. Many 
factors affect this measurement, such as the angle at which the 
phone is held, or which model of phone is used.

What is FDA doing to find out more about the possible 
health effects of wireless phone RF?

FDA is working with the U.S. National Toxicology Program and 
with groups of investigators around the world to ensure that high 
priority animal studies are conducted to address important 
questions about the effects of exposure to radio frequency 
energy (RF).

FDA has been a leading participant in the World Health 
Organization international Electromagnetic Fields (EMF) Project 
since its inception in 1996. An influential result of this work has 
been the development of a detailed agenda of research needs 
that has driven the establishment of new research programs 
around the world. The Project has also helped develop a series of 
public information documents on EMF issues.

FDA and Cellular Telecommunications & Internet Association 
(CTIA) have a formal Cooperative Research and Development 
Agreement (CRADA) to do research on wireless phone safety. 

FDA provides the scientific oversight, obtaining input from 
experts in government, industry, and academic organizations. 

CTIA-funded research is conducted through contracts to 
independent investigators. The initial research will include both 
laboratory studies and studies of wireless phone users. The 
CRADA will also include a broad assessment of additional 
research needs in the context of the latest research 
developments around the world.

What steps can I take to reduce my exposure to radio 
frequency energy from my wireless phone?

If there is a risk from these products - and at this point we do not 
know that there is - it is probably very small. But if you are 
concerned about avoiding even potential risks, you can take a 
few simple steps to minimize your exposure to radio frequency 
energy (RF). Since time is a key factor in how much exposure a 
person receives, reducing the amount of time spent using a 
wireless phone will reduce RF exposure.
• If you must conduct extended conversations by wireless phone every 

day, you could place more distance between your body and the source 
of the RF, since the exposure level drops off dramatically with distance. 
For example, you could use a headset and carry the wireless phone 
away from your body or use a wireless phone connected to a remote 
antenna.
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Again, the scientific data do not demonstrate that wireless 
phones are harmful. But if you are concerned about the RF 
exposure from these products, you can use measures like those 
described above to reduce your RF exposure from wireless phone 
use.

What about children using wireless phones?

The scientific evidence does not show a danger to users of 
wireless phones, including children and teenagers. If you want to 
take steps to lower exposure to radio frequency energy (RF), the 
measures described above would apply to children and 
teenagers using wireless phones. Reducing the time of wireless 
phone use and increasing the distance between the user and the 
RF source will reduce RF exposure.

Some groups sponsored by other national governments have 
advised that children be discouraged from using wireless phones 
at all. For example, the government in the United Kingdom 
distributed leaflets containing such a recommendation in 
December 2000. 

They noted that no evidence exists that using a wireless phone 
causes brain tumors or other ill effects. Their recommendation to 
limit wireless phone use by children was strictly precautionary; it 
was not based on scientific evidence that any health hazard 
exists.

Do hands-free kits for wireless phones reduce 
risks from exposure to RF emissions?

Since there are no known risks from exposure to RF emissions 
from wireless phones, there is no reason to believe that hands-
free kits reduce risks. Hands-free kits can be used with wireless 
phones for convenience and comfort. These systems reduce the 
absorption of RF energy in the head because the phone, which is 
the source of the RF emissions, will not be placed against the 
head. On the other hand, if the phone is mounted against the 
waist or other part of the body during use, then that part of the 
body will absorb more RF energy. Wireless phones marketed in 
the U.S. are required to meet safety requirements regardless of 
whether they are used against the head or against the body. 
Either configuration should result in compliance with the safety 
limit.

Do wireless phone accessories that claim to shield 
the head from RF radiation work?

Since there are no known risks from exposure to RF emissions 
from wireless phones, there is no reason to believe that 
accessories that claim to shield the head from those emissions 
reduce risks. Some products that claim to shield the user from RF 
absorption use special phone cases, while others involve nothing 
more than a metallic accessory attached to the phone. 
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Studies have shown that these products generally do not work as 
advertised. Unlike “hand-free” kits, these so-called “shields” 
may interfere with proper operation of the phone. The phone may 
be forced to boost its power to compensate, leading to an 
increase in RF absorption. In February 2002, the Federal trade 
Commission (FTC) charged two companies that sold devices that 
claimed to protect wireless phone users from radiation with 
making false and unsubstantiated claims. 

According to FTC, these defendants lacked a reasonable basis to 
substantiate their claim.

What about wireless phone interference with 
medical equipment?

Radio frequency energy (RF) from wireless phones can interact 
with some electronic devices. For this reason, FDA helped 
develop a detailed test method to measure electromagnetic 
interference (EMI) of implanted cardiac pacemakers and 
defibrillators from wireless telephones. This test method is now 
part of a standard sponsored by the Association for the 
Advancement of Medical instrumentation (AAMI). The final draft, 
a joint effort by FDA, medical device manufacturers, and many 
other groups, was completed in late 2000. This standard will 
allow manufacturers to ensure that cardiac pacemakers and 
defibrillators are safe from wireless phone EMI. FDA has tested 
wireless phones and helped develop a voluntary standard 

sponsored by the Institute of Electrical and Electronic Engineers 
(IEEE). This standard specifies test methods and performance 
requirements for hearing aids and wireless phones so that no 
interference occurs when a person uses a compatible phone and 
a compatible hearing aid at the same time. This standard was 
approved by the IEEE in 2000.

FDA continues to monitor the use of wireless phones for possible 
interactions with other medical devices. Should harmful 
interference be found to occur, FDA will conduct testing to assess 
the interference and work to resolve the problem.

Additional information on the safety of RF exposures from various 
sources can be obtained from the following organizations 
(Updated 1/1/2010):
• FCC RF Safety Program:

http://www.fcc.gov/oet/rfsafety/
• Environmental Protection Agency (EPA):

http://www.epa.gov/radiation/
• Occupational Safety and Health Administration's (OSHA):

http://www.osha.gov/SLTC/radiofrequencyradiation/index.html
• National Institute for Occupational Safety and Health (NIOSH):

http://www.cdc.gov/niosh/
• World Health Organization (WHO):

http://www.who.int/peh-emf/

http://www.fcc.gov/oet/rfsafety/
http://www.epa.gov/radiation/
http://www.osha.gov/SLTC/radiofrequencyradiation/index.html
http://www.cdc.gov/niosh/homepage.html
http://www.who.int/peh-emf/en/
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• International Commission on Non-Ionizing Radiation Protection:
http://www.icnirp.de

• Health Protection Agency:
http://www.hpa.org.uk/radiation

•  US Food and Drug Administration:
http://www.fda.gov/Radiation-EmittingProducts/
RadiationEmittingProductsandProcedures/
HomeBusinessandEntertainment/CellPhones/default.htm

Road Safety
Your wireless phone gives you the powerful ability to 
communicate by voice, almost anywhere, anytime. But an 
important responsibility accompanies the benefits of wireless 
phones, one that every user must uphold.

When driving a car, driving is your first responsibility. When using 
your wireless phone behind the wheel of a car, practice good 
common sense and remember the following tips:

1. Get to know your wireless phone and its features, such as 
speed dial and redial. If available, these features help you 
to place your call without taking your attention off the road.

2. When available, use a hands-free device. If possible, add 
an additional layer of convenience and safety to your 
wireless phone with one of the many hands free 
accessories available today.

3. Position your wireless phone within easy reach. Be able to 
access your wireless phone without removing your eyes 
from the road. If you get an incoming call at an 
inconvenient time, let your voice mail answer it for you.

4. Let the person you are speaking with know you are driving; 
if necessary, suspend the call in heavy traffic or hazardous 
weather conditions. Rain, sleet, snow, ice and even heavy 
traffic can be hazardous.

5. Do not take notes or look up phone numbers while driving. 
Jotting down a “to do” list or flipping through your address 
book takes attention away from your primary 
responsibility, driving safely.

6. Dial sensibly and assess the traffic; if possible, place calls 
when you are not moving or before pulling into traffic. Try 
to plan calls when your car will be stationary. If you need to 
make a call while moving, dial only a few numbers, check 
the road and your mirrors, then continue.

7. Do not engage in stressful or emotional conversations that 
may be distracting. Make people you are talking with 
aware you are driving and suspend conversations that 
have the potential to divert your attention from the road.

8. Use your wireless phone to call for help. Dial 9-1-1 or other 
local emergency number in the case of fire, traffic accident 
or medical emergencies. 

http://www.icnirp.de/
http://www.hpa.org.uk/radiation
http://www.fda.gov/Radiation-EmittingProducts/RadiationEmittingProductsandProcedures/HomeBusinessandEntertainment/CellPhones/default.htm
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9. Use your wireless phone to help others in emergencies. If 
you see an auto accident, crime in progress or other 
serious emergency where lives are in danger, call 9-1-1 or 
other local emergency number, as you would want others 
to do for you.

10. Call roadside assistance or a special non-emergency 
wireless assistance number when necessary. If you see a 
broken-down vehicle posing no serious hazard, a broken 
traffic signal, a minor traffic accident where no one 
appears injured, or a vehicle you know to be stolen, call 
roadside assistance or other special non-emergency 
number.

“The wireless industry reminds you to use your phone safely when 
driving.”

For more information, please call 1-888-901-SAFE, or visit our 
web-site www.ctia.org.

Important!: If you are using a handset other than a standard numeric keypad, 
please call 1-888-901-7233.

Provided by the Cellular Telecommunications & Internet 
Association.

Responsible Listening

Caution!: Avoid potential hearing loss.

Damage to hearing occurs when a person is exposed to loud 
sounds over time. The risk of hearing loss increases as sound is 
played louder and for longer durations. 

Prolonged exposure to loud sounds (including music) is the most 
common cause of preventable hearing loss. Some scientific 
research suggests that using portable audio devices, such as 
portable music players and cellular telephones, at high volume 
settings for long durations may lead to permanent noise-induced 
hearing loss. This includes the use of headphones (including 
headsets, earbuds, and Bluetooth or other wireless devices). 
Exposure to very loud sound has also been associated in some 
studies with tinnitus (a ringing in the ear), hypersensitivity to 
sound and distorted hearing.

Individual susceptibility to noise-induced hearing loss and 
potential hearing problem varies. Additionally, the amount of 
sound produced by a portable audio device varies depending on 
the nature of the sound, the device settings, and the headphones 
that are used. As a result, there is no single volume setting that is 
appropriate for everyone or for every combination of sound, 
settings and equipment. 

http://www.ctia.org/
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You should follow some commonsense recommendations when 
using any portable audio device:
• Set the volume in a quiet environment and select the lowest volume at 

which you can hear adequately.
• When using headphones, turn the volume down if you cannot hear the 

people speaking near you or if the person sitting next to you can hear 
what you are listening to.

• Do not turn the volume up to block out noisy surroundings. If you 
choose to listen to your portable device in a noisy environment, use 
noise-cancelling headphones to block out background environmental 
noise. By blocking background environment noise, noise cancelling 
headphones should allow you to hear the music at lower volumes than 
when using earbuds.

• Limit the amount of time you listen. As the volume increases, less time 
is required before you hearing could be affected.

• Avoid using headphones after exposure to extremely loud noises, such 
as rock concerts, that might cause temporary hearing loss. Temporary 
hearing loss might cause unsafe volumes to sound normal.

• Do not listen at any volume that causes you discomfort. If you 
experience ringing in your ears, hear muffled speech or experience 
any temporary hearing difficulty after listening to your portable audio 
device, discontinue use and consult your doctor.

You can obtain additional information on this subject from the 
following sources:

 
American Academy of Audiology

11730 Plaza American Drive, Suite 300

Reston, VA 20190

Voice: (800) 222-2336

Email: info@audiology.org

Internet: http://www.audiology.org

National Institute on Deafness and Other Communication Disorders

National Institutes of Health

31 Center Drive, MSC 2320

Bethesda, MD 20892-2320

Email: nidcdinfo@nih.gov

Internet: http://www.nidcd.nih.gov/

http://www.nidcd.nih.gov/
http://www.audiology.org


131

Operating Environment
Remember to follow any special regulations in force in any area 
and always switch your phone off whenever it is forbidden to use 
it, or when it may cause interference or danger. 

When connecting the phone or any accessory to another device, 
read its user's guide for detailed safety instructions. Do not 
connect incompatible products.

As with other mobile radio transmitting equipment, users are 
advised that for the satisfactory operation of the equipment and 
for the safety of personnel, it is recommended that the 
equipment should only be used in the normal operating position 
(held to your ear with the antenna pointing over your shoulder if 
you are using an external antenna).

Using Your Phone Near Other Electronic Devices
Most modern electronic equipment is shielded from radio 
frequency (RF) signals. However, certain electronic equipment 
may not be shielded against the RF signals from your wireless 
phone. Consult the manufacturer to discuss alternatives.

Implantable Medical Devices

A minimum separation of six (6) inches should be maintained 
between a handheld wireless phone and an implantable medical 
device, such as a pacemaker or implantable cardioverter 
defibrillator, to avoid potential interference with the device.

Persons who have such devices:
• Should ALWAYS keep the phone more than six (6) inches from their 

implantable medical device when the phone is turned ON;
• Should not carry the phone in a breast pocket;
• Should use the ear opposite the implantable medical device to 

minimize the potential for interference;

National Institute for Occupational Safety and Health (NIOSH)

395 E Street, S.W.

Suite 9200

Patriots Plaza Building

Washington, DC 20201

Voice: 1-800-35-NIOSH (1-800-356-4647)

1-800-CDC-INFO (1-800-232-4636)

Outside the U.S. 513-533-8328

Email: cdcinfo@cdc.gov

Internet: http://www.cdc.gov

1-888-232-6348 TTY

Internet: http://www.cdc.gov/niosh/topics/noise/default.html

http://www.cdc.gov
http://www.cdc.gov/niosh/topics/noise/default.html
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• Should turn the phone OFF immediately if there is any reason to 
suspect that interference is taking place;

• Should read and follow the directions from the manufacturer of your 
implantable medical device. If you have any questions about using 
your wireless phone with such a device, consult your health care 
provider.

For more information see:

http://www.fcc.gov/oet/rfsafety/rf-faqs.html

FCC Hearing-Aid Compatibility (HAC) 
Regulations for Wireless Devices
On July 10, 2003, the U.S. Federal Communications Commission 
(FCC) Report and Order in WT Docket 01-309 modified the 
exception of wireless phones under the Hearing Aid Compatibility 
Act of 1988 (HAC Act) to require digital wireless phones be 
compatible with hearing-aids. 

The intent of the HAC Act is to ensure reasonable access to 
telecommunications services for persons with hearing 
disabilities. 

While some wireless phones are used near some hearing devices 
(hearing aids and cochlear implants), users may detect a 
buzzing, humming, or whining noise. Some hearing devices are 
more immune than others to this interference noise, and phones 
also vary in the amount of interference they generate.

The wireless telephone industry has developed a rating system 
for wireless phones, to assist hearing device users find phones 
that may be compatible with their hearing devices. Not all phones 
have been rated. Phones that are rated have the rating on their 
box or a label located on the box.

The ratings are not guarantees. Results will vary depending on 
the user's hearing device and hearing loss. If your hearing device 
happens to be vulnerable to interference, you may not be able to 
use a rated phone successfully. Trying out the phone with your 
hearing device is the best way to evaluate it for your personal 
needs.

M-Ratings: Phones rated M3 or M4 meet FCC requirements and 
are likely to generate less interference to hearing devices than 
phones that are not labeled. M4 is the better/higher of the two 
ratings.

T-Ratings: Phones rated T3 or T4 meet FCC requirements and are 
likely to generate less interference to hearing devices than 
phones that are not labeled. T4 is the better/higher of the two 
ratings.

Hearing devices may also be rated. Your hearing device 
manufacturer or hearing health professional may help you find 
this rating. Higher ratings mean that the hearing device is 
relatively immune to interference noise. The hearing aid and 
wireless phone rating values are then added together. 

http://www.fcc.gov/oet/rfsafety/rf-faqs.html
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A sum of 5 is considered acceptable for normal use. A sum of 6 
is considered for best use.
 

In the above example, if a hearing aid meets the M2 level rating 
and the wireless phone meets the M3 level rating, the sum of the 
two values equal M5. This is synonymous for T ratings. This 
should provide the hearing aid user with “normal usage” while 
using their hearing aid with the particular wireless phone. 
“Normal usage” in this context is defined as a signal quality that 
is acceptable for normal operation. 

The M mark is intended to be synonymous with the U mark. The 
T mark is intended to be synonymous with the UT mark. The M 
and T marks are recommended by the Alliance for 
Telecommunications Industries Solutions (ATIS). The U and UT 
marks are referenced in Section 20.19 of the FCC Rules. 

The HAC rating and measurement procedure are described in the 
American National Standards Institute (ANSI) C63.19 standard.

Other Medical Devices

If you use any other personal medical devices, consult the 
manufacturer of your device to determine if it is adequately 
shielded from external RF energy. Your physician may be able to 
assist you in obtaining this information. Switch your phone off in 
health care facilities when any regulations posted in these areas 
instruct you to do so. Hospitals or health care facilities may be 
using equipment that could be sensitive to external RF energy.

Vehicles

RF signals may affect improperly installed or inadequately 
shielded electronic systems in motor vehicles. Check with the 
manufacturer or its representative regarding your vehicle. You 
should also consult the manufacturer of any equipment that has 
been added to your vehicle.

Posted Facilities

Switch your phone off in any facility where posted notices require 
you to do so.

M3                 +                    M2         =     5 T3                 +                    T2         =     5



Health and Safety Information       134

Potentially Explosive Environments
Switch your phone off when in any area with a potentially 
explosive atmosphere and obey all signs and instructions. Sparks 
in such areas could cause an explosion or fire resulting in bodily 
injury or even death.

Users are advised to switch the phone off while at a refueling 
point (service station). Users are reminded of the need to observe 
restrictions on the use of radio equipment in fuel depots (fuel 
storage and distribution areas), chemical plants or where blasting 
operations are in progress.

Areas with a potentially explosive atmosphere are often but not 
always clearly marked. They include below deck on boats, 
chemical transfer or storage facilities, vehicles using liquefied 
petroleum gas (such as propane or butane), areas where the air 
contains chemicals or particles, such as grain, dust or metal 
powders, and any other area where you would normally be 
advised to turn off your vehicle engine.

Emergency Calls
This phone, like any wireless phone, operates using radio 
signals, wireless and landline networks as well as user-
programmed functions, which cannot guarantee connection in all 
conditions. Therefore, you should never rely solely on any 
wireless phone for essential communications (medical 
emergencies, for example).

Remember, to make or receive any calls the phone must be 
switched on and in a service area with adequate signal strength. 
Emergency calls may not be possible on all wireless phone 
networks or when certain network services and/or phone 
features are in use. Check with local service providers.

To make an emergency call:

1. If the phone is not on, switch it on.

2. Key in the emergency number for your present location (for 
example, 911 or other official emergency number). 
Emergency numbers vary by location.

3. Press the  key.

If certain features are in use (call barring, for example), you may 
first need to deactivate those features before you can make an 
emergency call. Consult this document and your local cellular 
service provider.

When making an emergency call, remember to give all the 
necessary information as accurately as possible. Remember that 
your phone may be the only means of communication at the 
scene of an accident; do not cut off the call until given 
permission to do so.
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Restricting Children's access to your Phone

Your phone is not a toy. Children should not be allowed to play 
with it because they could hurt themselves and others, damage 
the phone or make calls that increase your phone bill.

FCC Notice and Cautions
FCC Notice

The phone may cause TV or radio interference if used in close 
proximity to receiving equipment. The FCC can require you to 
stop using the phone if such interference cannot be eliminated.

Vehicles using liquefied petroleum gas (such as propane or 
butane) must comply with the National Fire Protection Standard 
(NFPA-58). For a copy of this standard, contact the National Fire 
Protection Association:
 

Cautions

Any changes or modifications to your phone not expressly 
approved in this document could void your warranty for this 
equipment, and void your authority to operate this equipment. 
Only use approved batteries, antennas and chargers. The use of 
any unauthorized accessories may be dangerous and void the 
phone warranty if said accessories cause damage or a defect to 
the phone.

Although your phone is quite sturdy, it is a complex piece of 
equipment and can be broken. Avoid dropping, hitting, bending 
or sitting on it.

Other Important Safety Information
• Only qualified personnel should service the phone or install the phone 

in a vehicle. Faulty installation or service may be dangerous and may 
invalidate any warranty applicable to the device.

• Check regularly that all wireless phone equipment in your vehicle is 
mounted and operating properly.

• Do not store or carry flammable liquids, gases or explosive materials in 
the same compartment as the phone, its parts or accessories.

• For vehicles equipped with an air bag, remember that an air bag 
inflates with great force. Do not place objects, including both installed 
or portable wireless equipment in the area over the air bag or in the air 
bag deployment area. If wireless equipment is improperly installed and 
the air bag inflates, serious injury could result.

NFPA (National Fire Protection Agency)

1 Batterymarch Park

Quincy, Massachusetts

USA  02169-7471

Internet: http://www.nfpa.org

http://www.nfpa.org
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• Switch your phone off before boarding an aircraft. The use of wireless 
phone in aircraft is illegal and may be dangerous to the aircraft's 
operation.

• Failure to observe these instructions may lead to the suspension or 
denial of telephone services to the offender, or legal action, or both.

Product Performance
Getting the Most Out of Your Signal Reception

The quality of each call you make or receive depends on the 
signal strength in your area. Your phone informs you of the 
current signal strength by displaying a number of bars next to the 
signal strength icon. The more bars displayed, the stronger the 
signal.

If you're inside a building, being near a window may give you 
better reception.

Understanding the Power Save Feature

If your phone is unable to find a signal after searching, a Power 
Save feature is automatically activated. If your phone is active, it 
periodically rechecks service availability or you can check it 
yourself by pressing any key.

Anytime the Power Save feature is activated, a message displays 
on the screen. When a signal is found, your phone returns to 
standby mode.

Understanding How Your Phone Operates

Your phone is basically a radio transmitter and receiver. When it's 
turned on, it receives and transmits radio frequency (RF) signals. 
When you use your phone, the system handling your call controls 
the power level. This power can range from 0.006 watts to 0.2 
watts in digital mode.

Maintaining Your Phone's Peak Performance

For the best care of your phone, only authorized personnel should 
service your phone and accessories. Faulty service may void the 
warranty.

There are several simple guidelines to operating your phone 
properly and maintaining safe, satisfactory service.
• To ensure that the Hearing Aid Compatibility rating for your phone is 

maintained, secondary transmitters such as Bluetooth and WLAN 
components must be disabled during a call. For more information, 
refer to “Wireless Manager”  on page 110. 

• If your phone is equipped with an external antenna, hold the phone 
with the antenna raised, fully-extended and over your shoulder.

• Do not hold, bend or twist the phone's antenna, if applicable.
• Do not use the phone if the antenna is damaged.
• If your phone is equipped with an internal antenna, obstructing the 

internal antenna could inhibit call performance.
• Speak directly into the phone's receiver.
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• Avoid exposing your phone and accessories to rain or liquid spills. If 
your phone does get wet, immediately turn the power off and remove 
the battery. If it is inoperable, call Customer Care for service.

Availability of Various Features/Ring Tones
Many services and features are network dependent and may 
require additional subscription and/or usage charges. Not all 
features are available for purchase or use in all areas. 
Downloadable Ring Tones may be available at an additional cost. 
Other conditions and restrictions may apply. See your service 
provider for additional information.

Battery Standby and Talk Time
Standby and talk times will vary depending on phone usage 
patterns and conditions. Battery power consumption depends on 
factors such as network configuration, signal strength, operating 
temperature, features selected, frequency of calls, and voice, 
data, and other application usage patterns.

Battery Precautions
• Avoid dropping the cell phone. Dropping it, especially on a hard 

surface, can potentially cause damage to the phone and battery. If you 
suspect damage to the phone or battery, take it to a service center for 
inspection. 

• Never use any charger or battery that is damaged in any way.
• Do not modify or remanufacture the battery as this could result in 

serious safety hazards.

• If you use the phone near the network's base station, it uses less 
power; talk and standby time are greatly affected by the signal 
strength on the cellular network and the parameters set by the 
network operator.

• Follow battery usage, storage and charging guidelines found in the 
user’s guide.

• Battery charging time depends on the remaining battery charge and 
the type of battery and charger used. The battery can be charged and 
discharged hundreds of times, but it will gradually wear out. When the 
operation time (talk time and standby time) is noticeably shorter than 
normal, it is time to buy a new battery.

• If left unused, a fully charged battery will discharge itself over time.
• Use only Samsung-approved batteries and recharge your battery only 

with Samsung-approved chargers. When a charger is not in use, 
disconnect it from the power source. Do not leave the battery 
connected to a charger for more than a week, since overcharging may 
shorten its life.

• Do not use incompatible cell phone batteries and chargers. Some Web 
sites and second-hand dealers, not associated with reputable 
manufacturers and carriers, might be selling incompatible or even 
counterfeit batteries and chargers. Consumers should purchase 
manufacturer or carrier recommended products and accessories. If 
unsure about whether a replacement battery or charger is compatible, 
contact the manufacturer of the battery or charger. 
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• Misuse or use of incompatible phones, batteries, and charging devices 
could result in damage to the equipment and a possible risk of fire, 
explosion, leakage, or other serious hazard.

• Extreme temperatures will affect the charging capacity of your battery: 
it may require cooling or warming first.

• Do not leave the battery in hot or cold places, such as in a car in 
summer or winter conditions, as you will reduce the capacity and 
lifetime of the battery. Always try to keep the battery at room 
temperature. A phone with a hot or cold battery may temporarily not 
work, even when the battery is fully charged. Li-ion batteries are 
particularly affected by temperatures below 
0 °C (32 °F).

• Do not place the phone in areas that may get very hot, such as on or 
near a cooking surface, cooking appliance, iron, or radiator. 

• Do not get your phone or battery wet. Even though they will dry and 
appear to operate normally, the circuitry could slowly corrode and 
pose a safety hazard. 

• Do not short-circuit the battery. Accidental short-circuiting can occur 
when a metallic object (coin, clip or pen) causes a direct connection 
between the + and - terminals of the battery (metal strips on the 
battery), for example when you carry a spare battery in a pocket or 
bag. Short-circuiting the terminals may damage the battery or the 
object causing the short-circuiting.

• Do not permit a battery out of the phone to come in contact with metal 
objects, such as coins, keys or jewelry. 

• Do not crush, puncture or put a high degree of pressure on the battery 
as this can cause an internal short-circuit, resulting in overheating. 

• Dispose of used batteries in accordance with local regulations. In some 
areas, the disposal of batteries in household or business trash may be 
prohibited. For safe disposal options for Li-Ion batteries, contact your 
nearest Samsung authorized service center. Always recycle. Do not 
dispose of batteries in a fire.

Care and Maintenance
Your phone is a product of superior design and craftsmanship 
and should be treated with care. The suggestions below will help 
you fulfill any warranty obligations and allow you to enjoy this 
product for many years.
• Keep the phone and all its parts and accessories out of the reach of 

small children.
• Keep the phone dry. Precipitation, humidity and liquids contain 

minerals that will corrode electronic circuits.
• Do not use the phone with a wet hand. Doing so may cause an electric 

shock to you or damage to the phone.
• Do not use or store the phone in dusty, dirty areas, as its moving parts 

may be damaged.
• Do not store the phone in hot areas. High temperatures can shorten the 

life of electronic devices, damage batteries, and warp or melt certain 
plastics.
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• Do not store the phone in cold areas. When the phone warms up to its 
normal operating temperature, moisture can form inside the phone, 
which may damage the phone's electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break 
internal circuit boards.

• Do not use harsh chemicals, cleaning solvents or strong detergents to 
clean the phone. Wipe it with a soft cloth slightly dampened in a mild 
soap-and-water solution.

• Do not paint the phone. Paint can clog the device's moving parts and 
prevent proper operation.

• Do not put the phone in or on heating devices, such as a microwave 
oven, a stove or a radiator. The phone may explode when overheated.

• If your phone is equipped with an external antenna, use only the 
supplied or an approved replacement antenna. Unauthorized antennas 
or modified accessories may damage the phone and violate 
regulations governing radio devices.

• If the phone, battery, charger or any accessory is not working properly, 
take it to your nearest qualified service facility. The personnel there 
will assist you, and if necessary, arrange for service.
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Section 15: Warranty Information

Standard Limited Warranty
What is Covered and For How Long? 
SAMSUNG TELECOMMUNICATIONS AMERICA, LLC (“SAMSUNG”) 
warrants to the original purchaser (“Purchaser”) that SAMSUNG's 
Phones and accessories (“Products”) are free from defects in 
material and workmanship under normal use and service for the 
period commencing upon the date of purchase and continuing for 
the following specified period of time after that date:

What is Not Covered? This Limited Warranty is conditioned upon 
proper use of Product by Purchaser. This Limited Warranty does 
not cover: (a) defects or damage resulting from accident, misuse, 
abuse, neglect, unusual physical, electrical or electromechanical 
stress, or modification of any part of Product, including antenna, 
or cosmetic damage; (b) equipment that has the serial number 

removed or made illegible; (c) any plastic surfaces or other 
externally exposed parts that are scratched or damaged due to 
normal use; (d) malfunctions resulting from the use of Product in 
conjunction with accessories, products, or ancillary/peripheral 
equipment not furnished or approved by SAMSUNG; (e) defects or 
damage from improper testing, operation, maintenance, 
installation, or adjustment; (f) installation, maintenance, and 
service of Product, or (g) Product used or purchased outside the 
United States or Canada. 

This Limited Warranty covers batteries only if battery capacity 
falls below 80% of rated capacity or the battery leaks, and this 
Limited Warranty does not cover any battery if (i) the battery has 
been charged by a battery charger not specified or approved by 
SAMSUNG for charging the battery, (ii) any of the seals on the 
battery are broken or show evidence of tampering, or (iii) the 
battery has been used in equipment other than the SAMSUNG 
phone for which it is specified.

What are SAMSUNG's Obligations? During the applicable warranty 
period, SAMSUNG will repair or replace, at SAMSUNG's sole 
option, without charge to Purchaser, any defective component 
part of Product. To obtain service under this Limited Warranty, 
Purchaser must return Product to an authorized phone service 

Phone 1 Year

Batteries 1 Year

Leather Case 90 Days

Holster 90 Days

Other Phone Accessories 1 Year
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facility in an adequate container for shipping, accompanied by 
Purchaser's sales receipt or comparable substitute proof of sale 
showing the date of purchase, the serial number of Product and 
the sellers' name and address. To obtain assistance on where to 
deliver the Product, call Samsung Customer Care at 1-888-987-
4357. Upon receipt, SAMSUNG will promptly repair or replace the 
defective Product. SAMSUNG may, at SAMSUNG's sole option, 
use rebuilt, reconditioned, or new parts or components when 
repairing any Product or replace Product with a rebuilt, 
reconditioned or new Product. Repaired/replaced leather cases, 
pouches and holsters will be warranted for a period of ninety (90) 
days. All other repaired/replaced Product will be warranted for a 
period equal to the remainder of the original Limited Warranty on 
the original Product or for 90 days, whichever is longer. All 
replaced parts, components, boards and equipment shall 
become the property of SAMSUNG.

If SAMSUNG determines that any Product is not covered by this 
Limited Warranty, Purchaser must pay all parts, shipping, and 
labor charges for the repair or return of such Product.

WHAT ARE THE LIMITS ON SAMSUNG'S WARRANTY/LIABILITY? 
EXCEPT AS SET FORTH IN THE EXPRESS WARRANTY CONTAINED 
HEREIN, PURCHASER TAKES THE PRODUCT “AS IS,” AND 
SAMSUNG MAKES NO WARRANTY OR REPRESENTATION AND 
THERE ARE NO CONDITIONS, EXPRESS OR IMPLIED, STATUTORY 

OR OTHERWISE, OF ANY KIND WHATSOEVER WITH RESPECT TO 
THE PRODUCT, INCLUDING BUT NOT LIMITED TO:
• THE MERCHANTABILITY OF THE PRODUCT OR ITS FITNESS FOR ANY 

PARTICULAR PURPOSE OR USE;
• WARRANTIES OF TITLE OR NON-INFRINGEMENT;
• DESIGN, CONDITION, QUALITY, OR PERFORMANCE OF THE PRODUCT;
• THE WORKMANSHIP OF THE PRODUCT OR THE COMPONENTS 

CONTAINED THEREIN; OR
• COMPLIANCE OF THE PRODUCT WITH THE REQUIREMENTS OF ANY 

LAW, RULE, SPECIFICATION OR CONTRACT PERTAINING THERETO.

NOTHING CONTAINED IN THE INSTRUCTION MANUAL SHALL BE 
CONSTRUED TO CREATE AN EXPRESS WARRANTY OF ANY KIND 
WHATSOEVER WITH RESPECT TO THE PRODUCT. ALL IMPLIED 
WARRANTIES AND CONDITIONS THAT MAY ARISE BY OPERATION 
OF LAW, INCLUDING IF APPLICABLE THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, ARE HEREBY LIMITED TO THE SAME DURATION OF 
TIME AS THE EXPRESS WRITTEN WARRANTY STATED HEREIN. 
SOME STATES/PROVINCES DO NOT ALLOW LIMITATIONS ON HOW 
LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION 
MAY NOT APPLY TO YOU. IN ADDITION, SAMSUNG SHALL NOT BE 
LIABLE FOR ANY DAMAGES OF ANY KIND RESULTING FROM THE 
PURCHASE, USE, OR MISUSE OF, OR INABILITY TO USE THE 
PRODUCT OR ARISING DIRECTLY OR INDIRECTLY FROM THE USE 



Warranty Information       142

OR LOSS OF USE OF THE PRODUCT OR FROM THE BREACH OF 
THE EXPRESS WARRANTY, INCLUDING INCIDENTAL, SPECIAL, 
CONSEQUENTIAL OR SIMILAR DAMAGES, OR LOSS OF 
ANTICIPATED PROFITS OR BENEFITS, OR FOR DAMAGES ARISING 
FROM ANY TORT (INCLUDING NEGLIGENCE OR GROSS 
NEGLIGENCE) OR FAULT COMMITTED BY SAMSUNG, ITS AGENTS 
OR EMPLOYEES, OR FOR ANY BREACH OF CONTRACT OR FOR 
ANY CLAIM BROUGHT AGAINST PURCHASER BY ANY OTHER 
PARTY. SOME STATES/PROVINCES DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT 
APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS, WHICH VARY 
FROM STATE TO STATE/PROVINCE TO PROVINCE. THIS LIMITED 
WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE 
ORIGINAL PURCHASER OF THIS PRODUCT AND STATES 
PURCHASER'S EXCLUSIVE REMEDY. IF ANY PORTION OF THIS 
LIMITED WARRANTY IS HELD ILLEGAL OR UNENFORCEABLE BY 
REASON OF ANY LAW, SUCH PARTIAL ILLEGALITY OR 
UNENFORCEABILITY SHALL NOT AFFECT THE ENFORCEABILITY 
FOR THE REMAINDER OF THIS LIMITED WARRANTY WHICH 
PURCHASER ACKNOWLEDGES IS AND WILL ALWAYS BE 
CONSTRUED TO BE LIMITED BY ITS TERMS OR AS LIMITED AS 
THE LAW PERMITS. THE PARTIES UNDERSTAND THAT THE 
PURCHASER MAY USE THIRD-PARTY SOFTWARE OR EQUIPMENT 

IN CONJUNCTION WITH THE PRODUCT. SAMSUNG MAKES NO 
WARRANTIES OR REPRESENTATIONS AND THERE ARE NO 
CONDITIONS, EXPRESS OR IMPLIED, STATUTORY OR 
OTHERWISE, AS TO THE QUALITY, CAPABILITIES, OPERATIONS, 
PERFORMANCE OR SUITABILITY OF ANY THIRDPARTY SOFTWARE 
OR EQUIPMENT, WHETHER SUCH THIRD-PARTY SOFTWARE OR 
EQUIPMENT IS INCLUDED WITH THE PRODUCT DISTRIBUTED BY 
SAMSUNG OR OTHERWISE, INCLUDING THE ABILITY TO 
INTEGRATE ANY SUCH SOFTWARE OR EQUIPMENT WITH THE 
PRODUCT. THE QUALITY, CAPABILITIES, OPERATIONS, 
PERFORMANCE AND SUITABILITY OF ANY SUCH THIRD-PARTY 
SOFTWARE OR EQUIPMENT LIE SOLELY WITH THE PURCHASER 
AND THE DIRECT VENDOR, OWNER OR SUPPLIER OF SUCH 
THIRD-PARTY SOFTWARE OR EQUIPMENT, AS THE CASE MAY BE.

This Limited Warranty allocates risk of Product failure between 
Purchaser and SAMSUNG, and SAMSUNG's Product pricing 
reflects this allocation of risk and the limitations of liability 
contained in this Limited Warranty. The agents, employees, 
distributors, and dealers of SAMSUNG are not authorized to make 
modifications to this Limited Warranty, or make additional 
warranties binding on SAMSUNG. Accordingly, additional 
statements such as dealer advertising or presentation, whether 
oral or written, do not constitute warranties by SAMSUNG and 
should not be relied upon.
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End User License Agreement for Software
IMPORTANT. READ CAREFULLY: This End User License Agreement 
(“EULA”) is a legal agreement between you (either an individual 
or a single entity) and Samsung Electronics Co., Ltd. for software 
owned by Samsung Electronics Co., Ltd. and its affiliated 
companies and its third party suppliers and licensors that 
accompanies this EULA, which includes computer software and 
may include associated media, printed materials, “online” or 
electronic documentation (“Software”). BY CLICKING THE “I 
ACCEPT” BUTTON (OR IF YOU BYPASS OR OTHERWISE DISABLE 
THE “I ACCEPT”, AND STILL INSTALL, COPY, DOWNLOAD, 
ACCESS OR OTHERWISE USE THE SOFTWARE), YOU AGREE TO 
BE BOUND BY THE TERMS OF THIS EULA. IF YOU DO NOT 
ACCEPT THE TERMS IN THIS EULA, YOU MUST CLICK THE 
“DECLINE” BUTTON, DISCONTINUE USE OF THE SOFTWARE.

1. GRANT OF LICENSE. Samsung grants you the following rights 
provided that you comply with all terms and conditions of this 
EULA: You may install, use, access, display and run one copy of 
the Software on the local hard disk(s) or other permanent storage 
media of one computer and use the Software on a single 
computer or a mobile device at a time, and you may not make 
the Software available over a network where it could be used by 
multiple computers at the same time. You may make one copy of 
the Software in machine-readable form for backup purposes 

only; provided that the backup copy must include all copyright or 
other proprietary notices contained on the original. 

2. RESERVATION OF RIGHTS AND OWNERSHIP. Samsung reserves 
all rights not expressly granted to you in this EULA. The Software 
is protected by copyright and other intellectual property laws and 
treaties. Samsung or its suppliers own the title, copyright and 
other intellectual property rights in the Software. The Software is 
licensed, not sold.

3. LIMITATIONS ON END USER RIGHTS. You may not reverse 
engineer, decompile, disassemble, or otherwise attempt to 
discover the source code or algorithms of, the Software (except 
and only to the extent that such activity is expressly permitted by 
applicable law notwithstanding this limitation), or modify, or 
disable any features of, the Software, or create derivative works 
based on the Software. You may not rent, lease, lend, sublicense 
or provide commercial hosting services with the Software.

4. CONSENT TO USE OF DATA. You agree that Samsung and its 
affiliates may collect and use technical information gathered as 
part of the product support services related to the Software 
provided to you, if any, related to the Software. Samsung may 
use this information solely to improve its products or to provide 
customized services or technologies to you and will not disclose 
this information in a form that personally identifies you.
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5. UPGRADES. This EULA applies to updates, supplements and 
add-on components (if any) of the Software that Samsung may 
provide to you or make available to you after the date you obtain 
your initial copy of the Software, unless we provide other terms 
along with such upgrade. To use Software identified as an 
upgrade, you must first be licensed for the Software identified by 
Samsung as eligible for the upgrade. After upgrading, you may 
no longer use the Software that formed the basis for your 
upgrade eligibility.

6. SOFTWARE TRANSFER. You may not transfer this EULA or the 
rights to the Software granted herein to any third party unless it 
is in connection with the sale of the mobile device which the 
Software accompanied. In such event, the transfer must include 
all of the Software (including all component parts, the media and 
printed materials, any upgrades, this EULA) and you may not 
retain any copies of the Software. The transfer may not be an 
indirect transfer, such as a consignment. Prior to the transfer, the 
end user receiving the Software must agree to all the EULA 
terms.

7. EXPORT RESTRICTIONS. You acknowledge that the Software is 
subject to export restrictions of various countries. You agree to 
comply with all applicable international and national laws that 
apply to the Software, including the U.S. Export Administration 
Regulations, as well as end user, end use, and destination 
restrictions issued by U.S. and other governments.

8. TERMINATION. This EULA is effective until terminated. Your 
rights under this License will terminate automatically without 
notice from Samsung if you fail to comply with any of the terms 
and conditions of this EULA. Upon termination of this EULA, you 
shall cease all use of the Software and destroy all copies, full or 
partial, of the Software.

9. DISCLAIMER OF WARRANTIES. You expressly acknowledge 
and agree that use of the Software is at your sole risk and that 
the entire risk as to satisfactory quality, performance, accuracy 
and effort is with you. TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, THE SOFTWARE IS PROVIDED “AS IS” AND 
WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND 
SAMSUNG AND ITS LICENSORS (COLLECTIVELY REFERRED TO AS 
“SAMSUNG” FOR THE PURPOSES OF SECTIONS 9, 10 and 11) 
HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH 
RESPECT TO THE SOFTWARE, EITHER EXPRESS, IMPLIED OR 
STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF 
SATISFACTORY QUALITY OR WORKMANLIKE EFFORT, OF FITNESS 
FOR A PARTICULAR PURPOSE, OF RELIABILITY OR AVAILABILITY, 
OF ACCURACY, OF LACK OF VIRUSES, OF QUIET ENJOYMENT, 
AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. SAMSUNG 
DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR 
ENJOYMENT OF THE SOFTWARE, THAT THE FUNCTIONS 
CONTAINED IN THE SOFTWARE WILL MEET YOUR 
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REQUIREMENTS, THAT THE OPERATION OF THE SOFTWARE WILL 
BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE 
SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY SAMSUNG OR A SAMSUNG 
AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY. 
SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE 
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON 
APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THESE 
EXCLUSIONS AND LIMITATIONS MAY NOT APPLY TO YOU.

10. EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN 
OTHER DAMAGES. TO THE EXTENT NOT PROHIBITED BY LAW, IN 
NO EVENT SHALL SAMSUNG BE LIABLE FOR PERSONAL INJURY, 
OR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL 
DAMAGES WHATSOEVER, OR FOR LOSS OF PROFITS, LOSS OF 
DATA, BUSINESS INTERRUPTION, OR FOR ANY PECUNIARY 
DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR 
USE OR INABILITY TO USE THE SOFTWARE, THE PROVISION OF 
OR FAILURE TO PROVIDE SUPPORT OR OTHER SERVICES, 
INFORMATION, SOFTWARE, AND RELATED CONTENT THROUGH 
THE SOFTWARE OR OTHERWISE ARISING OUT OF THE USE OF 
THE SOFTWARE, OR OTHERWISE UNDER OR IN CONNECTION 
WITH ANY PROVISION OF THIS EULA, HOWEVER CAUSED, 
REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT 

OR OTHERWISE) AND EVEN IF SAMSUNG HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO 
NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL 
INJURY, OR OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO 
THIS LIMITATION MAY NOT APPLY TO YOU.

11. LIMITATION OF LIABILITY. Notwithstanding any damages that 
you might incur for any reason whatsoever (including, without 
limitation, all damages referenced herein and all direct or general 
damages in contract or anything else), the entire liability of 
Samsung under any provision of this EULA and your exclusive 
remedy hereunder shall be limited to the greater of the actual 
damages you incur in reasonable reliance on the Software up to 
the amount actually paid by you for the Software or US$5.00. The 
foregoing limitations, exclusions and disclaimers (including 
Sections 9, 10 and 11) shall apply to the maximum extent 
permitted by applicable law, even if any remedy fails its essential 
purpose.

12. U.S. GOVERNMENT END USERS. The Software is licensed 
only with “restricted rights” and as “commercial items” 
consisting of “commercial software” and “commercial software 
documentation” with only those rights as are granted to all other 
end users pursuant to the terms and conditions herein.
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13. APPLICABLE LAW. This EULA is governed by the laws of 
TEXAS, without regard to conflicts of laws principles. This EULA 
shall not be governed by the UN Convention on Contracts for the 
International Sale of Goods, the application of which is expressly 
excluded. If a dispute, controversy or difference is not amicably 
settled, it shall be finally resolved by arbitration in Seoul, Korea in 
accordance with the Arbitration Rules of the Korean Commercial 
Arbitration Board. The award of arbitration shall be final and 
binding upon the parties.

14. ENTIRE AGREEMENT; SEVERABILITY. This EULA is the entire 
agreement between you and Samsung relating to the Software 
and supersedes all prior or contemporaneous oral or written 
communications, proposals and representations with respect to 
the Software or any other subject matter covered by this EULA. If 
any provision of this EULA is held to be void, invalid, 
unenforceable or illegal, the other provisions shall continue in full 
force and effect.

Precautions for Transfer and Disposal

If data stored on this device is deleted or reformatted using the 
standard methods, the data only appears to be removed on a 
superficial level, and it may be possible for someone to retrieve 
and reuse the data by means of special software.

To avoid unintended information leaks and other problems of this 
sort, it is recommended that the device be returned to Samsung’s 
Customer Care Center for an Extended File System (EFS) Clear 
which will eliminate all user memory and return all settings to 
default settings. Please contact the Samsung Customer Care 
Center for details.

Important!: Please provide warranty information (proof of purchase) to 
Samsung’s Customer Care Center in order to provide this service 
at no charge. If the warranty has expired on the device, charges 
may apply.

Customer Care Center:

1000 Klein Rd.

Plano, TX 75074

Toll Free Tel: 1.888.987.HELP (4357)

Samsung Telecommunications America, LLC:

1301 East Lookout Drive

Richardson, Texas 75082

Phone: 1-800-SAMSUNG (726-7864)

Important!: If you are using a handset other than a standard numeric keypad, 
dial the numbers listed in brackets.
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Phone: 1-888-987-HELP (4357)

©2010 Samsung Telecommunications America. All rights 
reserved.

No reproduction in whole or in part allowed without prior written 
approval. Specifications and availability subject to change 
without notice.
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